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Welcome

This Microsoft® Outlook™ 97 Administrator’s Guide provides useful information to help administrators deploy, support, and understand Outlook in their organizations. This guide compiles important Outlook information (available from a number of published Microsoft materials) into a single document for administrators. The following section outlines the types of information included in this administrator’s guide.

About the Administrator’s Guide

This guide includes the following chapters:

Chapter 1, “Microsoft Outlook 97 Overview,” introduces Microsoft Outlook 97 and describes its basic architecture and system administration features. Also, this chapter identifies the features that distinguish Outlook 97 versions 8.01. 8.02, and 8.03 from version 8.0, which is the original release of Outlook 97. 

Chapter 2, “Installation and Configuration,” describes the files and settings that administrators use to install and configure Outlook. Learn how to create a custom network installation using the Network Install wizard and how to install the application remotely using the Outlook.pdf package definition file. Also, find out about Outlook mail profiles and profile settings.

Chapter 3, “Migration,” discusses two important tools, the SC2 Importer and the Outlook Migration Kit, which administrators can use to migrate Microsoft Schedule+ calendar information to Outlook.

Chapter 4, “Interoperability,” explains how Outlook interoperates with other Microsoft and third-party messaging systems, including Microsoft Exchange Server, Microsoft Mail 3.x, and Lotus® cc:Mail™. Also, learn how Outlook works with Microsoft Schedule+ and Microsoft Project.

Chapter 5, “Workgroup Features in Microsoft Outlook 97,” explains the features of Outlook that support many users collaborating within a workgroup. Find out how to deploy workgroup features, such as group scheduling, public folders, and team management capabilities.

�

Chapter 6, “Optimizing Microsoft Outlook 97,” provides many helpful tips for using Outlook, including how to back up Outlook data and how to create a resource account. These tips help administrators and their user communities to optimize Outlook features within the work environment.

Appendix A, “Sample Outlook.prf File” provides a sample Outlook.prf file, which is the messaging profile used by Outlook to define a user’s mail settings and preferences. Administrators can review this sample file when customizing the Outlook.prf for their own user communities.

Appendix B, “Setup Command-Line Options” explains how to run the Setup program from the command line and describes the parameters that you can add to the command to specify special options during installation.

Additional Information

Outlook provides comprehensive product documentation in both print and online formats. For information about how to use specific Outlook features, see the online Help supplied with the product. Also, see the following reference materials for additional information about Outlook.

Microsoft Office 97 Resource Kit

The Microsoft Office 97 Resource Kit contains valuable information about Microsoft Office 97 applications, including Outlook, its architecture and features, and how to upgrade to this product. This administrator’s guide includes a number of excerpts from the Microsoft Office 97 Resource Kit that are pertinent to an administrator’s deployment of Outlook. For a complete copy of the Microsoft Office 97 Resource Kit, see the Web site at http://www.microsoft.com/office/ork/.

Microsoft Exchange Server Resource Kit

The Microsoft Exchange Server Resource Kit consists of Parts 1 and 2, which are included with the Microsoft BackOffice® Resource Kit. The resource kit provides detailed information about Microsoft Exchange Server architecture and features, as well as setup and implementation tools. This administrator’s guide includes a number of excerpts from the Microsoft Exchange Server Resource Kit that are pertinent to an administrator’s deployment of Outlook. For a complete copy of the Microsoft Exchange Server Resource Kit, see your Exchange Server CD or the Exchange Web site at http://www.microsoft.com/exchange/.

�

Web Sites

Visit the following Web sites for up-to-date information about Outlook and related products:

http://www.microsoft.com/outlook/  The Outlook Web site contains a wealth of information about the Outlook product, including access to the Outlook knowledge base, support information, and frequently asked questions.

http://www.microsoft.com/office/  The Office Web site is a good source for information about Office applications and provides a link to the Microsoft Office 97 Resource Kit.

http://www.microsoft.com/exchange/  The Exchange Server Web site contains current information about Exchange Server and links to other Microsoft BackOffice products.



Newsgroups

The following newsgroups provide a public forum for comments and questions about Outlook:

Microsoft.public.Outlook 97

Microsoft.public.Outlook 97.installation

Microsoft.public.Outlook 97.configuration

Microsoft.public.Outlook 97.migration



Third-Party Publications

A number of publishers, including Microsoft Press, produce books that describe Outlook features and explain how to use the product. These books for administrators and end users are available from local bookstores:

10-Minute Guide to Outlook 97, by Sue Plumley, December 1996, ISBN: �0-7897-1018-8, Que Corporation, $14.99, for beginning and intermediate users.

Learn! Microsoft Outlook 97: Getting Organized, by Winstruct, Inc., February 1997, ISBN: 1-57231-546-6, $24.99, for beginning users.

Microsoft Outlook 97 At a Glance, by Stephen L. Nelson, March 1997, ISBN: �1-57231-390-0, $16.99, for beginners and intermediate users.

Microsoft Outlook 97 Field Guide, by Stephen L. Nelson, December 1996, ISBN: 1-57231-383-8, $9.99, for beginners and intermediate users.

�

Microsoft Outlook 97 Step by Step, by Catapult, Inc., December 1996, ISBN: �1-57231-382-X, Microsoft Press, $29.99, for beginners and intermediate users.

Microsoft Outlook for Dummies, by Bill Dyszel, January 1997, ISBN: �0-7645-0080-5, IDG Books Worldwide, Inc., $19.99; for beginning and intermediate users.

The Microsoft Outlook Handbook, by Martin Matthews, December 1996, ISBN: �0-07-882273-4, Osborne/McGraw Hill, $24.99, for all users. 



Note: Microsoft is not responsible for the contents of these publications and provides this list only as a convenience to you. The inclusion of these publications in this administrator’s guide does not imply endorsement by Microsoft.

For the most current list of Outlook publications, see the Web site at http://www.microsoft.com/outlook/documents/ot97book/default.htm.



Conventions in This Guide

The following table summarizes the typographic conventions used in this administrator’s guide.



Convention�Description����bold�Menus and menu commands, command buttons, property page and dialog box titles and options, command-line commands, options, and portions of syntax that must be typed exactly as shown.��Initial Capitals�Names of applications, programs, and named windows.��italic�Information that you provide (for example, a <server> or <drive> name that you type) and book titles.��KEY+KEY�Key combinations in which you press and hold down one key, and then press another.��

Acronyms in This Guide

The following table provides standard abbreviations or acronyms used throughout this administrator’s guide and their meanings.



Acronym�Meaning����BCC�Blind carbon copy��CD�Compact disc��CDO�Exchange collaboration data objects��DLL�Dynamic-link library���

Acronym�Meaning����GAL�Global address list��HTML�Hypertext markup language��IMEP�Internet mail enhancement patch��INF�Information file��ISP�Internet service provider��LAN�Local area network��MAPI�Messaging application programming interface��MLP�Microsoft License Pack��MSDL�Microsoft download service��OST�Offline store file��PDF�Package definition file��POP�Post office protocol��PST�Personal folder file��RPC�Remote procedure call��SC2�Schedule+ file format��SMS�System management server��SMTP�Simple mail transfer protocol��SPX�Sequenced packet exchange��STF�Setup table file��TAPI�Telephony application programming interface��TCP/IP�Transport control protocol/Internet protocol��WMS�Windows messaging system��UNC�Universal naming convention��URL�Uniform resource locator��

�

�Chapter 1

Microsoft Outlook 97 Overview

This chapter provides an overview of Microsoft® Outlook™ 97, so that you can gain a better understanding of its architecture and system administration features. Also, you can compare the subsequent 8.0x versions of the Outlook 97 product to the original 8.0 version. Administrators can use this version information to learn about product updates, which may assist with future upgrade decisions. 
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�Introduction

The Outlook messaging and collaboration client is a Microsoft Office application that builds on and advances the Microsoft Mail, Microsoft Exchange Client, and Microsoft Schedule+ products. In a sense, Outlook provides the newest version of these products, but it also extends and enhances earlier features. Outlook represents a new category of application—an integrated messaging and collaboration client that combines the following capabilities: 

E-mail 

Personal calendar and group scheduling 

Personal information, such as contacts and tasks 

Browsing and sharing of documents 

Custom groupware or information-sharing applications�

Outlook Design Goals

Outlook brings the vision of Office to the rest of the desktop. The design goals of Outlook include the following: 

Integration with the Office suite. Outlook integrates Office applications with e­mail, personal organization software, and groupware. This application allows organizations to develop and deploy groupware applications based on Office. 

Development of the foremost Microsoft messaging and scheduling client. E­mail is the fastest growing desktop application category, and group scheduling is the second most popular application. Outlook advances the state of the art in e­mail and scheduling features, usability, and integration. 

An integrated organization tool for personal, shared, and online information. Users need personal organization tools that integrate with messaging and groupware applications. They are more likely to make the best use of all of these tools when they are integrated into a single application. 

An easy upgrade from Microsoft Mail, Schedule+, or Microsoft Exchange Client. Customers have a smooth migration path to Outlook from Microsoft Mail, Microsoft Exchange Client, or Schedule+, both in features and in interoperability. Also, users within the same organization can run Outlook, Schedule+, and Microsoft Exchange Client, as well as other third-party messaging systems. 

A new class of information sharing. Outlook fulfills Microsoft’s long-standing promise to enhance groupware and information-sharing solutions on the Microsoft Exchange Server platform. 

�Outlook Architecture

This section explains how the various components of Outlook work together, and describes some of the many advanced architectural features. An understanding of the architecture of Outlook can help you take advantage of its features and may help you troubleshoot problems. 

How Outlook Is Structured

Microsoft Outlook combines information management, electronic mail, and personal and group calendar functions into one application. The building blocks of Outlook include the following: 

Items. Outlook categorizes information as one of several items. Each item, in turn, consists of a number of properties. For example, an e­mail message item consists of properties, such as subject, text, and date received. 

Folders. Outlook stores items in folders, with each folder containing items of a particular type. These item types include Outlook­specific items, such as Journal items, as well as files stored on the computer or on the network. 

Views. Outlook organizes and displays items in a folder using views. Any view can be used with any type of folder, and users can also customize and save views for later use. 

The following illustration shows how Outlook components fit together.



�EMBED PBrush���

Figure 1—Outlook components

�

As a messaging application, Outlook complies with MAPI, which defines a standard interface between messaging servers and clients. A MAPI profile (mail profile) on a computer defines the MAPI messaging servers, personal folders, and address books that are available to all MAPI applications on that computer. Outlook can connect to any messaging system, folder, and e­mail address book defined in the profile. Outlook even stores non-mail items in the folders defined in the profile. Outlook can send and receive messages using any e­mail information service defined in the profile, including Microsoft Exchange Server, Microsoft Fax, The MSN online service, and other e­mail applications. 

Personal Folders



Personal Folders are folders that users create to store mail messages on their local hard disk or on another server. Users add a main Personal Folders file as a service to their profile and give it a file name with a pst extension. For Microsoft Mail post offices, a Personal Folder is set up automatically because the Inbox and Outlook folders reside in the folder. 

The Personal Folders file contains folders, messages, forms, and attachments. Users work with Personal Folders files as they would with any other file. They can save, copy, and move the file to another location on their hard disk, a floppy disk, or a server. Also, users can designate a Personal Folders file as the delivery location for incoming messages. 

Address Books



Outlook provides two different types of address books—the Personal Address Book and the Outlook Address Book. Depending on their mail service provider, users may have other types of address books as well. The mail server and mail server administrator usually control the available types of address books. The Outlook Address Book is added to the profile when Outlook is installed, making it available to all MAPI applications. Users can add the Personal Address Book as a service to their profile. 

The Outlook Address Book allows users to gain access to their Outlook Contacts when addressing mail. Because the Contacts folder is a sub-component of either the Personal Folders or the Exchange Mailbox folders, users must include one or both of these services in their profile to have a Contacts folder. Then, they can set the properties of their Contacts folder so that it can act as an address book.



�

Advanced Architectural Features

Outlook introduces the following advanced architectural features: 

Unified e­mail and personal information. Outlook is a single application with a single database. Therefore, users can go between their e­mail Inbox, Calendar, and other modules with a single mouse click. A single command replicates and synchronizes all e­mail folders, public folders, calendars, and personal information. 

Commands for sorting and filtering information are the same in all modules, so users can perform tasks, such as dragging and dropping or searching for items, across different modules. For example, users can drag an e­mail message to the Calendar to convert the message into an appointment; a single search can return all related messages, appointments, tasks, and contacts. 

Common user interface. Outlook provides access to both Microsoft Exchange Server folders and other Windows® folders, applying a common user interface to both. With Outlook, users can browse the Inbox, a Microsoft Exchange Server public folder, the My Documents folder on the hard disk, or a group of shared documents on a network server. 

Support for multiple types of views. Outlook offers a wide variety of view types in a single application with common commands for displaying, filtering, sorting, and grouping information regardless of view type. Using any of the five types of views—table, calendar (day/week/month), card, icon, and timeline—users can customize their information into an unlimited number of personal or shared views. 

In the past, users could view their e­mail only in a table view or their schedule only in a calendar view. The Outlook architecture eliminates these arbitrary limitations. Users can browse a Calendar list of annual events in a table view, or they can apply a calendar view to their Sent Mail folder to organize messages by the date they were sent. 

New capabilities for designing custom forms and groupware solutions. The central elements of custom information-sharing solutions are views and forms. With the form design tool, users can customize any built-in Outlook form or build entirely new forms. Built-in Outlook forms and views can be used with no changes, with minor changes, or as the building blocks for information-sharing or groupware solutions. Designers can create shared custom views in a Microsoft Exchange Server public folder; users can create private views of public folders. 

Also, Exchange Server provides Outlook users with an alternative way to create forms for collaborative applications—using Outlook Web Access, Active Server Pages, and the Microsoft Exchange Collaboration Data Objects (CDO) interface. Users display scripted forms as HTML in a Web browser. All three versions of Outlook in Exchange Server 5.5 (Outlook 97 8.03, Outlook for Windows 3.x, and Outlook for Macintosh) have been extended to support Exchange Server HTML forms. See “Opening Exchange Server HTML forms” under “Version 8.03 Features” in this chapter.

�

This combination of architectural elements and a focus on the everyday activities of users makes Outlook a powerful, flexible, and easy-to-use tool for organizing and communicating information. 

System Administration Features

With Outlook advanced architecture, it’s easy to take advantage of these system administration features: 

Messaging profiles. The Outlook messaging profile (Outlook.prf) works similar to the Exchange.prf and Default.prf, defining Outlook-specific settings for each user’s mail profile and setting the properties in the mail profile automatically. With Outlook messaging profiles, administrators can offer a variety of options to their user communities. The Outlook.prf allows administrators to set up multiple mail environments for individual users. Users can also have different profiles point to the same mailbox. See “Outlook Messaging Profiles” in Chapter 2, “Installation and Configuration.”

Setup options. System administrators can customize Outlook setup using the Network Install wizard. The wizard was shipped with the Office 97 Resource Kit, or you can download this document from the Web site at http://www.microsoft.com/office/ork. Most setup customizations are based on familiar Office utilities, including Office policy templates and package definition format files. For more information about the Network Install wizard, see Chapter 2, “Installation and Configuration.” 

Also, you can customize setup and configuration with a number of specialized options. Command line flags allow administrators to add setup parameters for certain options, such as choosing a Typical installation or creating a network installation log.  

Migration tools. Microsoft offers two key tools to assist Schedule+ users with the migration to Outlook. The first tool, the Outlook Bulk Migration Kit, migrates Schedule+ calendar information to Outlook for entire user communities. The second tool, the Outlook SC2 Importer, assists with the client-side migration of  Schedule+ .sc2 data files into the Microsoft Outlook Calendar. You can use these tools in conjunction with the Exchange Migration Wizard. For more information, see Chapter 3, “Migration.”

Interoperability. Outlook can interoperate with a number of popular mail clients, including Microsoft Mail, Microsoft Windows post offices, and Lotus cc:Mail. In addition, Schedule+ drivers for Outlook allow Schedule+ users to view read-only details of Outlook calendars. For more information about Outlook interoperability, see Chapter 4, “Interoperability.”



�

Comparing Outlook 97 8.0x Versions

Version 8.0 is the original version of Microsoft Outlook 97. Microsoft has released three 8.0x versions of Outlook 97 following version 8.0. The following table lists the available versions of Outlook 97: 



Version�Help About shows�Distributed with����8.0�Microsoft Outlook 97 (Release 3511, not shown in Help About)�- Microsoft Office 97 �- Microsoft Outlook 97 Standalone�- Microsoft Office 97 Small �     Business Edition��8.01�Microsoft Outlook 97 (8.01.3817)�Microsoft Exchange Server, version 5.0��8.02�Microsoft Outlook 97 (8.02.4212)�- Microsoft Exchange Server, �     version 5.0, Service Pack 1 (SP-1)�- Microsoft Office 97, Service�     Release 1 Patch (SR-1 Patch)�- Microsoft Office 97, Service Release 1�     Enterprise Update (SR-1 Ent Upd)��8.03�Microsoft Outlook 97 (8.03.xxxx)�- Microsoft Exchange Server, �     version 5.5�- Microsoft Office 97 (not distributed �     as an actual release)��

Note: The Help About information is the same for all three configurations of Outlook 97 version 8.02. For information about how to determine the configuration of 8.02 that you have on your computer, see “Version 8.02 Features” later in this chapter. 



If you do not know your Outlook 97 version, you can determine this information quickly from within the application.

�symbol 52 \f "Marlett" \s 11�4�	To determine your Outlook 97 version



On the Help menu, click About Microsoft Outlook. 

A dialog box displays the version number. 
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Version 8.01 Features

Microsoft Outlook 97 version 8.01 ships with and is optimized for use with Microsoft Exchange Server version 5.0. To obtain this Outlook version, you must purchase Microsoft Exchange Server, although Exchange Server version 5.0 users are not required to upgrade to Outlook 97 version 8.01. 

Outlook 97 version 8.01 is not a maintenance release and does not contain new client features. However, this version does enable Outlook to take advantage of Exchange Server version 5.0 enhancements. Outlook 97 versions 8.0 and 8.01 are completely compatible with Exchange Server versions 4.0 and 5.0. 

The changes in version 8.01 fall into two categories: Outlook general product updates and Exchange Server 5.0-specific changes.

General Product Updates



Outlook general product updates include: 

Updated MAPI and Exchange Server service files. The Outlook client uses updated MAPI and Exchange Server service files to communicate with the Exchange Server. These files are version 5.0 for Outlook 97 version 8.01. 

Automatic sensing of new version availability. If a newer version of the Outlook client is available when you log on to version 8.01, you will be prompted with an option to upgrade. This AutoUpdate feature enables administrators to roll out new client versions more easily.

Different sort method for the "By Conversation Topic" view. The “By Conversion Topic” view now sorts by the most recently received message instead of alphabetically. This feature allows users to browse newsgroups more naturally. 

Changes to the Outlook.prf file. The Outlook.prf file is used during setup to configure a default messaging profile if one does not already exist. The 8.0 version of this file created a profile that did not include the Exchange Server service and specified that mail was to be delivered to a Personal Folder. The 8.01 version of this file configures a profile that includes the Exchange Server service and specifies that mail is delivered to the Server mailbox. Only the English version of Outlook includes this updated file. 

Performance improvement for viewing free/busy times. Outlook 97 version 8.01 uses a slightly different sort order, making it faster to look up calendar free/busy times. In addition, the 8.01 version publishes three months of free/busy time instead of the two months displayed in version 8.0. 

Improved storage for forms. Version 8.01 allows Outlook to store a greater number of fields (for example, 300+) and actions in a form. 

�

Improved handling of attached EFD forms. In version 8.0, using some editing features (copy, paste, and drag and drop) on an EFD form attached to an Outlook item generates an error message. In version 8.01, users can perform these editing tasks successfully. 

Different default for e-mail address separator. The Allow comma as address separator option is turned off by default in version 8.01. To turn this option back on, click the Tools menu, click Options, and then click the Sending tab. 

More version information in Help About. In the Help About Microsoft Outlook dialog box, you now find information about the version number and the internal build number.



Exchange Server 5.0-Specific Changes



The following features are available with Outlook 8.01 only when it is connected to Exchange Server 5.0: 

Moderated folders. Folder owners can screen content before it is published in a folder. 

Additional forwarding rule actions. Two new actions are available: the ability to forward a message without changing the content and the ability to forward as an attachment. 

Improved names for favorites. Now, when you add a public folder favorite using the Add To Favorites command on the File menu, you can create a “friendly” name for the favorite shortcut. 

Favorites with subfolders. With version 8.01, subfolders can appear in the Public Folder Favorites list. 

Per-recipient send options. You can set options, such as UUencode vs. MIME, on a per-recipient basis instead of for the entire item only. 

Inbox assistant rule-firing termination. Version 8.01 has the ability to specify a rule as the last rule applied on a particular message. Rules that normally apply after this rule are not executed. 

Copy rule to profile. Rules are stored with individual profiles. In earlier versions, if a rule was not stored in the current profile, it was not available (dimmed) in the Inbox Assistant dialog box. With Exchange 5.0, you can right-click the rule, and then choose to move the rule to the current profile. 

View folder permissions. Version 8.01 includes a new permission choice that enables a folder owner to designate whether people can view a particular folder. 

�

NNTP publishing properties. If you own a specific folder, and the folder’s parent is also a newsgroup, version 8.01 provides a Newsgroup property page for the folder. This page enables you to control whether the folder’s contents are visible via network news transfer protocol (NNTP) clients. 

Address book views. Administrators can control the format and view of the address book. This feature is controlled from the Exchange Server.



Version 8.02 Features

Outlook 97 version 8.02 is available in three different configurations. You can obtain version 8.02 from the following locations: 

Microsoft Exchange Server 5.0 Service Pack 1 (SP-1). The Service Pack 1 for Exchange Server 5.0 (SP1) version is available on the Web site at http://www.microsoft.com/exchange/. You must have Outlook 97 version 8.01 installed.

Office 97 Service Release 1 Patch (SR-1 Patch). For information about the availability of the Office 97 Service Release 1 Patch (SR-1 Patch) version, see the Web site at http://www.microsoft.com/Office/Office97/ServiceRelease/. 

You must have Outlook 97 version 8.0 installed; you cannot upgrade from version 8.01 to version 8.02. If you have Office 97 and have upgraded to Outlook 97 version 8.01 separately, running the SR-1 Patch upgrades all Office 97 programs except Outlook.  

Office 97 Service Release 1 Enterprise Update (SR-1 Ent Upd). The Office 97 Service Release 1 Enterprise Update is available from the Microsoft Order Desk at �(800) 360-7561. This version requires a complete installation.

Determining Your Version 8.02 Configuration



You can determine your version 8.02 configuration by checking for specific files installed by either the SR-1 Patch or SP-1 update tool and by viewing the properties of the Outlib.dll file for the dates the file was created and modified. Outlook 97 version 8.02 configurations have the following identification: 

You have the SP-1 configuration of version 8.02 if Help About shows Microsoft Outlook 97 (8.02.4212). Also, your hard disk contains the following file: C:\Outlook\Client\Update.exe or the Outlib.dll file was last modified on 6/12/97.

You have the SR-1 Patch configuration of version 8.02 if Help About shows Microsoft Outlook 97 (8.02.4212). Also, your hard disk contains the file C:\Program Files\Microsoft Office\Office\97sr1_<#>.txt (<#> is an integer that increments each time you run the patch) or the Outlib.dll last modified on 7/11/97.

�

You have the SR-1 Ent Upd configuration of version 8.02 if Help About shows Microsoft Outlook 97 (8.02.4212). Also, the Outlib.dll file was both created and modified on 7/11/97. The SR-1 Ent Upd updates the Outlook.exe file to 7/11/97, while the SR-1 Patch does not. 



Configuration Features



The following table lists major features of Outlook 8.02 for each configuration. 



Feature�SP-1�SR-1 Patch�SR-1 Ent Upd����Internet Mail Enhancement Patch�No�Yes�Yes��Schedule+ Driver to Read Outlook Calendars�Yes�No�No��Supports Exchange AutoUpgrade Feature�Yes�No�No��CC:Mail Improvements�Yes�No�Yes��Misc. Import/Export Improvements�Yes�No�Yes��Rules Wizard�Yes�No�Yes��Multiple Offline Address Books (for Microsoft Exchange Server)�Yes�No�Yes��Updated MAPI and Exchange Server Service Files�Yes�No�Yes��Outlook 8.01 Improvements*�Yes�Yes�Yes��Additional Fixes**�Yes�Yes�Yes��* See “Version 8.01 Features.”��** For a description of additional fixes, see the “General Version Updates” and “Other Improvements and Fixes” sections under “Version 8.02 Features.”��

General Version Updates



The following general updates distinguish Outlook 97 version 8.02:

Improved security. This version of Outlook improves security by preventing potentially malicious attachments and VBScript code from running without your knowledge. 

Improved handling of Macintosh file attachments. Version 8.02 improves how Outlook handles Macintosh file attachments. Product updates correct existing problems with the attached Macintosh file icon and its properties, Macintosh binary file attachments, dragging and dropping Macintosh file attachments, and opening previously saved message file attachments.

�

Improved handling of attachments. Outlook now handles downloading file attachments more efficiently. If an attachment did not have an icon property, earlier versions of Outlook attempted to download the entire attachment when you opened the item. Now Outlook displays a plain icon, and the attachment is not downloaded until you double-click to open the attachment. Also, version 8.02 fixes the problem of message recipients not seeing all of the attachments in mail forwarded from a PC Mail post office (multiple attachments appeared as spaces). 

Improved nickname list. This version of Outlook enhances and improves control of the nickname cache, so that the cache is less likely to cause name resolution problems. 

Different default for e-mail address separator. The Allow comma as address separator option is turned off by default in version 8.02. Setup turns on this option only if Microsoft Exchange Server Service is not in the profile. To turn this option back on, click the Tools menu, click Options, and then click the Sending tab.

Printing issues. Version 8.02 fixes the following printing issues:

—	The printed shared calendar used the wrong name in the header and footer.

—	The printout of an item contained only the header and no body text.

—	The user could not print a shared Schedule+ calendar from Outlook.

—	The date was printed in the empty user-defined date/time field.

Holiday issues. Version 8.02 fixes several Outlook holiday list issues, including the Lunar New Year, which now appears properly as a Chinese holiday (not Japanese) and Thanksgiving Day for the United States, which now appears on Thursday (not Wednesday). Also, version 8.02 allows users to more easily customize the Outlook calendar holidays.

Calendar and scheduling issues. Version 8.02 fixes the following calendar and scheduling issues:

—	In previous versions, if you ran Outlook with your Calendar minimized, the monthly calendar might not display when you opened the Calendar window. 

—	If a Microsoft Mail user and a Microsoft Schedule+ version 1.0 user sent overlapping meeting requests to an Outlook user, and the Outlook user accepted the first meeting and declined the second one, the first meeting was also deleted. 

—	The Item.Find VBScript command caused Outlook to stop responding when trying to find an infinite recurring appointment exception. 

—	Previously, if you used Schedule+ as your primary calendar but also made entries in your Outlook calendar, people who viewed your calendar might see your Outlook calendar entries instead of your Schedule+ calendar entries.

�

Also, version 8.02 improves handling of recurring meeting calculations. In previous versions, when a user deleted a single instance of a recurring meeting and then later sent out a change to the meeting, Outlook erroneously sent out a cancellation for the change and the deleted instance. 

cc:Mail issues. Outlook 97 version 8.01, which shipped with Microsoft Exchange Server version 5.0, does not include a license for the Lotus cc:Mail transport service, so when you installed the cc:Mail service you received an error message. Also, if you imported a message that contained single-byte non-English characters, such as Greek or German, from a cc:Mail bulletin board, the non-English characters did not display properly. Version 8.02 fixes these problems.

Importing issues. Version 8.02 fixes these importing issues:

—	Importing contacts into Outlook resulted in incorrectly formatted or parsed address and fax number fields. Although the information might look correct when viewed in an Outlook form, it could result in erratic behavior when other routines or programs used the information. 

—	Outlook did not store an incoming fax number in the proper format in the Contact record. When users imported data containing fax numbers into Outlook Contacts and then attempted to use the fax number, the connection was unsuccessful and the Fax was not sent. 

—	Importing a .cal file from Schedule+ 1.0 could cause an error message. 

Other error messages. Version 8.02 fixes a number of error conditions, so that users no longer see the resulting error messages. These conditions no longer cause your system to stop responding: 

—	Pressing ALT+I to change the focus to the Messages In list (Find Items feature).

—	Attempting to open the Outlook Notes, MAPI folder.

—	Switching between some Outlook folders (for example, Deleted Items, Contacts, Calendar, or Tasks).



Other Improvements and Fixes



You may benefit from these additional version 8.02 improvements and fixes:

Microsoft Word as your e-mail editor. During Outlook Setup, you no longer receive a prompt to use Word as your e-mail editor. This option was removed from Outlook Setup and added to the Tools menu. If you select the Use Microsoft Word as the �e-mail editor check box, and your computer has less than 32 megabytes of RAM, you receive the following alert: 

This allows you to take advantage of the features of Word when you read and write e-mail. To use this 16MB is required, with 32MB recommended for best performance. Do you want to turn this on?

�

Detection of TAPI devices. Version 8.02 fixes the problem of devices not being listed properly when your computer has multiple Telephony Application Programming Interface (TAPI) devices installed. For example, in the past Outlook might indicate that an ISDN modem was not capable of voice communications but could handle data, or that your fax/modem was not present. 

Fields offset by one character. After a system was upgraded to version 8.01, some fields appeared offset by one character. For example, this anomaly appeared in the Contacts File As box and the Appointment Location box. This problem is fixed in version 8.02. 

VBScript 32 KB limit. Previously, when you typed a large number of lines of code into the Visual Basic Script Editor, you eventually could not type any more characters; the Editor did not accept the keystrokes. This problem is fixed in version 8.02. 

Spelling checker does not check the Subject. Previously, the spelling checker did not check the spelling of words in the Subject line of an e-mail message. The spelling checker in version 8.02 also checks the Subject line. 

Improvements in mailto URL handling. If you click a mailto URL (Uniform Resource Locator) in the body of an e-mail message in Outlook, a new, untitled e-mail message starts. The new message is automatically addressed to the recipient identified in the mailto, but none of the other fields in the message header are completed. Outlook 8.02 now supports the following additional mailto fields: 

mailto:someone@microsoft.com�mailto: someone@microsoft.com?subject=Subject of Message�mailto: someone@microsoft.com?subject=Subject of �    Message&cc=others@microsoft.com�mailto: someone@microsoft.com;someone1@microsoft.com?subject=�    Subject of Message

Forms Fix utility. The Forms Fix utility (previously distributed separately) is included as part of version 8.02. This utility is for users of Outlook and the Microsoft Exchange Client who need to switch between the two e-mail clients. This utility substantially improves e-mail client performance for users who install Outlook but continue to use the Microsoft Exchange client for e-mail. 

Delegate permissions show as custom. With version 8.01, if you set up a delegate on a Microsoft Exchange Server and assigned any permissions except “none,” the permissions showed as “custom.” This problem is unique to delegate permissions on a Microsoft Exchange Server mailbox, and is fixed in version 8.02. 



�

Version 8.03 Features

Microsoft Exchange users are not required to upgrade to Outlook 97 version 8.03. However, this upgrade enables users to take advantage of the new server-based features available in Microsoft Exchange Server 5.5. Version 8.03 is completely compatible with Exchange Server versions 4.0 and 5.0. 

Base your decision to upgrade to version 8.03 on the need for the Exchange optimizations and new features described in this section. Outlook users who are not also users of Exchange Server should upgrade to version 8.03 if they require additional PST item storage (see “Storage improvements in .pst and .ost folders”) or the ability to blind carbon copy (BCC) recipients on sent e-mail messages (see “BCC recipients displayed in Sent Items folder.”)

Note: Version 8.03 requires a full installation. No patch or update mechanism is available for installing version 8.03.

General Version Updates



The following general updates distinguish Outlook 97 version 8.03:

Deleted item recovery. The Exchange Server 5.5 release enables users to recover items deleted from their Deleted Items folder. Previously, administrators had to restore an entire mailbox to recover a single item. This feature must be enabled on both the user’s Exchange Server and on the client. Version 8.03 includes an extension (automatically installed with the product) that adds the Recover Deleted Items command to the Tools menu and to the command bar. An administrator can set the length of time that items remain available for recovery. Users cannot recover items deleted from Deleted Item folders in a personal store (.pst file). 

“Change-only” offline address book. When Outlook is used with Exchange Server, it enables users to download the Global Address List (GAL) for use offline. To download the GAL, on the Tools menu, click Synchronize, and then click Download Address Book. In previous versions of Outlook, each request to download the address book downloaded the entire GAL, resulting in long synchronization times. With Outlook 97 version 8.03 and Exchange Server 5.5, only changed items are downloaded, making downloads from the GAL faster and requiring less network bandwidth for remote users.

Script editor for Microsoft Exchange scripting agent. Exchange Server 5.5 enables developers to associate VBScript or JavaScript with an Exchange Server folder. This feature provides a foundation for enabling event- and time-driven workflows or for providing server-based automatic scheduling of resources, such as conference rooms. Version 8.03 includes an extension (automatically installed with the product) that provides a script editor for developing the script associated with an Exchange folder.

�

Storage improvements in .pst and .ost folders. Stores have been expanded to 64,000 items per folder for customers using the personal store (.pst file) or working offline using the .ost file with Exchange Server. This storage capacity provides greater flexibility for Outlook users to organize their mail, calendar, and personal information using folders. 

Note: Setting this limit makes the folder incompatible with earlier versions of Outlook.

Opening Exchange Server HTML forms. Users can access Outlook electronic forms created with the built-in forms design tool only on Windows 32-bit desktops with Outlook installed. However, Exchange Server provides an alternative way to create forms for collaborative applications—using Outlook Web Access, Active Server Pages, and the Microsoft Exchange Collaboration Data Objects (CDO) interface. Users display scripted forms as HTML in a Web browser. All three versions of Outlook in Exchange Server 5.5 (Outlook 97 8.03, Outlook for Windows 3.x, and Outlook for Macintosh) have been extended to support Exchange Server HTML forms. These features provide Exchange sites with more options for developing and deploying electronic forms.

All three versions of Outlook in Exchange 5.5 contain a new menu item, Open Web Form (on the Compose menu), that lets users open an Exchange Server HTML form. When a user selects this menu item, the Web browser registered on the user’s computer is automatically opened and directed to an internal Web site containing a directory of HTML forms. The administrator can set an option in the registry keys to identify the URL that locates the directory of HTML forms. The Open Web Form command is off by default. To enable this feature, on the Tools menu, click Options, click Manage Forms, and then click Web Services.

Previously, when a user sent an Outlook form to a Windows 3.x or Macintosh client, the form was essentially unusable—opening the item in the Windows 3.x or Macintosh Inbox did not display the actual form as the form designer intended. However, with Exchange Server 5.5, the Windows 3.x and Macintosh clients open an associated HTML form automatically via the Web browser when a user opens an Outlook form from the Inbox (assuming that Outlook Web Access is installed and enabled on the server). This HTML form is created as an additional design step, and is not automatically generated during the design of the Outlook form. An administrator must associate the HTML form with the appropriate Outlook form message class.

Improvements in group scheduling. The version 8.03 release includes a utility to convert Schedule+ .sc2 files into Outlook Calendar folder data. This utility aids in the migration from Schedule+ to Outlook. For more information about the SC2 Importer, see Chapter 3, “Migration.” 

�

In addition, version 8.03 enhances the synchronization of “free/busy” information. In previous versions, free/busy information for the previous month was erased on the Exchange Server on the first day of the new month. The current week’s information was lost if the month changed during that week. Version 8.03 solves this problem by publishing free/busy information from the beginning of the current week if the month changes during that week. This solution means better tracking and logging of resources and more effective group scheduling.

Universal client installation. You can use version 8.03 in conjunction with the Universal Client Setup process. This setup creates a share on a file server that allows an Exchange administrator the choice of one or all of the clients (except the Macintosh client).

BCC recipients displayed in Sent Items folder. Opening a mail message in the Sent Items folder now displays any addressees that received a BCC of the message. 

Public folders replicated without intervening hierarchy. In version 8.03, users can now replicate a public folder for offline usage without also replicating the parent folders in the public folder hierarchy.

Synchronization of public folders maintains view settings. In previous versions, when users synchronized multiple public folders for offline usage, they lost the current view in all but the last folder synchronized. No data was lost, but view settings, such as fonts and gridlines, were not maintained. This problem is fixed in version 8.03.



�

�Chapter 2

Installation and Configuration

This chapter provides detailed instructions for installing and configuring Microsoft® Outlook™ 97 on Microsoft Windows® 3.x, Windows 95, Windows NT, and Macintosh platforms. Learn about the types of setup files, the setup process, and how to customize an installation for your user community. 
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�Setup File Formats

Setup files that contain application­specific information control the way Setup installs Outlook. This section describes the general format of two types of Setup files: the information (.inf) file and the Setup table (.stf) file. If you plan to customize your client installation using the Network Installation wizard for Microsoft Office or using Setup command-line options, the .inf and .stf files are modified during the Setup process. This information is provided to help you understand how the Setup process works. 



Caution: The behavior of Setup and a successful installation depend on the internal integrity of the Setup files. These files are tab­delimited and rely on positional parameters. Do not modify them directly; instead, use the Network Installation wizard or Setup command-line options to customize the Setup process. 



Setup relies on a set of files that work together to control the installation process for Outlook. The following table identifies the primary Setup files for Outlook. 



File name�Description����Setup.exe�Primary executable file for Setup ��Outlook.inf �Provides detailed information about the files to be installed ��Admin.inf�Used by Setup to run installations in network mode ��Outlook.stf �.Specifies the logic of the installation process ��*.dll�Dynamic-link library (.dll) files containing custom procedures ��Setup.lst, Setup.ini�Additional information files for Setup ��

The .inf Files

The .inf file is a text file that contains information about all the Setup files involved in an installation. This information includes the following: 

Where a file is located and its default attributes 

Whether a file is to be appended to an existing copy 

Whether a file is to be backed up, renamed, or copied 

Whether a file supports English or another language 



�

There are two .inf files: 

Outlook.inf, used in all installation modes except network mode 

Admin.inf, used when the application is installed on a workstation from a network share (in network mode)



The .stf File

The .stf file is the primary tool for configuring Setup to install Outlook. This file specifies the installation process for each installation mode and determines the nature, sequence, and extent of user input. It determines which options to install, where to install them, and how to respond to current configurations and user input. 

The .stf file consists of data in a tree­structured table. Setup takes different paths through the tree based on options that the user selects or based on the environment in which Setup is run. For example, Setup takes one path through the tree if it finds a previous version of Outlook installed, and a different path if it does not. 

To eliminate duplicating portions of the table throughout the .stf file, a portion of the table can be referenced by multiple paths in the tree. Because Setup carries out each line of the .stf file only once no matter how many paths reference it, multiple references to a single line allow Setup to process the .stf file more quickly. 

The tree structure of the .stf file affects the installation process. In particular, you should be aware of two effects: 

First, because Setup does not know which path it will take through the .stf file until installation begins, Setup cannot precisely predict the amount of disk space required. Setup might display disk space requirements that are slightly higher than the actual space needed. 

Second, if you use the Network Installation wizard to modify entries in the .stf file, you might see duplicate Yes/No questions or Start menu items. This is because the Network Installation wizard displays all the items in the tree, even though some items might never be carried out by Setup during installation. 



You can use the /g command­line option to generate a log file that keeps track of everything Setup does: what files it copies, where it copies them, what modifications it makes to the .ini files or the Windows registry, and any errors it encounters. For a description of this Setup command­line option, see Appendix B, “Setup Command-Line Options.” 

�

Settings Configured by the .stf File

The following table identifies the Outlook settings that are configured by the .stf  file.



Setting�Tab�Description�Key�ValueName����AutoProcRcpts�E-Mail�Process delivery, read, and recall receipts�HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�AutoProcRcpts��AutoProcReq�E-Mail�Process requests and responses�HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�AutoProcReq��WarnDelete�General��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�WarnDelete��SyncAtClose�General��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�SyncAtClose��SoundFeedBack�General��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�Sound��LargeToolbarIcons�General��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�General�BtnSize��Workday�Calendar�Mon=64, Tue=32, Wed=16, Thu=8, Fri=4, Sat=2, Sun=128�HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�Workday��FirstDOW�Calendar��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�FirstDOW��FirstWOY�Calendar��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�FirstWOY��CalDefStart�Calendar��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�CalDefStart��CalDefEnd�Calendar��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�CalDefEnd��RemindDefault�Calendar��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Calendar�RemindDefault���

Setting�Tab �Description�Key�ValueName����TaskRemindTime�Tasks/Notes�Time in minutes after midnight; 540 = 9:00 am�HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�TaskRemindTime��TaskAutoRemind�Tasks/Notes�Enabled = 1; Disabled = 0�HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�TaskAutoRemind��AddToUpdList�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�AddToUpdList��AddToSOCList�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�AddToSOCList��UnitsPerDay�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�UnitsPerDay��UnitsPerWeek�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Tasks�UnitsPerWeek��NoteColor�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Note�NoteColor��NoteSize�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Note�NoteSize��NoteDatestamp�Tasks/Notes��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Note�NoteDatestamp��JournalAccess�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Microsoft Access�Enabled��JournalExcel�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Microsoft Binder�Enabled��JournalOfficeBinder�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Microsoft Excel�Enabled��JournalPowerpoint�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Microsoft PowerPoint�Enabled��JournalWord�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Microsoft Word�Enabled���

Setting�Tab�Description�Key �ValueName����Journal Open Assoc Item�Journal��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Journal�Journal Open Assoc Item��JournalEMail�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\E-mail Message�Enabled��JournalMeetingCancellations�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Meeting Cancellation�Enabled��JournalMeetingRequests�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Meeting Request�Enabled��JournalMeetingResponses�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Meeting Response�Enabled��JournalTaskRequests�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Task Request�Enabled��JournalTaskResponses�Journal��HKCU\Software\Microsoft\�Shared Tools\Outlook\�Journaling\Task Response�Enabled��PlaySound�Reminders��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Reminders�PlaySound��Check�Spelling��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Spelling�Check��SpellAlwaysSuggest�Spelling��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Spelling�SpellAlwaysSuggest��SpellIgnoreNumbers�Spelling��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Spelling�SpellIgnoreNumbers��SpellIgnoreProtect�Spelling��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Spelling�SpellIgnoreProtect��SpellIgnoreUpper�Spelling��HKCU\Software\Microsoft\�Office\8.0\Outlook\Options\�Spelling�SpellIgnoreUpper��
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The Setup Process



The flexibility available in the standard Setup process is sufficient for many situations. In some cases, though, you may benefit from customizing the client installation process using tools, such as the Network Installation wizard, described in this chapter. For example, if you want to install a uniform configuration on all your Windows client computers, including a specific selection of converters and templates, you can create a customized Setup script using the Network Installation wizard. 



Whether you are planning a standard or custom installation for your user community, the first step is to set up an installation point. You can create a client installation point to install Outlook to a local disk. Alternatively, you can create a network share to install and run Outlook from a server. Before creating a client installation point or a network share, do the following:

Create a directory on a server to which users have read-only access. You must have full write, read, and delete permissions in this directory.

Disable virus detection software on the server. This prevents virus detection from being triggered erroneously during Setup.



Setting Up a Client Installation Point

You can install Outlook on a local hard disk by running Setup from a client installation point. A client installation point is a shared directory on a file server to which users can connect to install Outlook to their local computers. Users can choose either Typical or Custom installation.

Installing Outlook to the local computer increases performance but uses more hard disk space. This type of installation is appropriate if you do not want to use network resources for shared programs.

You can create an Outlook client installation point for Microsoft Windows, Windows 95, and Windows NT.



(	To set up a client installation point for Windows



Insert the Outlook client or Office compact disc (CD) into the appropriate drive.

If there is more than one language on the CD, choose the directory for the appropriate language.

Double-click Ucsetup.exe or Setup.exe.

The Setup program steps you through the installation process; for more information, see “Setup Process for a Client Installation” in this chapter.

�

Also, you can create a client installation point for Outlook for the Macintosh.



(	To set up a client installation point for the Macintosh



Create a folder on the server.

The server must have enough room for the contents of the CD.

Insert the Outlook client or Office CD into the appropriate drive.

Double-click the folder for the Macintosh client.

Copy the contents of the Macintosh folder to the folder on the server.

Make the share available to users.





Setting Up a Network Share

If you want your users to run Outlook from a server, you can set up a network share. A network share is a directory on a file server to which users can connect to install and run Outlook. A single network share can be used by multiple clients that use the same network operating system. Users can choose either Typical, Custom, or Run From Network Server installation. The Run from Network Server option leaves most of the Outlook files on the server so that multiple users can share them.

Running Outlook from a server reduces the amount of hard disk space used on client computers but requires continuous access to the network share while Outlook is running.



(	To set up a network share



Insert the Outlook client or Office CD into the appropriate drive.

From the Start menu, choose Run, and then type Setup /a.

Type the name of your organization.

During client installation, Setup uses this name as the organization name for each user.

Type the product ID printed on the CD package or provided by your licensing agreement.

Type the name and path for the directory where you want to store Outlook program files.

Type the name and path for the directory where you want to store the shared program files.

�

Under Network Location, type the server name and path for the shared programs folder.

This is the path that users type when they install Outlook.

Under Connect To Server Using, click Server Name if you want users to access the directory using a universal naming convention (UNC) path.

-or-

Click Drive Letter and type a drive letter if you want users to connect to the server using a drive letter.

Setup attempts to connect to the server and displays an error if it cannot connect. The following table describes how to resolve potential error messages.



If the error is caused by this�Do this����Misspelled server or share name�Click Edit, and correct the name.��Share not yet created�Click Continue, and create the share before users begin installing Outlook.��Cannot connect to a local share on the server�Click Continue; you can verify the share later from another computer on the network.��Invalid UNC path�Click Continue; you can verify the share later from another computer on the network.��

Setup Process for a Client Installation

This section describes the process that Setup follows during a standard client installation. The Setup program performs the following steps: 

Determine whether this is a new installation or a maintenance-mode installation. 

If Setup is running from Disk 1 of a floppy disk set, search from drive Z to drive A, and create the Mssetup temporary folder on the first hard disk that has sufficient disk space. If no hard disk is found, create the Mssetup folder in the user’s Windows folder. 

If Setup is running from a CD, a hard disk, or a network server, it does not create a temporary folder. 

Check the .stf file for syntax errors. 

If the .stf file has been modified, syntax errors could have been introduced. 

�

Check for active applications that are potentially disruptive. 

The list of applications that Setup checks is in the Check Modules item in the Header section of the .stf file. 

Run the .stf file according to the branching logic defined in the file, and then perform the following steps: 

Check for duplicate versions of the application being installed. 

Prompt the user for input regarding corrections and custom configurations. 

Determine whether there is adequate space on the hard disk. 

Copy the files into the system­specified and user­specified folders according to the instructions in the .stf and .inf files. 

The .stf file determines which files or groups of files are copied and their destinations. The .inf file specifies the characteristics of each file or group of files in the product, such as size and date. It also specifies instructions to be used when copying the files, such as whether to decompress the file or overwrite the destination file if it already exists. 

Delete or replace existing files as indicated. 

Make appropriate changes to the Windows registry and .ini files. 

Remove the Mssetup folder, if one was created. 



Determining Maintenance Mode Installation

Setup determines whether an installation is in maintenance mode by looking for an entry in the Windows registry that indicates whether Setup has been run before. The entry is under the following key: 

HKEY_LOCAL_MACHINE\Software\Microsoft\MS Setup (ACME)\Table Files 

The Name value in the Table Files subkey is the product name and version, and the Data value is the path to the .stf file. If the Name value matches the product name and version of software that Setup is attempting to install, Setup runs in maintenance mode using the .stf file identified in the Data value. If the Name value does not match the product name and version of software that Setup is attempting to install, or if Setup cannot find or open the .stf file identified in the Data value, Setup runs in install mode. 

When Setup runs in install mode, it uses the .stf file in the folder in which the Setup program (Setup.exe) resides. Setup recognizes the .stf file by looking for the eight­character name portion of the Setup program file, with the extension .stf. For example, if Setup.exe has been renamed Newsetup.exe, Setup looks for the .stf file named Newsetup.stf. If you use the /t command­line option to specify a particular .stf file, Setup runs in install mode using the .stf file that you specify. 

�

Customizing a Network Installation

The .inf, .stf, and .lst files reside in the same folder as Setup.exe. The most common method for creating customized client installations is to create an installation point and modify these Setup files directly on the server. That way, all users who install Outlook over the network run the custom client installation that you design. 

Note: The majority of this chapter assumes that you are doing a network installation. If you want to customize an installation from your CD or floppy disks, see “Customizing Installations from Physical Media” in this chapter.  



There are two ways you can modify the Setup files to customize the client installation:

You can change values in the .stf file to select the following: 

—	The type of installation to use during batch mode (Typical, Custom, or Run from Network Server). 

—	Specific components, such as the spelling checker, to install during batch mode. 

—	Destination folders to use for Outlook and its components. 

—	Responses to Yes/No questions, such as “Would you like to remove your previous version of Outlook?”

—	Items to appear on the Windows Start menu or Windows NT Workstation version 3.51 program group.

—	The default working folder for Start menu and Windows NT Workstation3.51 program group items. 



You can add new entries to the .stf or .inf file so that Setup creates additional registry settings during client installation. 



Customizing Installations from Physical Media

You can customize some aspects of client Setup for users installing Outlook from physical media, although the preparation is more complex. The technique also differs depending on whether you install Outlook from a CD or from floppy disks. These techniques are described in the following sections. 

Using a CD



Because the files on the CD are not compressed, you can modify both the .stf file and the .inf file using the Network Installation wizard, as described in this chapter. However, because the CD is read­only, you cannot write modified files back to the original CD. 

�

If you have the ability to duplicate CDs and you have multiple user licenses, you can create a new installation CD with your modified Setup files and duplicate this CD for users. You can also copy the CD contents to a network server and modify the Setup files on the server. Users who install Outlook from that location will use your customized files. 

Using Floppy Disks



If you are a Select CD customer, you can create floppy disks from the Select CD for users who cannot use the CD and who do not have network access. Because the .stf file on Disk 1 is compressed in a cabinet (.cab) file and cannot be modified, you cannot customize setup for users installing from floppy disks. 

Important: You cannot use the Network Installation wizard described in the following section with the floppy disk set because the .stf file is inaccessible on the floppy disks. 



Network Installation Wizard

Using the Network Installation wizard, you can modify Setup information files to create a customized network installation for Outlook and other Office applications. You can install the Network Installation wizard from the Office Resource Kit; for more information, see the Web site at http://www.microsoft.com/office/ork/. (If you are not installing Outlook using the Office Resource Kit, you can customize your installation using Setup command-line options; for more information, see Appendix B, “Setup Command-Line Options.”)

If you install an application in batch mode (without user interaction), Setup installs the software using the default values you specify with the Network Installation wizard. If users install an application in interactive mode, the values you set with the Network Installation wizard are presented as the default choices during installation. 



(	To install the Network Installation wizard



Click SetupNIW.exe (2004K). 

Follow the instructions to install the Network Installation wizard. 



Note: The information in the following sections pertains only to the Windows 95 or Windows NT operating system. 



�

Modifying Client Setup with the Network �     Installation Wizard

The Network Installation wizard modifies the .inf, .stf, and .lst files for the client Setup. Using this tool, you can change the values for items in the .stf file. If the user installs Outlook in batch mode, Setup uses the default values you specify in the modified .stf file. If the user installs Outlook in interactive mode, the values you set with the Network Installation wizard appear as default responses during client Setup. 

The Network Installation wizard guides you through the following steps to create a customized Setup: 

Start the Network Installation wizard. 

Specify the appropriate .lst file. 

Select a destination folder for the application files. 

Select a default folder for documents. 

Select a location for shared applications. 

Specify an installation log (optional). 

Choose the type of installation. 

Configure the installation environment. 

Select items for the desktop, Start menu, or Program Manager. 

Specify the destination folder for the .inf, .stf, and .lst files, and any additional files you add to the installation. 

Add additional files to the installation (optional). 

Add Windows registry entries (optional). 

Select type of quiet mode for client Setup (optional). 

Save changes to the .inf, .stf, and .lst files. 



The following sections describe each of these steps in more detail. 



Starting the Network Installation Wizard

The Network Installation wizard guides you through a series of pages and options. You proceed to the next page by clicking Next, and you can go back to the previous page by clicking Back. The Setup files are not modified until you click Finish, so you can go back and change any answers before you complete the final page. 

�

You can quit the Network Installation wizard at any time by clicking Cancel. 
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Specify the .stf or .lst File



After the initial Welcome page, the Network Installation wizard asks for the name of the .lst file to customize. Type the name of the .lst file from the folder containing the main application files.  

The Network Installation wizard finds the name of the .stf file as defined in the .lst file, and then opens the .stf file. The Network Installation wizard looks for the .stf and .inf files in the same folder in which the .lst file resides. While the Network Installation wizard is reading the .stf file, which can take a minute or two, it displays a progress bar. 
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�

After opening the .stf file, the Network Installation wizard opens the .inf file specified in the .stf file. This is in the same folder as the .stf file and has the same file name with an .inf extension. For Outlook, the name of the .inf file is Outlook.inf. If the Network Installation wizard cannot find the .inf file specified in the .stf file, it asks you to enter the location and name of the file. 

Select a Primary Location for the Application Files



Then, the Network Installation wizard displays the name of the folder where the main application files are installed during client Setup. You can change the default folder by entering a new name, or by clicking Browse and selecting a new folder. 

�EMBED PBrush���

If you run client Setup in batch mode (using the /q command­line option), Setup installs the application files in this folder. If a user runs client Setup interactively, this folder appears as the default folder, which the user can change. 

Note: Remember that the folder name you enter here is used by Setup when users install an application. If you specify a folder on a network server, that folder must be accessible during client Setup. If you specify a local folder, Setup creates a folder with that name on the user’s hard disk. 

�

Select a Default Folder for Documents



Both Windows 95 and Windows NT Workstation version 4.0 provide a default folder to store all user documents. By default, this folder is named My Documents and is located at the root directory of the C drive. If the default folder has not yet been defined on the user’s hard disk, the Network Installation wizard allows you to specify a name and path for this folder, which is created during client Setup. If the folder has been defined already in the user’s hard disk, then setting this option has no effect. 
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Tip: In Windows 95 and Windows NT Workstation 4.0, you can use a system policy to define a default file name and path for the documents folder for all users in your workgroup. In the System Policy Editor, set the policy for User\Office\Common\Personal Folder. 

Select a Location for Shared Applications



Next, the Network Installation wizard displays a page similar to the dialog box that was displayed when you created the administrative installation point. The options on this page determine whether users choose where to install shared applications or whether you make that choice for them. 

�

The page contains these options: 

Server. Shared applications are stored on the server, and users run them over the network. Users running client Setup do not make the choice. 

Local hard drive. Shared applications are installed on each user’s computer. Users running client Setup do not make the choice. 

User’s choice. Users choose where to install shared applications when they run client Setup. 
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If you want an application installed in batch mode with no user interaction, you must select either Server or Local hard drive. If you select Server, a second page is displayed for you to specify a location on the network for the shared applications. (This page is also displayed if you select User’s choice, because users in that scenario may choose to store shared applications on the network.)

�
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In the Connect to server using area, you can specify whether you want the location of the shared applications to be defined with a drive letter or with a UNC path. If you click Drive letters, you must enter a drive letter and a path under Network location. You do not need to have a valid connection to the drive while running the Network Installation wizard. However, users must have a valid connection to the drive during client Setup. If you click UNC, you must enter a server name and path under Network location. 

Note: UNC stands for Universal Naming Convention and refers to the \\servername\sharename syntax used for defining servers and shared areas on the server for LAN Manager­compatible networks. 

When you click Next, the Network Installation wizard attempts to connect to the server to verify it. If it encounters any errors, the Network Installation wizard asks whether you want to use the path as specified. To continue and leave the path as it is, click Yes; to change the path, click No. 

�

The following table shows some reasons why the verification might fail and what you can do to fix the problem. 



If the error is caused by this�Do this����Misspelled server or share name. �Click No and correct the name. ��Share not yet created.�Click Yes and create the share before users begin installing Office. ��Cannot connect to a share on the server. (Many networks do not allow you to do this if you run directly from the server.) �Click Yes; you can verify the share later from another computer on the network. ��Invalid UNC path�Click Yes; verify that the share is accessible before users try to install from this server.��

Specify an Installation Log



Setup can create a log file containing information about the installation. If you specify a log file in the Installation Log page of the Network Installation wizard, then each time an application is installed from this administrative installation point, Setup writes one record into the log file. The log file is a text file, and each record contains the following fields: 

Date 

Time 

User name 

Computer name 

Application name 

Version number 

Operation—for example, Install or RemoveAll 



The Network Installation wizard gives you the opportunity to create a log file by specifying the log file name. If you do not want a log file, click Next without entering a file name. 

�
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Choose the Type of Installation



Setup offers three types of installation: Typical, Custom, and Run from Network Server. If you select Typical or Custom in the Installation Type page, the Network Installation wizard displays the Components page so you can select which components you want Setup to install. If you run Setup in batch mode (/q command­line option) using the Typical or Custom installation type (/b command­line option), Setup installs the components you selected. 

For example, if you select Custom in the Installation Type page and then select a number of text converters in the Components page, you can use the command setup.exe /q /b2 to install those converters. For more information, see Appendix B, “Setup Command-Line Options.” 

Note: In the final page, after you have finished customizing the Setup files, the Network Installation wizard displays a suggested Setup command string that includes the correct installation type parameter. For example, if you select Typical in the Installation Type page, the Network Installation wizard displays a suggested command string that includes the parameter /b1. 

If you run Setup interactively, then the components you select with the Network Installation wizard are displayed as default selections. 

�
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If you select Typical in the Installation Type page, the Network Installation wizard displays the list of Typical installation options in the Components page in a format similar to the one presented to an end user running client Setup in interactive mode. 

�
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If you select Custom in the Installation Type page, the Network Installation wizard displays the list of Custom options in the Components page. 
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When you select an installation option in the All Components box, a description appears under Description for selected component, and the folder name appears in the Folder for selected component box. Each of these installation options could have additional options—if additional options are available, a plus sign (+) appears to the left of the option in the All Components box. You can click the plus sign (+) to expand the list and display the additional components. 
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You can select all or only some of a set of additional components: 

If a check box is selected, all of that option’s additional components are selected. 

If a check box is cleared, none of that option’s additional components are selected. 

If a check box is grayed, some of that option’s additional components are selected. To see the selected components, click the plus sign (+). 



If you want to select all the options, along with all their additional components, you can click Select All.

If you use the modified .stf file in batch mode, the state of a check box for a particular option indicates whether the option is installed when client Setup is run. If the check box is selected, the option is installed; if the check box is cleared, the option is not installed. 

If you use the modified .stf file in interactive mode, the state of the check boxes in the All Components box represents the default settings that are presented to the user during client Setup. For example, if you select the Office Tools check box, that check box is selected when the user runs client Setup interactively and views the options for a Custom installation. 

With the Browse button, you can modify the default folder for a selected option. Both the long and short names of the folder you select are kept in the .stf file. However, the Return long folder name to previous dialog check box in the Browse Folders dialog box determines the form of the name that is displayed in the Components page. This option does not affect the .stf file; it only affects the way you view the folder name in the Network Installation wizard. (The default is to use long folder names.) 

�
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When you are creating a customized network installation, you can use a set of special folder identifiers to specify standard system folders in the Browse Folders dialog box. That way, you do not need to know the exact location of these folders on each user’s computer.



This folder identifier�Represents this folder����<ParentDestFolder> �The destination folder of the component ��<SetupSourceFolder> �The folder from which Setup is run��<WindowsFolder> �The main Windows folder��<SystemFolder> �The Windows system folder��<SharedFilesFolder> �The folder in which shared applications are stored��<ProgramFilesFolder> �The Program Files folder in Windows 95, or the Windows directory on Windows NT Workstation��

The Network Installation wizard might also display the identifier <NoneSpecified> for a particular folder. This means that the folder name has not yet been determined, but will be resolved by Setup during installation. 

Note: You can specify a subfolder for any of these folders by appending a backslash ( \ ) and a subfolder name to the folder identifier—for example, <WindowsFolder>\Media. 

Configure the Installation Environment

The .stf file contains a number of questions that Setup uses to further configure the network installation. The questions Setup displays to the user depend on previous user responses and on the installation environment. 

�

For example, if Setup finds Microsoft Schedule+ 95 on the hard disk, Setup asks whether to configure Outlook to use Schedule+ as the primary calendar. If Schedule+ 95 is not found, Setup does not display that question. If the same question can be asked in several situations during installation, the .stf file defines that question in multiple locations. 

The Network Installation wizard displays every Yes/No question that could appear during client Setup in the .stf file and allows you to determine the default answers. Because a particular question can appear more than once in the .stf file, the Network Installation wizard might repeat the same question several times in the Yes/No Questions page. To ensure that your default answer is used during client Setup, change every occurrence of the question in this page. 
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Clicking a question in the Yes/No Questions page switches the answer from Yes to No and back again. 

Why Does the List Contain Duplicate Items?



In some of the lists displayed in the Network Installation wizard, you might see what appear to be duplicate entries. This occurs because there are several execution paths that Setup can take through the .stf file, depending on the configuration of the user’s computer and whether Setup finds a previous version of an application installed. The same question might appear in more than one path; however, Setup asks each question only once during installation. 

�

Because the Network Installation wizard does not know what path Setup will take, it displays every instance of a question. If you want to specify a default answer, you must do so for all the duplicate questions in the list, so that Setup uses the same answer in every context. 

In these lists, the Network Installation wizard displays an Object ID column with the heading ObjID. The Object ID is a number in the .stf file that uniquely identifies each item in the list. This number helps the Network Installation wizard distinguish between duplicate items in the .stf file. You do not need to use this number when running the Network Installation wizard. 

Select Items for Program Manager



The Network Installation wizard allows you to specify the application icons that you want to install in the Program Manager group when you install Office on a computer running Windows NT Workstation 3.51. In the Program Manager Items page, you can specify the Program Manager group and the default working folder for each item you select. The corresponding Program Manager icons are created when you install Office on a computer running Windows NT Workstation 3.51. 
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When you click an item in the Program Manager Item box, the corresponding Program Manager group appears to the right. You can change the group name, and you can select the Prevent users from changing groups during installation check box if you do not want users to modify the location of the selected item. 

�

The working folder for the application appears below the Program Manager Items box. This is the default folder used for creating new files or browsing for existing files. Some applications explicitly define the folder to be used for certain types of files, in which case the working folder is used only for those files that have no other folder explicitly defined for them. You can change this folder by clicking Browse. 

To clear the check boxes for all items in the list, click Select None. 

Which Icons Are Actually Installed?



The items listed in the Program Manager Items page include the program icons defined in the .stf file; however, not all the icons are necessarily installed during client Setup. The icons that are actually installed depend on the options the user selects during Setup, along with other factors that Setup encounters, such as whether a previous version of an application is installed. Clearing a check box in this list, however, guarantees that the corresponding icon is not installed. 

If there are duplicates of an item in the list, only one corresponding program icon is actually created in Program Manager during installation. However, you must modify each duplicate item the same way, so that the correct icon is created regardless of the path Setup takes. For an explanation of duplicate items displayed in the Program Manager Items or Shortcuts pages, see “Why Does the List Contain Duplicate Items?” earlier in this chapter. 

Select Shortcuts for the Start Menu or Desktop



The Start Menu and Desktop Items page in the Network Installation wizard allows you to select the shortcuts that appear in the Windows\Start Menu folder or on the desktop when you install an application on a computer running Windows 95 or Windows NT Workstation 4.0. 

�
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Note: The shortcuts in the list include all the program files defined in the .stf file; however, not all of these items are necessarily installed during client Setup. For more information about which items are installed and how Setup handles duplicate items, see “Why Does the List Contain Duplicate Items?” earlier in this chapter. 

To change the properties of a shortcut, select it in the list box, and then click Edit. In the Edit Shortcut dialog box, you can change the folder in which the shortcut is installed, as well as the name and working folder of the shortcut. 
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�

You can use a set of special folder identifiers to specify standard Start Menu folders in the Edit Shortcut dialog box. For example: 



This folder identifier�Represents this folder����<StartMenuFolder>�The Start Menu folder��<ProgramsFolder>�The Programs folder in the Start Menu��<StartupFolder>�The Startup folder in the Start Menu��<DesktopFolder>�The Desktop folder��

You can also append a subfolder to a standard folder identifier. The Working directory can be a full path or a special folder as used in the Browse dialog box in the Components page. 

Choose Folder for Modified Setup Files



In the Choose Setup Files Subfolder page, specify the subfolder in which you want the Network Installation wizard to create the customized .inf, .stf, and .lst files. The subfolder name you specify will be created in the folder in which the original .stf file resides. 

Note: The folder name you enter must conform to the standard MS-DOS 8.3 file name format. 
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�

Add Additional Files to the Installation



The Network Installation wizard allows you to add files to the installation process. These are additional files, provided by you, that Setup installs along with the application files. For example, you could add a template file that you created for your workgroup to use. 
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(	To add files to the installation process



In the Add Files page, click Add. 

In the Add box, select the file you want, and then click Open. 

This can be any type of file located anywhere on the network. 

When the Network Installation wizard asks if you want to copy the selected file to the Custom folder, click Yes. 

In order for added files to be accessible during client Setup, they must reside in the Custom folder. If you click No, you must remember to copy the file to the Custom folder yourself. 

In the Destination folder for selected file box, enter a folder name, or click Browse to find the folder. 

Setup installs the file in this folder during client Setup. You must specify a folder; entering a description in the Description for selected file box is optional. 

�

Add Registry Entries



The Network Installation wizard allows you to add registry entries to the user’s Windows registry during the installation process. This can be useful if, for example, you have written an application that relies on the contents of a particular registry entry. You can add the entry to Setup so that your application is ready after the user completes the installation process. 
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(	To add a new registry entry



In the Add Registry Entries page, click Add. 

The Add dialog box appears. 

In the Root box, enter the name of the top­level key for the new registry entry. 

Top­level keys include the following: HKEY_CLASSES_ROOT; HKEY_CURRENT_USER; HKEY_LOCAL_MACHINE; and HKEY_USERS. 

In the Data type box, click the type of data stored in the new entry—either DWORD (double­word integer) or SZ (string). 

In the Key box, enter the name of the subkey in which the new entry is stored. 

In the Value name box, enter a name for the new registry entry. 

In the Value data box, enter the data to be stored in the new entry. 

The data must match the data type already specified. 

�

In the Description box, type a description of the new registry entry. 

This description is stored with the key in the registry and is optional. 
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For example, you can enter the new registry key HKEY_LOCAL_MACHINE\SOFTWARE\AcmeApps\ClipArt\Installed with a value of Yes using the following entries in the Add dialog box. 



In this box�Select or type this text����Root �HKEY_LOCAL_MACHINE ��Data type �SZ��Key�SOFTWARE\AcmeApps\ClipArt ��Value name �Installed ��Value data �Yes ��Description �Acme clip art is installed ��

Select Quiet Mode



When you run client Setup to install an application on a user’s computer, you can specify a command-line option that will run Setup in a batch mode, which does not require input from the user during the installation. There are a number of possible “quiet” modes that Setup can use that determine whether Setup will display anything to the user or run completely silently. 

The Select Quiet Mode page allows you to choose how you want Setup to run. When the Network Installation wizard is finished, it displays a suggested Setup command string that includes the appropriate command-line option corresponding to the quiet mode you select in this page. 

�
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For example, if you select 4: No Exit or Progress dialogs; force system restart if necessary, then the Network Installation wizard suggests that you use the /QT Setup command-line option. For a description of all Setup command-line options, see Appendix B, “Setup Command-Line Options.”

Save Changes



To complete the customization process, the Network Installation wizard saves the modified .inf, .stf , and .lst files. These files are created in the subfolder you specified in the Choose Setup Files Subfolder page. 

In the Save Changes page, you can specify the names of the customized .stf , .inf, and .lst files. 

�
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Note: The name of the .inf file that you specify here is stored in the .stf file, and the name of the .stf file is stored in the .lst file. If you rename either the .stf file or the .inf file on the disk, Setup will not be able to find it during installation. 

For more information about how to use the modified .stf file with Setup, see “Running Client Setup with the Modified .stf File” later in this chapter. 

�

Done!



When the Network Installation wizard finishes writing the new .inf, .stf, and .lst files, it displays the Done! page. 
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Based on the name of the .lst file you provided in the Save Changes page and the installation type and quiet mode you selected, the Network Installation wizard suggests a Setup command string to use in running Setup. The following command-line options can be displayed: 

The /L file option specifies the name of the customized .lst file. 

The /Bn option specifies the installation type to use when running in batch mode. 

The /Qn option specifies the quiet mode you selected, if any. 



For a description of all Setup command-line options, see Appendix B, “Setup Command-Line Options.” 

�

Running Client Setup with the Modified .stf File

After you have successfully modified the .inf, .stf, and .lst files with the Network Installation wizard, you need to make them available so that users running client Setup use your modified files and not the original ones. 

Note: Because the .inf, .stf, and .lst files are interrelated, you cannot rename any of these files directly on the disk after you have created them with the Network Installation wizard. To change the name of any of these files, run the Network Installation wizard again and specify a different name. 

Using the Modified .stf File



The Network Installation wizard creates the modified .inf, .stf, and .lst files in a subfolder of the folder containing the Setup program. To use the modified files, the user runs Setup from the Setup folder with the command string suggested by the Network Installation wizard. 

For example, suppose the administrative installation point is in a folder named MSOffice on the network share \\Server1\Install, and in the Choose Setup Files Subfolder page of the Network Installation wizard, you specify Custom for the name of the subfolder. To use your customized Setup files, users connect to \\Server1\Install\MSOffice and run Setup with the following command string (along with any other command-line options you require): 

setup /l Custom\NewSetup.lst

Setup opens the Setup.lst file in the Custom subfolder and installs the application using the custom files you created in that subfolder with the Network Installation wizard. 

You can create more than one customized installation by running the Network Installation wizard for each version and saving the .inf, .stf, and .lst files in a unique subfolder. Users can then run Setup specifying the appropriate subfolder in the Setup command string. 

For example, suppose your company has three departments—Engineering, Accounting, and Services—that each have different installation requirements. You run the Network Installation wizard three times, creating a customized installation for each department and saving the custom files in separate subfolders: Engineer, Account, Services. Users from each department can run Setup by connecting to the administrative installation point and using one of the following command strings: 

setup /l Engineer\NewSetup.lst�setup /l Account\NewSetup.lst�setup /l Services\NewSetup.lst

For more information about the command-line options for Setup.exe, see Appendix B, “Setup Command-Line Options.” 

�

Installing over the Network

After you modify the .inf, .stf, and .lst files, you can initiate a client installation using one of three methods: interactive, batch, and push. 

Interactive Installation



In an interactive installation, users connect to the server and run Setup using the command­line options you have chosen. Setup prompts the user for installation information. Modifications you have made to the .stf file are displayed as default responses to user prompts. 

Batch Installation



In a batch installation, you create a batch file that runs Setup using your customized .stf file with the appropriate command­line options. The user runs the batch file, which in turn installs an application with no additional user interaction. Setup does not prompt the user for information, but uses the responses from the customized .stf file instead. 

For example, a command line for Setup might be 

setup.exe /l Custom/NewSetup.lst /q1

The /l option directs Setup to use your custom .inf, .stf, and .lst files in the Custom subfolder. The /q1 option directs Setup to run without further user intervention, displaying only progress indicators to the user. For a description of all the available Setup command­line options, see Appendix B, “Setup Command-Line Options.” 

By placing this command line in a batch file that the user can run, you can create a simple mechanism for users to launch a customized version of client Setup. 

Push Installation



In a push installation, you initiate client Setup automatically with no user intervention. This can be done by putting the customized Setup command line in the user’s system logon script, so the installation is initiated the next time the user logs on to the network. 

You can also use a network administration tool, such as Microsoft Systems Management Server, to initiate a push installation. For more information, see “Using Microsoft Systems Management Server” later in this chapter.

�

Enabling Outlook Automatic Upgrade

If you use a shared installation point for Microsoft Outlook, you can enable the automatic upgrade feature by adding the following line to the end of the Outlook.srg file in the \Program Files\Microsoft Office\Office directory:

[HKEY_LOCAL_MACHINE\software\microsoft\office\8.0\outlook\upgradepath] �“serverpath” = “<\\\\server\\share\\subdir>“

Do not add a trailing backslash. All backslashes must be doubled.

Note: The automatic upgrade feature is available only with Outlook 97 versions 8.01 and 8.02. For more information about these versions, see “Comparing Outlook 97 8.x Versions” in Chapter 1, “Microsoft Outlook 97 Overview.”



Package Definition Files

If you are installing Outlook from the Office CD, you can use the sample package definition (.pdf) files with the Microsoft Systems Management Server to install applications remotely. A network administration tool, such as Microsoft Systems Management Server, lets you distribute a customized version of client Setup to your users. This tool helps you automate large­scale deployment by performing an automatic installation that requires no intervention from you or the user. 

To install the Outlook .pdf file (Outl97.pdf) as well as other Office .pdf files from the Office CD, use the SetupPDF.exe or NewPDF.exe program, described in the following steps.



(	To install the package definition files



For Office 97, click SetupPDF.exe (208K). 

– or – 

For Office 97 Service Release 1, click NewPDF.exe (170K). 

The .pdf files and associated files will be decompressed and placed in the \Program Files\ORK97\Tools\SetupPdf folder on your computer. 

For information about using the sample .pdf files, read the Readme.doc file in this folder. This document contains comprehensive information about installing an application using Microsoft Systems Management Server version 1.2. 

�

Using Microsoft Systems Management Server

Important: This section supplements the Microsoft Systems Management Server documentation; it does not replace it. The procedures that follow provide additional information for using Systems Management Server, but they do not cover all Systems Management Server options and features. For complete information, see the Microsoft Systems Management Server Administrator’s Guide. 

To use Systems Management Server to distribute Outlook and other Office applications remotely, perform the following steps: 

Create a package. A package consists of a folder (the package source folder that contains all the installation files) and a .pdf file. The .pdf file describes the Setup commands that can be used to install an application on client computers. 

Create and run a job to distribute the package. A job consists of a package and a list of destination client computers. Systems Management Server copies the package to distribution servers servicing the client computers and executes the jobs on the client computers. 

Note: Before you use Systems Management Server to install an application, you must create an administrative installation point on a server. Systems Management Server uses the administrative installation point as the package source folder. 

To install an application on your users’ computers, you create a package to run Setup using the standard Typical, Custom, or Run from Network Server installation types, or using a Setup script you have customized. After the package is created, you create a Run On Workstation job to execute Setup on the user computers that you designate. 

Creating a Package



You create a package by using the Systems Management Server Administrator program and importing the .pdf file. The Outlook .pdf file is located in the main Office folder in the administrative installation point and is named Outl97.pdf. 

The .pdf file contains command-line definitions for the standard installation types: Typical and Custom, as well as for the complete installation (a Custom installation with all the components selected) and Uninstall options. Each of these command-line definitions contains a Setup command line that directs Setup to run in batch mode with the specific installation type (except for Custom, which always runs interactively). 

For example, the command line for a Typical installation, using your customized Setup files, is: 

CommandLine = setup.exe /l Custom\NewSetup.lst /q1 /b1

�

The /l command-line option in this example directs Setup to use your custom .lst file in the Custom subfolder. The /q1 command­line option directs Setup to run with no user interaction, and the /b1 option directs Setup to use the Typical installation type. When this command is run from the Systems Management Server package, Setup automatically installs an application using the options you predefined for the Typical installation type in your custom .stf file. For a description of all the available Setup command­line options, see Appendix B, “Setup Command-Line Options.” 

To use one of the standard installation types for installing an application on your client computers, create a package using the unmodified .pdf file. 



(	To create a Setup package



Start the Systems Management Server Administrator program, and switch to the Packages window. 

On the File menu, click New. 

In the Package Properties dialog box, click Import. 

In the File Browser dialog box, select the appropriate .pdf file (Outl97.pdf for �Outlook 97), and then click OK. 

The .pdf file is located in the administrative installation point in the folder containing the main Office application files. 

In the Package Properties dialog box, click Workstations. 

In the Source Directory box, type the location of the administrative installation point. 

In the Workstation Command Lines box, click the installation type you want, and then click Close. 

�EMBED PBrush���

�

To create a Setup command that differs from those available in the .pdf file, you can add a new command to the .pdf file. For example, if you want Setup to run with your custom Setup files and to generate a log file, add a new command in the .pdf file that runs Setup using the command­line options /l and /g. You do this with the Systems Management Server Administrator program. 



(	To add a new command to the package



Start the Systems Management Server Administrator program, switch to the Packages window, and then select the package you created. 

On the File menu, click Properties. 

In the Package Properties dialog box, click Workstations. 

In the Source Directory box, type the location of the administrative installation point, and then click New. 

In the Command Name box, type a name for the new command. 

For example, type Install Outlook.

In the Command Line box, type the command to run your custom Setup. 

For example, to run a Typical installation of Setup with your custom Setup files in full quiet mode, generating a log file, type: 

setup.exe /l Custom\NewSetup.lst /b1 /qt /g “setup.log”

To indicate that no user input is required to run the package, select the Automated Command Line check box. 

If you are installing on Windows NT Workstation, you can also select the System (Background) Task check box to indicate that you want the package to run in the background. 

In the Supported Platforms box, select the appropriate operating systems, Windows 95, Windows NT, or both, and then click OK. 

In the Workstation Command Lines box, select the command you created, and then click Close. 



Note: For more information about creating, modifying, or distributing packages, or for information about other package options available in Systems Management Server, see the Microsoft Systems Management Server Administrator’s Guide. 



�

Creating a Job for the Package



After you create the Systems Management Server package, you can create a Run On Workstation job to distribute the package. 



(	To create a Run On Workstation job



Start the Systems Management Server Administrator program, and switch to the Jobs window. 

On the File menu, click New. 

In the Job Properties dialog box, click Details. 

In the Package box, click the package you created. 

Under Run Phase, select the Run Workstation Command check box, select one of the Setup commands in the package, and then click OK. 



�EMBED PBrush���

Important: The previous procedure describes how to create a simple job for the package and how to select the appropriate Setup command line. To finish creating the job, you must define job targets (user computers) on which to install an application, and you must set the job schedule. For more information about creating and scheduling the job, see the Microsoft Systems Management Server Administrator’s Guide. 

When the job is executed, Systems Management Server copies all the files from the main Office folder on the administrative installation point to a folder on one or more Systems Management Server distribution servers that service the users on your network. When a user runs the package, Setup is run from within this copy of the administrative installation point. 



�

Outlook Messaging Profiles

The messaging profile settings for Outlook are contained within a Profile Descriptor File (.prf). The default .prf file for Outlook is Outlook.prf. This file is located on the Outlook Client CD and in the Office folder on the Office CD. Your version of this file might vary slightly depending on which version of Outlook you have installed. Setup puts a copy of this file in the Windows folder on your hard disk.

A messaging profile contains information services that control the way the client works. A profile contains a group of settings that define how Outlook is configured for a particular user. A profile can include these types of settings: 

Services—Services and service properties 

Delivery—Delivery options, such as default mail location and address processing 

Addressing—Addressing preferences and address list order



For example, a profile could include access to a mailbox on Microsoft Exchange Server and specify that the Outlook Address Book appear in the Address Book. A profile can contain any number of information services, and it can contain more than one e-mail transport (delivery) service. For example, a single profile might contain MSN and Internet Mail services. In this example, you can check MSN and Internet Mail accounts without restarting Outlook. 

Messaging profiles and information services work hand-in-hand to enable users to apply all the features of Outlook. Information services control how messaging applications address and route mail and how mail and folders are stored. They specify the delivery location for incoming mail and the location of a user’s personal address book and any sets of personal folders that the user creates. They also enable users to send faxes or connect to other mail systems, such as the Internet. Before using an information service, a user must add the service to his or her active profile.

When a user first starts Outlook on a system without a Windows Messaging profile, Outlook automatically creates a profile. The default Outlook profile includes services for Personal Folders and the Outlook Address Book. After starting Microsoft Outlook, the user can add services for Internet Mail, Microsoft Mail, Lotus cc:Mail, or other messaging systems.

�

Generally, the profile that a user creates during installation is the only profile the user will need. However, if more than one person uses the same computer, each person should have a separate profile to keep his or her mail private and secure. A user can have Outlook start with the same profile every time, or the user can select a profile to use each time Outlook is opened. If a user needs to work with a different set of services, that person can create an additional profile for those services. A user can copy an existing profile, rename it, and then modify the profile as needed. Users can also protect their profile with a password. 

For more information about profiles, see the Outlook profiles document. 

(	To view the Outlook profiles document



From your CD, click Profiles.exe (170K). 

The files will be decompressed and placed in the \Program Files\ORK97\Outlook\Profiles folder on your computer. 

In this folder, double­click Profiles.doc. 



Outlook.prf File Format

This section describes the format of the Outlook.prf file. A unique Outlook.prf file is required for every unique messaging profile. Administrators can customize the Outlook.prf file before installing Outlook, or after installing but before the user starts Outlook for the first time. Administrators can also use Outlook.prf file in conjunction with the Automatic Profile Generator (Newprof.exe) to automate the creation of messaging profiles; for more information, see “Automatic Profile Generator” later in this chapter. 

The Outlook.prf file contains information relating to the services that will be installed in the profile and contains four major sections: 

Section 1: Profile defaults 

Section 2: Services in the profile 

Section 3: Default values for each service 

Section 4: Mapping for profile properties 



To review a sample Outlook.prf file, see Appendix A, “Sample Outlook.prf File.”



�

Section 1: Profile Defaults



Section 1 of the .prf file contains values that apply to the entire profile, specified in the [General] section. The following table describes the [General] section entries: 



Entry�Description����ProfileName=<Name of the Profile>�Specifies the profile name when the profile is created.��DefaultProfile= [Yes/No]�If the value is set to Yes, specifies that the profile that you create is set as the default profile. By default, this entry is set to Yes.��OverwriteProfile= [Yes/No]�Determines whether the profile that you create should overwrite an existing profile with the same name. If the value is set to No and a profile with the same name as that specified in the ProfileName entry does exist, the profile is not created. The default value is No.��DefaultStore=<Service ID>�<Service ID> corresponds to a service used as the default store. Each entry listed in the [Service List] section has a Service ID. By default, the value is set to Service2, which corresponds to the Microsoft Exchange Server Service. ��

Section 2: Services in the Profile



The second section of the file lists all the services that will be installed with the profile. The names of the profiles are listed as entries under the [Service List] section. By default the [Service List] section includes these entries: 

Service1=Microsoft Exchange Client

Service2=Microsoft Exchange Server

Service3=Personal Address Book



The services listed in this section are installed only if the settings associated with each of these services are valid. If the Automatic Profile Generator encounters a problem with one or more of the settings associated with a service, it may not install that service in the profile you create. 

�

Section 3: Default Values for Each Service



This section of the file contains service-specific information for the services listed under the [Service List] section. For each of the services listed under the [Service List] section, the Outlook.prf file should include a section with that service name. This section should contain entries for each configurable option for the service. By default, the service options include the following: 

[Service1]  Contains configurable options for the Microsoft Exchange Client. The different settings available in the Microsoft Exchange Client are described in Section 4 of the .prf file; for more information, see “Section 4: Mapping for Profile Properties.”

[Service2]  Contains settings for the Microsoft Exchange Server service. The different configurable settings available in the Microsoft Exchange Server service are described in Section 4 of the .prf file; for more information, see “Section 4: Mapping for Profile Properties.”

[Service3]  Contains settings for the Microsoft Exchange Personal Address Book service. The different configurable settings available in the Microsoft Exchange Personal Address Book service are described in Section 4 of the .prf file; for more information, see “Section 4: Mapping for Profile Properties.”



Section 4: Mapping for Profile Properties



This section of the file contains a listing of all the supported properties for each of the services that the Automatic Profile Generator supports. There is a section for each service in the file. By default, the sections include:

[Microsoft Exchange Client]

[Microsoft Exchange Server]

[Personal Folders]

[Personal Address Book]

[Microsoft Mail]



For each entry in the [Service List] section, a corresponding section must exist in Section 4 of Outlook.prf. For example, if the [Service List] section includes an entry for “Service1=Microsoft Exchange Client,” a section named [Microsoft Exchange Client] must exist in Section 4 of this file. The [Microsoft Exchange Client] section contains descriptions of all the options that can be set for the Exchange Client. Each description contains the type of entry and an internal identification number. Also, a text description of the entry explains the purpose of the option and the values that you can assign. 

�

The Automatic Profile Generator reads Section 4 to determine how to interpret each of the options. The textual description of each option is commented out, so the Automatic Profile Generator ignores these lines. Using the previous example, if the [Service List] section includes an entry for “Service1=Microsoft Exchange Client,” a section named [Service1] must exist in Section 3 of the file, and a section named [Microsoft Exchange Client] must exist in Section 4. 

For each entry specified in the [Service1] section, a corresponding entry must exist in the [Microsoft Exchange Client] section, which describes the type (whether the option is a Boolean variable, an integer, and so on) and an internal identification number. If the corresponding entry is not present in the [Microsoft Exchange Client] section, the Automatic Profile Generator will not be able to interpret that option and will display an error message. 



Registry Settings for Outlook.prf

The following table identifies the registry settings for Outlook.prf. These entries are located under the following key: HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\Windows Messaging Subsystem\Profiles 



�Name��Tab�Original Address��Data Type��Address����NewItemPlaySound�E-Mail�000b023e�PT_BOOLEAN�0x023e��NewItemChangeCursor�E-Mail�000b023f�PT_BOOLEAN�0x023f��NewItemNotificationMessage�E-Mail�000b0240�PT_BOOLEAN�0x0240��AllowCommaSeparator�Sending�000b0350�PT_BOOLEAN�0x0350��AutoNameChecking�Sending�000b0332�PT_BOOLEAN�0x0332��TrackingTellWhenMsgDelivered�Sending�000b014c�PT_BOOLEAN���TrackingTellWhenAllMsgsRead�Sending�000b0141�PT_BOOLEAN���SaveRepliesWithOriginal�Sending�000b0208�PT_BOOLEAN�0x0208��SaveForwardedMsgs�Sending�000b0205�PT_BOOLEAN�0x0205��MarkComments�Reading�000b0319�PT_BOOLEAN�0x0319��MarkCommentsWith�Reading�001e0345�PT_STRING8�0x0345��CloseOriginalMsgOnReply�Reading�000b0132�PT_BOOLEAN�0x0132��PublishPeriodFreeBusy�Calendar/�Advanced�00030330�PT_LONG�0x0330��ArchiveFileFullPath�AutoArchive�001e032�PT_STRING8�0xe032��PromptBeforeArchive�AutoArchive�000b0321�PT_BOOLEAN�0x0321��DeleteExpiredItems�AutoArchive�000b0322�PT_BOOLEAN�0x0322��AutoArchive�AutoArchive�000b0320�PT_BOOLEAN�0x0320���

Installing Messaging Profiles

The default profile for Outlook, Outlook.prf, creates a profile with Personal Folders and Outlook Address Book. 



(	To set the default profile in Outlook



Click the Start button, point to Settings, and then click Control Panel. 

To create a new profile, double-click either the Mail or the Mail and Fax icon. If you have not installed Windows Fax services, you may see only the Mail icon.

The Services tab lists any services installed for the current default profile.

On the Services tab, click Show Profiles. 

On the General tab, click one of the listed profiles that you want to use as the default profile.



To change the default profile that Outlook creates, replace the Outlook.prf file with an alternative version. The alternative profiles provided are: 

Exchange.prf. Creates a profile with Microsoft Exchange Server and Outlook Address Book. To use this profile, you need to know the name of a Microsoft Exchange Server in your organization. 

None.prf. Causes Outlook to run the Inbox Setup wizard, which allows users to select profile services. 



(	To install and use an alternative Outlook profile



From the \Program Files\ORK97\Outlook\Profiles folder, copy Exchange.prf or None.prf to the Windows folder on your computer. 

If you are using Exchange.prf, open it in a text editor (such as Notepad), find the line HomeServer = in the [Service2] section, and set it to the name of a Microsoft Exchange Server in your organization. 

In the Windows folder on your computer, delete Outlook.prf. 

Rename Exchange.prf or None.prf to Outlook.prf. 



�

You can also install an alternative Outlook profile on a network installation point, so that users who install an application from the network can use the new profile. 



(	To install and use an alternative Outlook profile on a network �          installation point



From the \Program Files\ORK97\Outlook\Profiles folder, copy Exchange.prf or None.prf to the Office folder on the network installation point. 

If you are using Exchange.prf, open it in a text editor (such as Notepad), find the line HomeServer = in the [Service2] section, and set it to the name of a Microsoft Exchange Server in your organization. 

In the Office folder on the network installation point, delete Outlook.prf. 

Rename Exchange.prf or None.prf to Outlook.prf. 



Automatic Profile Generator

Administrators can use the Automatic Profile Generator (Newprof.exe) to automate the creation of messaging profiles for their user communities. The Automatic Profile Generator creates a default messaging profile with the settings that you have specified. This process is transparent to the user.

When the user first starts Outlook, the application searches for Outlook.prf in the user’s Windows folder and verifies that the file includes the Custom=1 setting in the [General] section. Then, Outlook runs Newprof.exe to create a new profile using the settings in Outlook.prf. If you use Newprof.exe, users don’t need to create their own profiles after Outlook has been installed. If Outlook cannot locate Outlook.prf, the application launches the Windows Messaging Inbox Setup wizard.

You can run the Automatic Profile Generator during Setup or from the command line. Newprof.exe uses the .prf file to determine the settings for the new profile. If no default profile exists in the user’s home directory and a .prf is present, Newprof.exe creates a profile based on the information that you specified in the .prf file. 

You can run Newprof.exe with a .prf file from the command line with a variety of distribution mechanisms such as SMS, logon scripts, and e-mail. If you use it with logon scripts, Newprof.exe can be used to create default profiles for roving users when they log on to a new computer. Roving users are users who log on to Outlook from different computers in an organization.

�

Automatically Creating Profiles for Roving Users



Many users need to gain access to their e-mail from different computers. For example, a roving user can have two offices in two different locations. You can make it easier for a roving user to log on to a new computer by using the automatic profile generator to create a default profile. If you preconfigure a default profile, roving users don’t need to create a profile using the Profile wizard every time they log on to a new client computer because the automatic profile generator creates one if needed.

To create profiles for roving users automatically, you can create a .prf file with the user’s logon name and home server defined. You can also configure the logon script to verify that a profile does not exist for that user on the computer. If the computer doesn’t already have a profile defined for the user, the logon script calls Newprof.exe. Newprof.exe uses the .prf file in the user’s home directory to create a new profile.

About the HomeServer= Setting



Exchange Server administrators should replace the default Outlook.prf file. The default profile includes Personal Folders (a local .PST file) as the default message store, and does not include the Exchange Server service. Exchange administrators should copy Exchange.prf from the Office Resource Kit to their shared Outlook installation drive, edit it to provide a correct HomeServer=setting, and rename it Outlook.prf. 

The HomeServer=setting is required for automatic configuration of an Outlook profile for Exchange Server users. The listed server can be any server in your Exchange domain; it does not need to be the user’s specific home server. Outlook will query the user directory of the server you specify and will substitute the correct server name. 

For example, if you have three servers—Server1, Server2, and Server3—in the same Exchange Server domain, you could create a single Outlook.prf file with HomeServer=Server1 for all Outlook installations. Outlook will substitute the correct server name for each user. 

You should create separate Outlook.prf files with specific server names to allow for slow links or gaps in your wide area network (WAN). For example, users installing Outlook in Europe should be pointed to an Exchange Server in Europe and not in North America. 

�

If Outlook cannot resolve the user’s name within the user directory of the Exchange Server you specify, Outlook will not start. Provide the correct values for the user’s mailbox name and server name in the Mail and Fax properties in Control Pane, and then restart Outlook. 

Configuring Outlook User Options



Some Outlook user options can be configured by editing the Outlook.prf file. The configurable options include: 

Option�Description����EmptyWastebasket�Indicates that the Deleted Items folder is permanently emptied when exiting Outlook. The default value is False.��SelectEntireWord�When selecting text, automatically selects entire words. The default value is True.��AfterMoveMessage�Opens the next, previous, or no message after deleting the current message. The default value is the previous message.��CloseOriginalMessage�Closes the original message when the user replies or forwards. The default value is False.��GenReadReceipt�Requests a read receipt report for every sent message. The default value is False.��GenDeliveryReceipt�Requests a delivery confirmation report for every sent message. The default value is False.��DefaultSensitivity�Specifies the default sensitivity level for new messages. The default value is Normal.��DefaultPriority�Specifies the default priority level for new messages. The default value is Normal.��SaveSentMail�Indicates that all sent messages are saved in the Sent Mail folder. The default value is True.��

�

Using Command Line Options with Newprof.exe 



By default, if you do not supply any parameters for Newprof.exe, it looks for the file Default.prf in the Windows directory. Newprof.exe accepts the following command-line options: 

NEWPROF [-P <Path to .PRF file>] [-S] [-X] [-Z]

The following table describes these options. 

Command�Description����-P <Path to .PRF file>�Specifies the .prf file with the complete path��[-S]�Causes Newprof.exe to display a window that allows the user to choose a .prf file and displays status and error messages.��[-X]�Causes Newprof.exe to start execution automatically when the [-S] option is used, without waiting for a .prf file to be selected. This option requires either the [-P] option or the Default.prf file to be present in the Windows directory.��[-Z]�Causes Newprof.exe to display MAPI error codes when errors are encountered. This option requires the [-S] option.��

Note: Newprof.exe does not generate any log files.





Modifying Outlook Registry Entries

The following two scenarios describe instances when an administrator might want to modify a Windows registry setting for an Outlook function.



Deleted Items from Shared Mailbox

In Outlook, when you delete items from a Mailbox folder of another user where you have delete privileges, the deleted items go into your Deleted Items folder rather than into the folder of the mailbox owner. Outlook 97 version 8.02 provides a Windows registry setting to switch the destination of deleted items to the mailbox owner’s Deleted Items folder.



WARNING: Using Registry Editor incorrectly can cause serious problems that may require you to reinstall Windows 95. Microsoft cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. For information about how to edit the registry, view the “Changing Keys And Values” online Help topic in Registry Editor (Regedit.exe). Before you edit the registry, you should make a backup copy of the registry files (System.dat and User.dat). Both are hidden files in the Windows folder.



�

(	To switch the destination of Deleted Items



On the Outlook File menu, click Exit and Log Off. 

Click the Start button, and then click Run. 

In the Open window, type regedit, and then click OK. 

Move to the following entry in the registry: 

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\�Options\General 

Right-click the DelegateWastebasketStyle key, and then click Modify. 

If the key is not present, you will need to create it. Right-click the General folder. On the shortcut menu, point to New, and then click DWORD Value. Then, type DelegateWastebasketStyle as the name for the new key, and press ENTER. 

Change the Value data in the Edit DWORD Value dialog box to one of the following values: 

8 = stores deleted items in your folder

4 = stores deleted items in the mailbox owner’s folder

Quit the Registry Editor. 

Restart Outlook. 



Enabling/Disabling AutoNameCheck Feature

AutoNameCheck helps ensure that users’ e­mail messages are sent to the intended recipients by quickly and clearly identifying ambiguous e­mail names. While the user composes the body of the message, Outlook automatically checks the e­mail names. If a name, abbreviated name, or nickname matches an entry in the address book, Outlook displays the full name. 

If a name matches more than one address book entry, Outlook marks the ambiguous name with a red underline, similar to a misspelled word in Microsoft Word. Users can right-click the ambiguous name to choose the correct name from a list. After a user has resolved an ambiguous name, Outlook automatically remembers the ambiguous name as a nickname and proposes the same address book entry the next time the nickname is entered. 

Also, Outlook automatically resolves and properly formats Internet e­mail addresses by removing spaces and changing commas to periods. For example, “david good @ ms,com” is changed to “davidgood@ms.com”.

�

Recent enhancements to the AutoNameCheck feature include:

An improved method for storing nicknames, making it easier to control the nickname list. 

A default 64-entry limit for the nicknames list and the ability to increase this limit in the Windows registry. 

The ability to turn the building of a nickname list on or off, without affecting the automatic name checking setting in the Outlook profile. 

A resource kit utility so that advanced users can remove names from the cache one at a time. 

A new Non-Delivery Receipt message that tries to determine if the non-delivery resulted from a bad nickname. If so, Outlook deletes the bad nickname from the list. 



WARNING: Using Registry Editor incorrectly can cause serious problems that may require you to reinstall Windows 95. Microsoft cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. For information about how to edit the registry, view the “Changing Keys And Values” online Help topic in Registry Editor (Regedit.exe). Before you edit the registry, you should make a backup copy of the registry files (System.dat and User.dat). Both are hidden files in the Windows folder.



The new cache method uses a file to store nicknames. The following registry key identifies the nickname file (the key is of value type STRING): 

 HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\�AutoNameCheck\NicknamePath = <full path to nickname file>



(	To change the 64-entry limit for the nicknames list



The new cache size defaults to a 64-entry limit. You can specify another size in the following registry key by changing the value type DWORD: 

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\�AutoNameCheck\MaxNicknames = <maximum number of entries> 



(	To turn the nicknames list on or off



You can turn the storage of a nickname list on or off without changing the automatic name check feature. To turn off the nicknames feature, in the following registry key change the value type DWORD to 1: 

KEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\�AutoNameCheck\NoNicknames = <0 or 1>

If the registry key is missing or set to zero, the nicknames feature is turned on. 



�

�Chapter 3

Migration

This chapter describes two important migration tools, the SC2 Importer and the Microsoft® Outlook™ Migration Kit, which administrators can use to migrate Microsoft Schedule+ calendar information to Outlook 97. Learn how to install and use these tools, and understand the types of data that the tools convert. 

Note: This chapter describes tools for server-side migration; end-user tools are not discussed. For information about end-user migration tools, such as client import/export utilities, see the Outlook Web site at http://www.microsoft.com/outlook/.
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SC2 Importer for Microsoft Outlook 97

The SC2 Importer allows Outlook 97 users to import .sc2 data files into the Outlook Calendar. The SC2 Importer serves a special purpose because Schedule+ natively reads .sc2 data files, whereas Outlook does not. You can install the SC2 Importer from the Microsoft Exchange 5.5 Client CD.

When you move from another mail system, such as Microsoft Mail, to Exchange Server, the Exchange Migration Kit (available with Exchange Server 5.0 and 5.5) migrates mail and calendar information into .sc2 format. After the Exchange Migration Wizard completes the migration process, the SC2 Importer converts the resulting .sc2 data file. For more information about the Exchange Migration Wizard, see your Exchange Server documentation.

Note: User intervention is required to complete this process. The SC2 data file is sent to the Outlook user in a mail message; the user opens the file to import the data into the user’s Outlook Calendar.



Installing the SC2 Importer

Before installing the SC2 Importer, you must have Outlook installed.

(	To install the SC2 Importer for Microsoft Outlook 97



Verify that Outlook is installed on your computer.

In the \Support folder, double-click Msimpsc2.exe.

When asked if you want to continue, click Yes.

The following files are installed:

AsycFilt.dll	•	Msvbvm50.dll

Betaeula.txt	•	Msvcrt.dll

Cfgmgr32.dll	•	Newvers.dll

ComCat.dll	•	OleAut32.dll

Comctxl32.ocx	•	OlePro32.dll

Ctl3d32.dll	•	Setupapi.dll

Impsc2.exe	•	StdOle2.tlb

Impsc2.inf	

After the files are installed on the computer, the Exchange Migration Wizard mails an .sc2 file to the new Outlook user as an attachment to a new mail message. When the user double-clicks the .sc2 file in the mail message, the converter takes the data and imports it into the user’s Outlook Calendar. The imported data converts to either a .pst file or a mailbox on the server, depending on the user’s default store.

�

Schedule Data

This section describes the .sc2 schedule data contained in the attachment mailed to the new Outlook user. This .sc2 data is created by the Exchange Migration Wizard when an administrator migrates mail and calendar information from another mail system to Exchange Server.

Primary and Secondary Files



The .sc2 data in the mail attachment consists of primary and secondary files. In the primary file, the schedule data appears to be another message in the message section. In the following example, the third message (shown in bold) is the schedule message, which is placed in the user’s Inbox. 

MAILMESSAGE,PROFS:SANFRAN(HOWARDS)�Folder,Sender,To,Cc,Bcc,Subject,Send-Date,Received-Date,Priority,Unread,Unsent,Body�,Bill Lee,Howard Snyder,,,"End of Month Report",19950321093421,,-1,,,#SALESPO1.SEC(54)�Phoenix Project,Pat Parkes,Howard Snyder,,,Back Office Review,,,,,,#SALESPO1.SEC(161)�,Howard Snyder,Howard Snyder,,,Schedule+,19951005022543,,1,TRUE,,#SALESPO1.SEC(356)



In the secondary file, the body of the message should be set to a length of 0. The Exchange Migration Kit automatically adds instructions for importing the schedule file in English, German, French, or Japanese, depending on the language of your Microsoft Exchange Server.

Type,Length,Encoding,Islast,Name,Position,Format�Body,0,,FALSE,,,�Schedule,298,,True,HOWARDS.SC2,-1,�SCHEDULE+2 EXPORT VERSION 103�…



Schedule File Format



The first line in the schedule file must be a header line as follows:

SCHEDULE+2 EXPORT VERSION 103



Each line thereafter contains schedule properties and values. The following table describes the differences between the schedule file format and the standard migration file format.



Property�Description����Object�The file starts with a line that describes the type of data (for example, “Projects”), followed by a colon. The next line has an open brace ({). Thereafter, each line contains a property, followed by a colon and the value. The last line of the table has a close brace (}). This format is comparable to a header line and a row of data in the migration file format.���

Property�Description����Object containing �an object�An object can contain another object. Within open and close braces of an object, another set of braces can designate another object. For example, recurring appointments can contain exception objects to describe modified or deleted single appointments in the recurring appointment schedule.��Separator�Schedule file format uses a colon instead of a comma to separate schedule property names from values. A space must follow the colon.��Space�A space after a colon and before a value is ignored. You can use spaces to make the file more readable.��Line continuation character�Schedule file format uses a backslash (\), followed by a carriage return and a line feed, to indicate that the line continues. Lines cannot exceed 80 characters. You can use two line continuation characters to make a line break in appointment or task descriptions.��Quotation mark�Schedule file format encloses all strings and binary data in quotation marks. Quotation marks inside these values are represented by a backslash followed by a quotation mark (\”).��Date/Time�Date = mm-dd-yyyy. Time = hh:mm, 24-hour format. You can join date and time with a space: mm-dd-yyyy hh:mm. For example, 9:00 A.M. on New Year’s Day would be 01-01-1998 09:00. All times and dates are imported in the time zone of the user.��

Tip: To see examples of the schedule file format, create examples in Schedule+ and then export the calendar.



The following table identifies Schedule+ objects that can be created in the schedule file format.



Property�Description����Projects�Table of all projects��Contacts�Table of contacts��SingleAppointments�Appointments that occur only once��SingleEvents�Events that occur only once��SingleTasks�Tasks that occur only once��RecurringAppointments�Appointments that occur more than once��RecurringEvents�Events that occur more than once��RecurringTasks�Tasks that occur more than once��



Each type of property can occur multiple times within the file. If objects of the same type are kept together, import performance is improved. 

�

The following sample file contains each type of Schedule+ object.

SCHEDULE+2 EXPORT VERSION 103

Projects:

{

	data

}

Projects:

{

	data

}

Contacts:

{

	data

}

RecurringAppointments:

{

	data

}

RecurringEvents:

{

	data

}

RecurringTasks:

{

	data

}

SingleAppointments:

{

	data

}

SingleEvents:

{

	data

}

SingleTasks:

{

	data

}



Schedule+ Projects



The following examples illustrate the Projects format:

Projects: 	

{

	Priority: 	16945

	Text: 	"Colossus Project"

}

Projects: 	

{

	Priority: 	16689

	Text: 	"Region 6 Spring Sales Drive"

}

�

The following table describes the properties of Projects. 



Property�Description����Priority�Urgency of project��Text�Description of project��

For more information about priorities, see “Priority Property” later in this chapter.

Schedule+ Contacts



Schedule+ Contacts are separate from Microsoft Exchange Client .pab file entries. There is no link between them. Depending on the configuration of your source system, Contacts can be imported into Schedule+ if entries are created in the schedule migration file. You can also create Contacts from .pab file entries in the source system. Users can delete Contacts created this way, but they cannot add information from .pab file entries to the Contacts list.

The following example illustrates the Contacts format:

Contacts: 	

{

	LastName: 	"Lee"

	Department: 	"MIS"

	AddressBusiness: 	"12 Main St"

	CountryBusiness: 	"USA"

	PhoneBusiness: 	"415 555-9839"

	CityBusiness: 	"San Francisco"

	Office: 	"16/2102"

	Company: 	"Ferguson & Bardell"

	Assistant: 	"Sarah"

	ZipCodeBusiness: 	"94105"

	CurrentPhone1: 	4

	FirstName: 	"William"

	StateBusiness: 	"CA"

	JobTitle: 	"Team Manager"

}



The following table describes the properties of Contacts.



Property�Description����AddressBusiness�Business address��AddressHome�Home address��Assistant�Assistant of the contact��CityBusiness�City for the business address��CityHome�City for the home address��Company�Company��CountryBusiness�Country for the business address���

Property�Description����CountryHome�Country for the home address��Department�Department��FirstName�First name��JobTitle�Job title��LastName�Last name��Notes�Miscellaneous information��Office�Office location��PhoneAssistant�Phone number of the contact’s assistant��PhoneBusiness�Business phone number��PhoneBusiness2�Second business phone number��PhoneFax�Fax phone number��PhoneHome�Home phone number��PhoneHome2�Second home phone number��PhoneMobile�Mobile phone number��PhonePager�Pager phone number��Spouse�Name of the contact’s spouse��StateBusiness�State or province of business address��StateHome�State or province of home address��User1�User-defined string for contact information that does not fit any other field��User2�User-defined string for contact information that does not fit any other field��User3�User-defined string for contact information that does not fit any other field��User4�User-defined string for contact information that does not fit any other field��ZipCodeBusiness�Business address postal code��ZipCodeHome�Home address postal code��

Schedule+ SingleAppointments



If attendees are invited to a migrated appointment, put their names into the Notes or Text property of the appointment. To make it easier for the user to send mail to the attendees or to add the attendees to the attendees list, use a semicolon to separate the names. Then, the user can copy the list of names into the To line of a message or to the attendees list, and resolve them against the address book.

�

Schedule+ appointments can list outside attendees. Their unique MAPI ID is stored with the appointment and is used to verify responses to meeting requests. Without an attendee’s MAPI ID, the display name cannot be added to the attendees list.

The following example illustrates the SingleAppointments format:

SingleAppointments: 	

{

	Ring: 	T

	AlarmAmount: 	15

	Text: 	"Attend training class."

	AlarmTypeUnit: 	0

	AlarmAmountOriginal: 	15

	BusyType: 	0

	Start: 	3-5-1996 15:00

	End: 	3-5-1996 17:00

}

SingleAppointments: 	

{

	Where: 	"Rona's office"

	Text: 	"Meet with Rona about shifting contacts to new employees.\

\

Rona Rumalski"

	Ring: 	T

	AlarmAmount: 	15

	Start: 	3-5-1996 09:00

	BusyType: 	1

	End: 	3-5-1996 10:30

	AlarmTypeUnit: 	0

}



The following table describes the properties of SingleAppointments.



Property�Values�Description����AlarmAmount�Integer�Length of time before a meeting date to an issue a reminder��AlarmTypeUnit�0 = Minute�1 = Hour�2 = Day�3 = Week�4 = Month�Unit of measurement for AlarmAmount��BeforeEnd�T or F�Default = F�Reminder is set relative to the end rather than to the start of SingleAppointment��BusyType�0 = Tentative�1 = Busy�If SingleAppointment should appear busy or tentative��End (Required)�mm-dd-yyyy hh:mm�End date and time for SingleAppointment��IsRecurringInstance�T or F�Default = F�If SingleAppointment is an instance of a recurring series���

Property�Values�Description����Notes��Miscellaneous information; text appears in the Notes property page for an appointment��Ring�T or F�Default = T�If reminder was set for SingleAppointment��Start (Required)�mm-dd-yyyy hh:mm�Start date and time for SingleAppointment��Text��Description for SingleAppointment; text appears on Calendar�� Where��Location for an appointment��

Schedule+ SingleEvents



Events are different from appointments in the following ways:

Events appear above the day’s calendar.

Events do not have attendees.

Reminders for events are based on midnight.



The following example illustrates the SingleEvents format:

SingleEvents: 	

{

	Ring: 	T

	AlarmAmount: 	2

	Text: 	"River City 10 mile hike and camp. (Weather permitting.)\

Call Josh at 555-1232 to make sure it is happening."

	AlarmTypeUnit: 	2

	AlarmAmount: 	2

	StartDate: 	3-2-1996

	EndDate: 	3-3-1996

}



The following table describes the properties of SingleEvents.



Property�Values�Description����AlarmAmount�Integer�Length of time before midnight to issue a reminder��AlarmTypeUnit�0 = Minute�1 = Hour�2 = Day�3 = Week�4 = Month�Unit of measurement for AlarmAmount��BusyType�0 = Tentative�1 = Busy�If an event should appear busy or tentative��EndDate (Required)�mm-dd-yyyy�End date for an event���

Property�Values�Description����IsRecurringInstance�T or F�Default = F�Indicates if an event is an instance of a recurring series��Notes��Miscellaneous information��Ring�T or F�Default = T�If a reminder was set to sound for an event��StartDate (Required)�mm-dd-yyyy hh:mm�Start date for an event��Text�String�Text (description) for an event��

Schedule+ SingleTasks



Schedule+ relates tasks to projects by using the ProjectID number. Without a ProjectID number, tasks are imported without a relationship to a project. 

The following example illustrates the SingleTasks format:

SingleTasks: 	

{

	Priority: 	16672

	Text: 	"Update summer catalog."

	AmountActualEffort: 	0

	AmountEstimatedEffort: 	1

	IsTaskAutoDone: 	T

	StartDate: 	3-6-1996

	AmountStartWork: 	4

	TypeUnitStartWork: 	2

	EndDate: 	3-10-1996

	TypeUnitEstimatedEffort: 	2

	TypeUnitActualEffort: 	2

}



The following table describes the properties of SingleTasks.



Property�Values�Description����AmountActualEffort�Number�Amount of time the task actually took, in units set by TypeUnitActualEffort��TypeUnitActualEffort�0 = Minute�1 = Hour�2 = Day�3 = Week�4 = Month�Unit of measurement for the actual task��AmountEstimatedEffort�Number�Amount of time the task is estimated to take, in units set by TypeUnitEstimatedEffort��TypeUnitEstimatedEffort�0 = Minute�1 = Hour�2 = Day�3 = Week�4 = Month�Unit of measurement for the estimated completion of the task���

Property�Values�Description����AmountStartWork�Number�Amount of time before the end date to start work on an item, in units set by TypeUnitStartWork��TypeUnitStartWork�0 = Minute�1 = Hour�2 = Day�3 = Week�4 = Month�Unit of measurement for an amount of time before the end date to start work��Billing�String�Billing information��CompletedDate�mm-dd-yyyy�Date task was completed��StartDate�mm-dd-yyyy�Date task starts��EndDate�mm-dd-yyyy�Date task ends��IsTaskAutoDone�T or F�If task should appear as automatically completed on the end date��Mileage�String�Mileage associated with a task��PercentCompleted�Number�Percentage of task completed��Priority�See Priority Property in this chapter..�Priority of a task��

Priority Property



Schedule+ prioritizes tasks by using numbers (1 through 9) and/or letters (A through Z). For example, “A1,” “3,” and “B” are valid priorities. The migration file format converts this priority to a decimal. 

The following table illustrates how priorities are converted to decimal versions. The ASCII value of the letter or number is converted to a hexadecimal, the number 20 is prefixed or appended as a space and place holder, and this number is converted to a decimal.



�Priority�Convert to hexadecimal��Prefix or append 20��Convert to decimal����1�31�2031�8241��2�32�2032�8242��3�33�2033�8243��4�34�2034�8244��5�35�2035�8245��6�36�2036�8246��7�37�2037�8247��8�38�2038�8248���

�Priority�Convert to hexadecimal��Prefix or append 20��Convert to decimal����9�39�2039�8249��A�41�4120�16672��B�42�4220�16928��C�43�4320�17184��D�44�4420�17440��E�45�4520�17696��F�46�4620�17952��G�47�4720�18208��H�48�4820�18464��I�49�4920�18720��J�4A�4A20�18976��K�4B�4B20�19232��L�4C�4C20�19488��M�4D�4D20�19744��N�4E�4E20�20000��O�4F�4F20�20256��P�50�5020�20512��Q�51�5120�20768��R�52�5220�21024��S�53�5320�21280��T�54�5420�21536��U�55�5520�21792��V�56�5620�22048��W�57�5720�22304��X�58�5820�22560��Y�59�5920�22816��Z�5A�5A20�23072��

For example, for a number priority of 3, use the hexadecimal 33 and prefix 20. The value 2033 converts to decimal 8243. For example, for a letter priority of C, take the hexadecimal 43 and append 20. The value 4320 converts to 17184.

If your existing system prioritizes by requiring both letters and numbers (for example: A1, B3, or Z9), convert both to hexadecimal, concatenate (link together) the values of the letter and number, and then convert that value to decimal. For example, for a priority of A3, use the hexadecimal of A (41), and concatenate it with the hexadecimal of 3 (33). The value 4133 converts to 16691.

�

Schedule+ RecurringAppointments, RecurringEvents, and RecurringTasks



The following examples illustrate the format for RecurringAppointments, RecurringEvents, and RecurringTasks:

RecurringEvents: 	

{

	Text: 	"Yearly tax audit. Start preparations early."

	Ring: 	T

	AlarmAmount: 	21

	AlarmTypeUnit: 	2

	StartDate: 	3-4-1996

	EndDate: 	3-4-1996

	RecurringType: 	7

	YearInterval: 	1

	DayOfMonthMask: 	8

	MonthOfYearMask: 	4

}

RecurringAppointments: 	

{

	Text: 	"SATR meeting.\

\

Big Sale."

	Ring: 	T

	AlarmAmount: 	15

	DayOfWeekStart: 	0

	StartRecurringTime: 	12:00

	YearInterval: 	1

	WeekInterval: 	1

	BusyType: 	0

	RecurringType: 	51

	StartRecurringDate: 	2-26-1996

	DayOfWeekMask: 	32

	EndRecurringDate: 	3-4-2000

	DayOfMonthMask: 	8

	EndRecurringTime: 	13:00

	MonthOfYearMask: 	4

	AlarmTypeUnit: 	0

}

RecurringTasks: 	

{

	Text: 	"Check online mailbox for new mail."

	Priority: 	8243

	TypeUnitActualEffort: 	2

	AmountEstimatedEffort: 	1

	TypeUnitEstimatedEffort: 	2

	Billing: 	"Billed at higher rate"

	BeforeEndOriginal: 	F

	AmountStartWork: 	0

	StartRecurringDate: 	3-2-1996

	RecurringType: 	64

�

	WeekInterval: 	1

	DayOfWeekMask: 	16

	DayOfWeekStart: 	0

	DayInterval: 	1

	EndRecurringDate: 	8-10-1996

	TypeUnitStartWork: 	2

	Ring: 	T

	AlarmAmount: 	0

	AlarmTypeUnit: 	2

	BeforeEnd: 	F

	Exceptions: 	

	{

		InstanceDate: 	3-3-1996

		StartDate: 3-3-1996

		EndDate:	 3-4-1996

		Deleted: 	F

		Text: "Check online mailbox for new mail. Check for new rates."

		Priority: 	8241

		TypeUnitActualEffort: 	2

		AmountEstimatedEffort: 	1

		TypeUnitEstimatedEffort: 	2

		BeforeEndOriginal: 	F

		AmountStartWork: 	0

		TypeUnitStartWork: 	2

		Ring: 	T

		AlarmAmount: 	5

		AlarmTypeUnit: 	2

		BeforeEnd: 	F

	}



The following table describes the properties shared by RecurringAppointments, RecurringEvents, and RecurringTasks.



Property�Values�Description����DayInterval�1 through  999�Number of days between instances; used only if RecurringType is 64��DayOfMonthMask�1st day of month = bit 0�31st day of month = bit 30�Bit field indicating which days of the month are valid for a recurrence pattern; used only if RecurringType is 7 or 12��DayOfWeekMask�Sunday = bit 0�Saturday = bit 6�Bit field indicating which days of the week are valid for a recurrence pattern; used only if RecurringType is 48, 51, or 56��DayOfWeekStart�0 through 6�Sunday = 0�Start of week preference for recalculating biweekly meetings; used only if RecurringType is 48��EndRecurringDate�mm-dd-yyyy�End date for a recurrence pattern���

Property�Values�Description����EndRecurringTime (required)�hh:mm�End time for a recurring item��Exceptions�See Exceptions Property in this chapter.�Exceptions to a recurring item��FirstRecurringAlarmDate�Today’s date in mm-dd-yyyy format.�First recurring item with an alarm; recalculated during import into Schedule+��MonthInterval�1 through 99�Interval between months for a recurrence pattern; used only if RecurringType is 12 or 56��MonthOfYearMask�January = bit 0�December = bit 11�Bit field indicating the months of the year that are valid for a recurrence pattern; used only if RecurringType is 7 or 51��RecurringType (Required)�  7 = Yearly on specific day�12 = Monthly on specific day�48 = Weekly�51 = Yearly on a pattern�56 = Monthly on a pattern�64 = Daily�Type of recurrence pattern��StartRecurringDate (Required)�mm-dd-yyyy�Start date for a recurrence pattern��StartRecurringTime (Required)�hh:mm�Start time for a recurring item��WeekInterval�Positive integer�Interval between weeks for a recurrence pattern; used only if RecurringType is 48, 51, or 56��YearInterval�Positive integer�Interval between years for a recurrence pattern; used only if RecurringType is 7��

The following table describes additional values required for the RecurringType property.



RecurringType�Required values����  7 = Yearly on specific day�DayOfMonthMask, MonthOfYearMask, YearInterval��12 = Monthly on specific day�DayOfMonthMask, MonthInterval��48 = Weekly�DayOfWeekMask, DayOfWeekStart, WeekInterval��51 = Yearly on a pattern�DayOfWeekMask, MonthOfYearMask, WeekInterval��56 = Monthly on a pattern�DayOfWeekMask, MonthInterval, WeekInterval��64 = Daily�DayInterval���

Exceptions Property



Exceptions are deleted or modified properties of a recurring appointment or task. To delete, only two properties are required: Deleted and InstanceDate. To modify, the appointment or task must be redefined as a single appointment or task, and you must redefine the StartDate and EndDate, even if only the Location property is modified.



Property�Values�Description����Deleted�T or F�If an instance was marked “deleted”; if FALSE, the instance has been modified��InstanceDate�mm-dd-yyyy�Date that the original instance would have occurred��

Known Issues

This list identifies potential SC2 Importer issues:

Large files appear to hang the importer. This problem occurs because the progress indicator increments are much larger than the number of records. This discrepancy causes the indicator to appear frozen, although processing continues.

If a Temp folder does not exist on the computer, setup errors occur.



Microsoft Outlook Migration Kit

The Microsoft Outlook Migration Kit helps an Exchange Server administrator migrate Exchange Server-based Microsoft Schedule+ accounts (2.0 16-bit, 7.0, and 7.5 versions) to Outlook accounts in bulk. In advance, the administrator selects a list of accounts to migrate. Then, the administrator starts the migration process and lets the tool iterate through the list unattended until all of the users are migrated.

The migration of each Schedule+ user essentially automates Outlook’s Import utility to import the contents of each account’s Schedule+ file (.cal or .scd extension) to the account’s Microsoft Exchange server mailbox. All contents of the .cal or .scd file that can be handled by Outlook’s Import utility will be imported—Calendar, Tasks, and Contacts.

To migrate Microsoft Mail 3.x-based Schedule+ accounts to Outlook on Exchange, the administrator must first migrate the Microsoft Mail 3.x accounts to Exchange Server using the Exchange Migration Wizard provided with Exchange Server.

To request the Outlook Migration Kit, contact Microsoft Product Support at �(425) 635-7031 in the United States or (905) 568-2294 in Canada.

�



WARNING: Any use of the Outlook Migration Kit is at your own risk. Microsoft provides this tool without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability and/or fitness for a particular purpose. Microsoft offers no support for this tool. 



Supported Configurations/Platforms

The following are requirements for the Outlook Migration Kit to work properly:

The Outlook Migration Kit must be run on Intel platforms with Windows® NT 4.0 only. It will not run on Windows 95 or Windows NT 3.51. A fast processor (P150 or better) is highly recommended.

The Outlook client must be installed with the Schedule+ Support Files install option enabled (this option is enabled by default).

The Outlook Migration Kit must be run with a profile that is associated with a service-level administrator account; the administrator’s account must have “read” and “modify” privileges on the mailboxes of the users being migrated. Without these permissions, the Outlook Migration Kit will not be able to migrate Schedule+ data to a user’s mailbox.



Installing the Outlook Migration Kit

The Outlook Migration Kit is installed in the Program Files\Outlook Migration Kit for Schedule+ directory. Under Windows NT 4.0, a shortcut to the kit is automatically placed on the Programs menu. To install the kit, click the Add/Remove Programs icon in Control Panel. 

To uninstall the kit, delete all files from Program Files\Outlook Migration Kit for Schedule+.

The Migration Process

It is highly recommended that the administrator first test the migration process on a small number of accounts to gauge how fast the process will occur. The rate of migration can vary drastically depending on the speed of the computer performing the migration, the speed of the Exchange Server, and the speed of the network.

(	To run the Outlook Migration Kit



After logging on to Windows as a service-level administrator (for the Exchange Server), double-click Migkit.exe to start the Outlook Migration Kit application.

Log on to the Outlook Migration Kit using an administrator account.

�

To add the account names that you want to migrate, click Edit List, or to load an existing list, click Open List. 

These files are saved in a text file with an .mig file extension.

Change the migration options, as necessary.

To begin the migration process, click Start. 



WARNING: Do not interrupt the migration process after it has begun. If you interrupt the process, unpredictable results may occur.



The Outlook Migration Kit iterates through the list of accounts until it is done. The Successful box displays a list of successful migrations, and the Failures box displays a list of failed migrations.

When the application encounters a failure, a dialog box appears. You have the option to retry or skip over the failed account (one of the migration options is always to skip over failures).

To try again to migrate the accounts listed in the Failures box, click Retry Failures, or to save them to disk for a later attempt, click Save List.

A log file is created in C:\Migkit.Log.



Known Issues

This list identifies potential Outlook Migration Kit issues:

The Outlook Migration Kit automates Outlook by sending keystrokes to the Outlook user interface. This process can be erratic in its reliability—if a keystroke is missed, the migration process stalls. During the migration process, if it appears that the wizard is waiting for a prompt and the wait is longer than five minutes, you can move the process forward by clicking the appropriate next step. 

The administrator profile that is used to log on to the Outlook Migration Kit becomes cluttered with the account names of the migrated users.

Occasionally, the Outlook Migration Kit does not exit MAPI cleanly and will not run again in the same Windows session. To resolve this problem, log off from Windows, and then log on again.



�Chapter 4

Interoperability

As an administrator, you need to know how Microsoft® Outlook™ 97 interoperates with other workgroup clients in your organization. Read this chapter to find out how Outlook interoperability with other Microsoft and third-party messaging systems, Microsoft Schedule+, and Microsoft Project takes the administrative hassle out of upgrading or managing a mixed client environment. 
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�

Interoperability as an E-Mail Client for�Messaging Services

Through the Windows® Messaging System, which includes the messaging application programming interface (MAPI), Outlook works well as an e-mail client for a variety of messaging services. Outlook is a full MAPI client application, and functions with any e-mail system that supports MAPI. Outlook includes drivers for Microsoft Mail, Microsoft Fax, Microsoft Exchange Server, Internet mail (SMTP/POP3), MSN™, and Lotus® cc:Mail™. Additional third-party MAPI drivers are either available or under development for Lotus Notes®, Novell® GroupWise, Hewlett-Packard® OpenMail, and Digital’s ALL-IN-1™. 

Many client configurations of Outlook are possible. Most of the configurations can be grouped within the broad categories defined in the following table. 



Configuration �Functionality�Primary Drivers����Internet mail and online services�E-mail client, messaging and collaboration client, and document explorer�- Personal store file (.pst)

- SMTP/POP3 transport 

- Outlook e-mail address book��Local area network (LAN) or post office e-mail systems�E-mail client, group scheduling, messaging and collaboration client, and document explorer�- Personal store file (.pst)

- Post office transport and �     address book drivers��Microsoft Exchange Server�Advanced e-mail client, group scheduling, messaging and collaboration client, document explorer, and groupware applications�Microsoft Exchange Server store, transport, and address book drivers��Other client/server messaging systems�Varies; see details in this chapter�Varies; see details in this chapter��

For clarity, this chapter assumes that the user has a single primary messaging store, transport, and address book driver. In fact, the Outlook user’s profile can include multiple drivers to support, for example, users who have accounts on multiple online services. 

In any of these configurations, the availability of some e-mail features is determined by the fidelity of the messaging gateways between the sender and recipient and whether both sender and recipient are using Outlook. 

�

Internet Mail and Online Services

With an Internet Mail configuration, Outlook functions as a full-featured e-mail client integrated with desktop information management and the Outlook Document Explorer. The user stores messages locally in a .pst file, and remotely connects to and downloads messages from an Internet mail service provider via the SMTP/POP3 driver. The user stores e-mail addresses in the Outlook Contacts module. The .pst file store and Internet Mail transport drivers are components of the Windows Messaging System included with Outlook. 

This category also includes online services, where the user installs a MAPI transport driver for the online service (for example, The Microsoft Network) instead of the Internet mail driver. Transport drivers for these services are available from Microsoft and other vendors. 

Note: Users can download the Internet Mail Enhancement Patch (IMEP). This free Outlook add-in improves the Outlook Internet Mail information service by supporting Internet e-mail product features, such as multiple POP3 accounts in the same user profile and improved support for storing messages on POP3 servers; see the Web site at http://www.microsoft.com/outlook/.



LAN or Post Office E-Mail Systems

In the LAN or post office e-mail configuration, users store messages locally in a .pst file but work connected primarily via the LAN to a post office. The post office provides the messaging transport and central address book or e-mail directory. In this configuration, Outlook functions as a full-featured e-mail client integrated with basic group scheduling (e.g., sending and receiving meeting requests and viewing free/busy times), personal information management, and the Outlook Document Explorer. 

Examples include Microsoft Mail and Microsoft Windows post offices. Outlook includes drivers for these systems. Drivers for Lotus cc:Mail are available from Microsoft and other vendors. 

Outlook and Lotus cc:Mail



Outlook offers Lotus cc:Mail users the ability to use Outlook as their mail client. To use Lotus cc:Mail with Outlook, you must first install the Lotus cc:Mail transport from the Office 97 Value Pack. Then, when you configure a profile, Lotus cc:Mail appears as an available transport service. Follow these simple tips to configure Outlook for use with Lotus cc:Mail:

Obtain and install the latest Dual VIM Drivers from Lotus. These drivers are available as compressed files from the Lotus Web site. The file Vdlw32.zip contains the 32-bit drivers, and Vdlwin.zip contains the 16-bit drivers.

�

Place a copy of Import.exe and Export.exe in your Windows\System or System32 directory. Generally, you can obtain these files from the server administration directory for Lotus cc:Mail. If you are using Lotus cc:Mail with a DB8 post office, you should also follow the same procedure for the IE.ri file.

Map a drive to the Lotus cc:Mail post office instead of using the universal naming convention (UNC) path.

Typically, Lotus cc:Mail program files are located in a different directory than the cc:Mail post office. For example, a typical program directory is \Ccmail and a typical post office directory is \\Ccdata. When making a profile, you will be asked for both locations.



Microsoft Exchange Server

The complete Outlook feature set is available with the Microsoft Exchange Server driver, which supports the server-based message store, message transport, and global address book. In this configuration, Outlook offers advanced e-mail functionality, group scheduling, personal information management, document explorer, and custom groupware applications. 

The Microsoft Exchange Server driver is included with Outlook, but users must acquire a Microsoft Exchange Server client access license separately. 



Other Client/Server Messaging Systems

Client/server messaging systems are distinguished from LAN or post-office e-mail systems in that they provide an intelligent server-based message store for users. Examples include Microsoft Exchange Server, Lotus Notes, Novell GroupWise XTD, Hewlett-Packard OpenMail, Digital’s ALL-IN-1, and IBM® PROFS®. Outlook is a MAPI client application, and can work with any MAPI store driver that uses the full MAPI store specification. 

Outlook Features and Configurations

The following tables include major features in each Outlook feature area. This section is not an exhaustive list of all Outlook features, but should help determine the feature areas supported for each configuration. Only the feature names are included in this document; for a complete description of each feature, see the Microsoft Outlook Product Enhancements Guide available from the Web site at http://www.microsoft.com/outlook/. 

�

Desktop Information Management Features



All of the standalone desktop information management and document explorer features are supported in all configurations. 



�Feature �Internet Mail and Online Services ��LAN Post Offices�Microsoft Exchange Server����Calendar�Yes�Yes �Yes��Contact Manager �Yes�Yes �Yes��Task list�Yes�Yes �Yes��Journal�Yes�Yes �Yes��Outlook Notes �Yes�Yes �Yes��Document Explorer �Yes�Yes �Yes��

E-Mail Message Management Features



Message management features help users organize or find e-mail messages after they have received them, and they help users quickly format and prepare new messages. These Outlook features are supported with all messaging configurations. 



�Feature �Internet Mail and Online Services ��LAN Post Offices�Microsoft Exchange Server����AutoArchiving �Yes�Yes �Yes��AutoCreate �Yes�Yes �Yes��Outlook searching (Find Items) �Yes�Yes �Yes��Message categories �Yes�Yes �Yes��Message flags �Yes�Yes �Yes��AutoNameCheck �Yes�Yes �Yes��AutoPreview �Yes�Yes �Yes��Replied and forwarded marks �Yes�Yes �Yes��Reply annotations �Yes�Yes �Yes��Move to folder �Yes�Yes �Yes��Outlook Address Book �Yes�Yes �Yes��Message templates �Yes�Yes �Yes��WordMail�Yes�Yes �Yes��Hyperlinks �Yes�Yes �Yes��Remote (dial-up) Mail �Yes�Varies �Yes��

�

E-Mail Message Sending Features



Message-sending features add fields or properties to messages to perform specific actions or convey status information. These Outlook features are supported with all messaging configurations. Some of these features require both the sender and recipient to be Outlook users and that the intervening message gateways support binary attachments. 



�Feature �Internet Mail and Online Services ��LAN Post Offices�Microsoft Exchange Server����Voting�Yes�Yes�Yes��Message flags �Yes�Yes�Yes��Message recall �Yes�Yes�Yes��Task delegation �Yes�Yes�Yes��Outlook forms �Yes�Yes�Yes��Rich-text messages �Yes�Yes �Yes��Locked messages �Yes�Yes �Yes��Meeting requests and responses �Yes�Yes �Yes��File attachments �Yes�Yes �Yes��AutoSignature �Yes �Yes�Yes��Read receipts �Yes�Yes �Yes��Delivery receipts �Varies�Varies �Yes��

Advanced E-Mail Message Handling Features



Advanced message handling features take advantage of Microsoft Exchange Server capabilities. These features are generally not available with other messaging services that do not fully support X.400 message properties. These features include the following: 

Digital signatures and encryption 

Message tracking 

Redirected replies 

Message expiration 

Deferred delivery 

Offline folders 

Delegate access 

Groupware 



�

As of this date, Microsoft Exchange Server is the only shipping and tested multiuser MAPI store, so all of the groupware or information-sharing features of Microsoft Outlook require Microsoft Exchange Server. These features include the following: 

Comprehensive group scheduling (such as viewing calendar details) and shared calendars 

Shared contact and task lists 

Groupware applications with custom forms and views 

Offline folders 



Interoperability with Outlook for Windows 3.1x�and Outlook for the Macintosh

The Microsoft Outlook integrated e-mail client for the Windows 3.1x and Macintosh operating systems improve the messaging and group scheduling interoperability with Outlook 97 (for 32-bit Windows) without requiring new hardware. These new Outlook are appropriate for customers with Microsoft Exchange Server who need “stepping stone” clients as they migrate to the 32-bit Windows operating systems. The Outlook clients for Windows 3.1x and Macintosh are upgrades from the Exchange Mail and Schedule+ clients. 

Customers committed to staying on Macintosh or 16-bit Windows platforms for the long term might consider Outlook Express for Macintosh or Windows 3.x for messaging, as well as Outlook Web Access (for Microsoft Exchange Server) for calendaring. Microsoft continues to support the Macintosh and Windows 3.x Microsoft Exchange Server mail clients, as well as Schedule+ for Macintosh and Windows 3.x.

The new Outlook clients for Windows 3.1x and Macintosh include all the features of the existing Exchange Mail and Schedule+ clients, plus new features to smooth interoperability with Outlook 97. Due to operating system and hardware limitations of typical computers based on 16-bit Windows and Macintosh, Outlook clients for Windows 3.1x and Macintosh continue to provide only a subset of the features of Outlook 97. 

�

The following new features are included in the Outlook clients for Windows 3.1x and Macintosh: 

E-mail interoperability improvements. Users can now receive and send flagged messages, recall messages, and respond to (but not send) voting messages. Microsoft has also improved attachment handling and translation for Macintosh users. Macintosh users receive S/MIME support. These clients are intended for Microsoft Exchange Server integration only and do not include Internet mail (POP3, IMAP) support required to connect directly to an Internet service provider. Users of 16-bit Windows and Macintosh who require POP3 support are encouraged to evaluate the Outlook Express client.

Calendar and group scheduling. For scheduling, Outlook for Windows 3.1x can read the details of a calendar on Outlook for Windows 95. (This feature is not available to Macintosh users at this time.) The clients continue to have the same Calendar, Contacts, and Task features available in Schedule+ version 7.0, and to display Calendar, Contacts, and Task information in a separate window, accessible from the Outlook Bar.  

Custom forms. Outlook for Windows 3.1x and Macintosh can display custom forms implemented with HTML and Microsoft Exchange Server Collaboration Data Object (CDO) scripts. When a user of Outlook for Windows 3.1x or Macintosh opens a custom form, it is displayed in the user’s Web browser. HTML and CDO-based custom forms can be developed using the Microsoft Visual InterDev™ Web development system or any standard text editor and stored on Microsoft Exchange Server similarly to Outlook 97-based forms. The Windows 3.1x and Macintosh clients cannot design or display a custom form compatible with Outlook 97.

Improved visuals and interface. Outlook for Windows 3.1x and Macintosh includes a partially customizable Outlook Bar and a Folder Banner consistent with �Outlook 97. Menu and toolbar commands are now arranged to match Outlook 97 more closely.



Interoperability with Microsoft Mail 3.x

Outlook and Microsoft Mail 3.x users can share e­mail messages by sending e­mail back and forth or by making messages available in shared folders. The way Outlook and Microsoft Mail 3.x clients work with e­mail messages is the same in either case. While Outlook users are able to exchange e­mail freely with Microsoft Mail 3.x users, e­mail messages composed using Outlook may not appear the same when viewed by users of Microsoft Mail 3.x, and Microsoft Mail 3.x users cannot take full advantage of many Outlook features. 

�

Users will notice these differences:

Exchanging messages. When an Outlook user opens a message created by a Microsoft Mail 3.x user, Outlook recognizes all of the features of the message. However, when a Microsoft Mail 3.x user opens an e­mail message created by an Outlook user, the Microsoft Mail 3.x client may not recognize some of the advanced features that the Outlook user is able to include in the message, such as large amounts of text and attachments (Microsoft Mail 3.x users are restricted to 32K for text and approximately 100 MB for attachments), rich-text formats, embedded links, and custom forms. 

Also, Microsoft Mail 3.x and Outlook cannot share the same message store. To use data from a Microsoft Mail 3.x message store with Outlook, you must import the message store to an Outlook-compatible (MAPI) format. Microsoft Exchange Server includes a utility that imports Microsoft Mail message stores to MAPI format.

Sharing public folders. Outlook users can create, open, read, write, and delete Microsoft Mail 3.x public folders. If an Outlook or Microsoft Mail 3x user stores a form in a public folder, the user can open the message, but could experience some of the same restrictions mentioned in the previous paragraphs. Microsoft Mail 3.x users, though, cannot gain access to Outlook public folders. 



Note: If an Outlook user sends e­mail to a Microsoft Mail 3.x user who has a delegate account, Outlook redirects the message to the delegate account. However, if the Outlook user sends the message while offline, Outlook cannot send the message to the delegate, and the message is delivered only to the original Microsoft Mail 3.x user. 



Interoperability with Microsoft Exchange Inbox

Outlook builds upon and extends the Windows Messaging System, which is the underlying messaging architecture and service first introduced with the Microsoft Exchange Inbox application for the Windows 95 operating system. Both Outlook and Microsoft Exchange Inbox are MAPI applications. MAPI is the core component of the Windows Messaging System and provides standard interfaces for connecting e­mail clients and applications with services, such as messaging stores, directories, and transports. Outlook uses the same MAPI profile and services as Microsoft Exchange Inbox, so MAPI services developed for the Inbox also work with Outlook. 

Outlook users can seamlessly exchange e­mail messages with users of Microsoft Exchange Inbox. Outlook and Microsoft Exchange Inbox use the same rich-text format, the same message properties and file format, and the same Microsoft Exchange folders to store messages. 

�

Interoperability with Microsoft Exchange Client

Microsoft Exchange Client, which was introduced with Microsoft Exchange Server, adds advanced features to Microsoft Exchange Inbox. These new features make better use of the capabilities of Microsoft Exchange Server. 

Outlook uses Microsoft Exchange Server user accounts, so administrators do not need to create or import user accounts from Microsoft Exchange Server to Outlook. In fact, for the purposes of setup and administration, administrators can think of Outlook and the Microsoft Exchange Client as the same—any user who already has an account on Microsoft Exchange automatically has an account for Outlook. 

Outlook and Exchange Client users will notice several key areas of interoperability:

Building views. Users of both Outlook and Microsoft Exchange Client can build custom views in personal and public folders. A view is a way of looking at information in a folder. It combines a custom set of columns or fields that list only specific items. The result sorts one or more columns and then groups items into categories. In a public folder on Microsoft Exchange Server, Outlook can display any views created in Microsoft Exchange Client, and Microsoft Exchange Client can display table views created in Outlook. 

Rules technology. Outlook and Microsoft Exchange Client both take advantage of Microsoft Exchange Server rules technology to enable new messages to be processed automatically, even when users are not logged on. Both products make use of Microsoft Exchange Server security, so users can share their folders with other users to create delegates, and they can use the same services to digitally sign and encrypt messages. 

Sharing public folders. Outlook and Microsoft Exchange Client users can have access to a common set of public folders. There are no special restrictions regarding simultaneous access by both Outlook and Microsoft Exchange Client users; the Microsoft Exchange Server does not distinguish between Outlook and Microsoft Exchange Client when you open public folders. 

The most significant issue in sharing folders is how saved views are handled between the two clients. Outlook supports all the custom view features of Microsoft Exchange Client, but it also supports a number of other features as well. Saved views created by Outlook also have a different format than those created by Microsoft Exchange Client. While Microsoft Exchange Client does not recognize the Outlook format, Outlook recognizes both formats.  

�

Exchanging forms. Outlook can open both standard and custom message forms created by Microsoft Exchange Client, but Microsoft Exchange Client can open only the Outlook standard form. Outlook can create special forms for Outlook items other than e­mail (such as calendar or task items); Microsoft Exchange Client cannot open these forms. Microsoft Exchange for MS­DOS and for the Macintosh, though, do not recognize the Outlook standard message form. If either of these clients receives an Outlook form, the standard message form for the MS­DOS or Macintosh client is used to display the Outlook form. 

Note: Outlook for the Macintosh and Outlook for Windows 3.1x (both available with Exchange Server 5.5) include new forms-handling abilities. With this new feature, users launch Outlook Web Access to view the form. See “Version 8.03 Features” in Chapter 1, “Microsoft Outlook 97 Overview.”

Interface support. Outlook supports all of the programming interfaces of Microsoft Exchange Client. These include Microsoft Exchange Client extension interfaces, which allow developers to add new functionality, and MAPI Form interfaces, which allow C++ developers to build custom forms. Also, Outlook users can run custom forms built with Microsoft Exchange Forms Designer, an optional component included with Microsoft Exchange Client. 



Interoperability with Microsoft Schedule+

Outlook and Schedule+ (16-bit versions 1.0 and 2.0 and 32-bit versions 7.0 and 7.0a) offer a high level of interoperability for basic calendar and group scheduling capabilities. In a mixed environment consisting of Outlook and Schedule+ users, all users can exchange meeting request messages and share calendar free/busy status with each other. However, many Outlook capabilities go beyond those of Schedule+. Outlook users should be aware that their coworkers who are using Schedule+ might not be able to view or use some of the messaging or calendar information the same way as another Outlook user would. 



Basic Group Scheduling Capabilities

For most organizations, two scheduling functionality areas are considered essential: 

Exchanging meeting requests 

Viewing free/busy status 



Outlook and Schedule+ interoperate completely in both of these key areas. 

Note: The Outlook driver for Schedule+ allows Schedule+ users to view Outlook free/busy data; without this driver, users are unable to do so. To install this driver, see “Outlook Driver for Microsoft Schedule+ ” in this chapter.



�

As you read this section, you should be familiar with the distinction between free/busy status and free/busy details: 

Free/Busy Status The time blocks during which the user is either available for a meeting or is busy. When users publish their free/busy status, other users can view the free/busy time blocks (but not necessarily their free/busy details) from within the Meeting Planner. 

Free/Busy Details The descriptions (details) of the appointments or activities a user has scheduled. Users who have been given at least Read Only permission to another user’s calendar can not only view (in the Meeting Planner) the time blocks representing when that user is free or busy, but they can also view the user’s free/busy details. 



Exchanging Meeting Request Messages



Outlook and Schedule+ users can freely exchange meeting messages across Windows and Macintosh platforms. Although Outlook users and Schedule+ 1.0 users can freely exchange meeting requests and responses, Schedule+ 1.0 does not recognize the advanced features of Outlook (such as attachments, the meeting location field, and recurring meetings). As a result, when a Schedule+ 1.0 user receives a meeting message from an Outlook user, Schedule+ 1.0 ignores any Outlook-specific message features it does not recognize. For example, if an Outlook user sends a recurring meeting request to a Schedule+ 1.0 user, the Schedule+ 1.0 user receives only the first meeting request. 

Viewing Free/Busy Status



When users “publish” their free/busy status, other users can view the free/busy time blocks (but not necessarily their free/busy details) from within the Meeting Planner. With appropriate permission, Outlook and Schedule+ users can view each other’s free/busy status (time blocks). 

In addition to designating free/busy status, Outlook users can designate “tentative” and “out of office” time blocks for specific appointments. When Outlook users view each other’s calendars, they can identify the time blocks that are free, busy, tentative, or out of office. When Schedule+ users view an Outlook user’s calendar in their Planners, time blocks designated by the Outlook user as tentative appear as free times to the Schedule+ users. However, time blocks designated by the Outlook user as out of office appear as busy times to Schedule+ users. 

�

Outlook differs slightly from Schedule+ in how it handles unpublished free/busy status. When Schedule+ users choose not to publish their free/busy status, other Schedule+ users—if they have at least Read Only permission—can still view the users’ free/busy status in their Meeting Planners. However, when Outlook users choose not to publish their free/busy status, other Outlook users—even those who have at least Read Only permission—cannot view the users’ free/busy status in their Meeting Planners. To view the users’ unpublished free/busy status, Outlook users must view (open) the user’s calendar, providing that they have appropriate permission. 

By default, Outlook publishes three months of free/busy status for all users. Users can change the number of months or choose not to publish their free/busy status at all (by specifying 0 months). To set the number of months of free/busy status that is published, you would click the Tools menu, click Options, click Calendar, and then click Advanced. In the Publish X Months Of Free/busy Status box, enter 0 (zero). 



Other Group Scheduling and Calendar Features

The following sections describe differences that exist in how Outlook and Schedule+ interoperate. 

Opening Other Users’ Calendars



Unless the Outlook driver for Schedule+ is installed, Schedule+ 95 users cannot open an Outlook user’s calendar. As a result, Schedule+ 95 users cannot view free/busy details of an Outlook user’s calendar. To install this driver, see “Outlook Driver for Microsoft Schedule+” in this chapter. Outlook users, on the other hand, can open Schedule+ 95 users’ calendars with appropriate permission, and can therefore view a Schedule+ 95 user’s free/busy details. 

Viewing Another User’s Free/Busy Details



Outlook users on Exchange Server can view the free or busy details of Schedule+ users who are also on Exchange Server, but they cannot view the details of those on Microsoft Mail Server. Schedule+ 95 users can view the free or busy details of Outlook users when all users are on Exchange Server and the necessary Windows 16-bit or 32-bit driver is installed; for more information, see “Outlook Driver for Microsoft Schedule+” in this chapter. Schedule+ 1.0 users cannot view Outlook users’ free/busy details. 

Outlook users who have at least Read Only permission to another user’s calendar can see when that user is free or busy. Also, they can view the description (details) of that user’s scheduled appointments and activities in the Meeting Planner. 

�

Delegate Access



Just as they can give others permission to read or modify their folders, users can designate other users to be their “delegates.” As a delegate, a user can manage the owner’s e-mail and schedule, as well as create, send, and reply to messages (including meeting and task requests) on the owner’s behalf. For example, managers could give their assistants or teams access to their schedules so the assistants or team members can create messages, appointments, tasks, or other items for them. 

A delegate relationship requires that both users run the same scheduling client. For example, Outlook users can be delegates only for other Outlook users. Outlook users who want to participate in delegate relationships with other Outlook users must keep all their primary folders (such as Calendar and Inbox) on the server instead of on their local computers. 

Schedule+ 95 users can designate other users to be their “delegate owners.” As a delegate owner, a user has all the capabilities of a delegate, and can also designate additional delegates for the owner’s schedule. Like Schedule+ 95 users, Outlook folder owners can enable their delegates to give other users the necessary permission for gaining access to the owner’s folders. However, Outlook does not allow a delegate to designate additional delegates for the owner’s folders. To designate a delegate in Outlook, you must be logged on as the folder (account) owner. 

Note: When Outlook is a client for a Microsoft Mail server, Outlook users cannot give other Outlook users access to their folders. 



Direct Booking



If they have appropriate permission, Outlook users can take advantage of the Schedule+ direct booking feature to book appointments directly into a Schedule+ Calendar. However, Schedule+ users cannot book appointments directly into Outlook Calendars. In addition, Outlook users cannot book appointments directly into other Outlook Calendars. 

Outlook helps users get into the habit of organizing meetings by sending meeting requests instead of booking appointments directly into other users’ calendars, as was necessary on some mainframe systems. However, with appropriate permission (such as Delegate), an Outlook user can open another Outlook user’s or resource’s calendar and modify it, if necessary. 



�

With direct booking, no meeting request is actually sent to the Schedule+ resource. The meeting organizer’s client software simply adds the meeting directly into the Schedule+ resource’s calendar. Because a directly booked Schedule+ resource is unlikely to receive meeting requests, you are not required to assign a delegate to the resource or have a continuously running computer logged into the resource’s account to process incoming meeting requests. However, without a delegate or continuously running computer for the Schedule+ resource, if a user does send an explicit meeting request to the resource instead of booking an appointment directly, the meeting request goes unnoticed until a user actually logs on to the resource’s account. 

Unlike Schedule+ accounts, Outlook accounts cannot be booked directly. Therefore, to process the meeting requests that are sent to Outlook resource accounts, it is recommended that each Outlook resource account be set up with a delegate that receives its meeting requests. The delegate account should be logged on to a continuously running computer. Because a single delegate can be responsible for multiple resource accounts, a single, dedicated “delegate computer” can handle a large number of conference rooms and other resources. 

Note: When Outlook is a client for a Microsoft Mail server, Outlook users cannot take advantage of the Outlook delegate access capabilities. For this reason, resource accounts on a Microsoft Mail server should be Schedule+ 95 accounts, so both Outlook users and Schedule+ users can book appointments into them directly. 



Calendar Synchronization



Although different versions of Schedule+ synchronize calendars the same way, Outlook’s calendar synchronization method is different. Schedule+ maintains two copies of a user’s calendar—a local copy and a server copy. By default, Schedule+ runs primarily from a local calendar and automatically synchronizes the local and server calendars each time the user connects to the server. 

With Outlook, users work directly on the server-based calendar by default, so there is less need for automatic background replication. In addition, a single calendar file, residing on the server, provides additional security and manageability. Disconnected users also benefit from the tight integration of Outlook with Microsoft Exchange Client: a single command and a single phone call synchronize all folders—calendar, �e-mail, public folders, contacts, and tasks. 

Although working directly on the server-based calendar is the default for Outlook, users can choose to have both a server copy and a local copy of their Outlook folder. For example, users who travel frequently or who need to gain access to their Outlook information from an offline store might want to take advantage of this ability. In such cases, users can configure Outlook to synchronize the folders automatically when they log on and/or log off. 

�

Macintosh Interoperability

Outlook 97 offers identical interoperability with Schedule+ 95, whether the �Schedule+ 95 user is using a Macintosh computer or a Microsoft Windows computer. As a result, Outlook 97 users and Schedule+ 95 Macintosh users can exchange meeting messages and, with the appropriate permission, can view each other’s free/busy status. Macintosh Schedule+ 1.0 users and Outlook 97 users can exchange meeting messages. Also, Outlook for the Macintosh is available with the Microsoft Exchange Server.



Outlook Driver for Microsoft Schedule+

With the Outlook driver for Schedule+ 7.x, Schedule+ users can open an Outlook Calendar from Schedule+ and view Outlook free/busy data. The Schedule+ user must have Read Only permission for the Outlook user’s Calendar. Also, that Calendar must be stored on the Exchange Server.

Note: The Schedule+ user can only read the Outlook user’s Calendar, not add to it or edit it, regardless of the permissions granted by the Outlook user.

This driver works on 16-bit and 32-bit versions of Microsoft Schedule+. Both the Schedule+ and Outlook users must be running Exchange Server. The 32-bit driver is available with the Exchange Server 5.0 and 5.5 CDs; you can also download this driver from the Web site at http://www.microsoft.com/outlook/. The 16-bit driver is available only with the Exchange Server 5.5 CD.



Installing the Driver



You must have installed Schedule+, Outlook, and Windows 3.1, Windows 95, or Windows NT 3.51 or a later version.

(	To install the Outlook driver for Schedule+



If the Schedule+ application is open, close it.

In the same folder as your Schedule+ files, double-click Msoutl.exe (Windows 95 users) or Msoutl16.exe (Windows 3.1 users). 

When asked if you want to continue, click Yes.

�

When the installation is complete, restart Schedule+.

The following files are installed on your computer:

Msoutl32.dll

Msstubs.dll

Msoutl.inf

Unins351.reg

Readme.txt



After the driver is installed, the Schedule+ user can open an Outlook user’s calendar.

(	To open an Outlook user’s calendar from Schedule+



On the Schedule + File menu, click Open. 

Click Open Other’s Appointment Book.



Removing the Driver



If you no longer want the driver installed on your computer, you can remove it easily. The following procedure describes how to remove the driver if you are running Windows 95. If you are running Windows 3.1 and you need to remove this driver, you must rerun the original setup. 

Windows NT 3.51 users can remove the driver by running Unins351.reg and then deleting Msoutl32.dll and Msostubs.dll. These files are located in the same folder as Schedule+.



(	To remove the Outlook driver for Schedule+ if you are running �            Windows 95



On the Windows Start menu, point to Settings, and then click Control Panel.

Double-click Add/Remove Programs.

On the Install/Uninstall tab, click Microsoft Outlook 97 Driver for Schedule+, and then click Add/Remove.



�

Known Issues



This list identifies potential issues with the Outlook driver for Schedule+ 7.x:

All-day events in Outlook appear as appointments when viewed in Schedule+ 7.x.

If Schedule+ 7.x is reinstalled, you must also reinstall the driver .

An Outlook user might share his or her Outlook calendar with other users, and then switch to using Schedule+ 7.x as the primary calendar. In this case, Schedule+ 7.x users who are using the Outlook driver for Schedule+ 7.x to open that user’s calendar will continue to open that user’s Outlook calendar instead of that user’s Schedule+ 7.x calendar. To solve this problem, the Outlook user needs to remove the permissions on the Outlook Calendar folder so that the Outlook driver for Schedule+ 7.x does not open the folder.

Outlook appointments with more than 32K of text in the Notes field appear to have a blank Notes field when viewed in Schedule+ 7.x.



Interoperability with Microsoft Project

Microsoft Project 95 users can assign tasks to Outlook users. However, if the Outlook recipients accept the tasks, Microsoft Project 95 will not add the tasks to their Outlook Tasks automatically. Plans for future versions of Microsoft Project include additional Outlook integration functionality. 



�Chapter 5

Workgroup Features in�Microsoft Outlook 97

Microsoft® Outlook™ 97 contains many features that support collaboration within a workgroup. This chapter provides administrators with the information necessary to enable, support, and troubleshoot Outlook workgroup features.

Note: Some of the workgroup features described in this chapter also require Microsoft Exchange Server. For more information, see your Microsoft Exchange Server documentation. 
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�

Group Scheduling

To implement group scheduling, a workgroup administrator must do the following: 

Set up each user or resource with an electronic mail (e­mail) account on the server.

Have users set the appropriate permissions to share their Calendars with other users.



You can also edit the messaging profile (Outlook.prf) to create custom profiles for your users. For more information about setting up e­mail accounts, see your Microsoft Exchange Server documentation. 



Viewing Free/Busy Information in a Workgroup

The most common group scheduling activity is browsing free and busy information to find an available time for a group of users to meet. Free/busy status refers to the format displaying the user’s time as free, busy, out­of­office, or tentative. This information is published in a common file format on the server. Free/busy details include appointment specifics, such as subject or meeting location. To see free/busy details, a user must be granted permission to open another user’s Calendar. For more information about free/busy status and free/busy details, see “Basic Group Scheduling Capabilities” in Chapter 4, “Interoperability.”

To publish free/busy status in Outlook, a user would click the Tools menu, click Options, click the Calendar tab, and then click Advanced Scheduling. To view other users’ unpublished free/busy status, Outlook users must open another user’s Calendar (with appropriate permission). 

Note: Unless noted otherwise, all references to Schedule+ refer to both Schedule+ 95 and Schedule+ 1.0. 

For workgroups using a combination of Outlook and Schedule+, Outlook differs slightly from Schedule+ in how it handles unpublished free/busy status. When a Schedule+ user chooses not to publish free/busy status, other Schedule+ users who have at least read permission for that user’s schedule can still view the free/busy status in their Meeting Planners. However, when an Outlook user chooses not to publish free/busy status, other Outlook users—even those who have read­only permission—cannot view the user’s free/busy status in their Meeting Planners. 

Schedule+ users cannot see Outlook users’ unpublished free/busy status, even if the Outlook Calendar is shared. However, Microsoft provides a utility driver that enables Schedule+ 7.0 clients (both 16-bit and 32-bit) to view the free/busy status for an Outlook user. For 16-bit clients, the driver is msoutl.exe, located in the \Support folder of the Office CD; for 32-bit clients, the driver is setup.exe, located in the \Support\win16 folder.

�

Managing Scheduling Data with Microsoft Exchange Server



For Outlook clients who use Microsoft Exchange Server, free/busy status and free/busy details are stored in a hidden public folder on the server. Within a single site, this public folder may be replicated to load balance the queries to the free/busy information. When the free/busy folder is replicated, network traffic is reduced, especially when a large number of users are connecting to Microsoft Exchange Server. 

You can also replicate the free/busy folder between two Microsoft Exchange Server computers located across a remote link. This reduces the total traffic across the link and improves performance when users read or write remote schedule data. 



Scheduling Resources

With Outlook, you can plan schedules not only for workgroup users but also for resources, such as conference rooms and AV equipment. This feature makes it easy for everyone in a workgroup to see when resources are available and to reserve the resources in advance. Users can include the resources, along with proposed attendees, in a meeting request. You can configure each resource account to accept or reject meeting requests automatically, or you can have requests for several resources handled by a single delegate. 

To set up a resource on Outlook, first create an e­mail account for each resource, just as you would for a workgroup member. If a delegate is assigned for a resource, you can configure the resource account so that users send meeting requests directly to the delegate. 

Unlike Schedule+ resource accounts, Outlook resource accounts cannot be booked directly. To set up automatic booking of Outlook resource accounts, you must configure the resource account so that Outlook automatically responds when meeting requests are delivered to the Inbox. To do this, you must have Outlook running on a computer and be logged on to the resource account. 

If you want to centralize booking of several resources, you can assign a single delegate to multiple resource accounts and then configure the delegate to respond to meeting requests automatically. All meeting requests sent to the resources are forwarded to the delegate for processing. The advantage to this method is that only one computer is required to handle multiple resources. For example, you can set up a dedicated computer, with Outlook logged on to the delegate account, to handle the booking of several conference rooms at once. 

�

(	To assign a delegate to an Outlook resource account



Create an e­mail account with the name of the resource. 

For example, create an e­mail account with the name Conference Room 3/422. 

Create an e­mail account for the delegate. 

You can create a dedicated delegate account, or you can use an existing user account. For example, you could use a receptionist’s e­mail account for booking all conference rooms in a building. 

Start Outlook, and log on to the resource account. 

On the Tools menu, click Options. 

Click the Delegates tab, and then click Add. 

In the Add Users dialog box, select the delegate user, click Add, and then click OK. 

Set the permissions you want the delegate to have, and then click OK. 

On the Delegates tab, select the Send meeting requests and responses only to my delegates, not to me check box. (This option is not available before you add the delegate.) 

Click OK.

All meeting requests sent to this resource are automatically forwarded to the delegate for processing. 



You can also set up the resource account to handle meeting requests automatically. 



(	To enable automatic booking of resource requests



Start Outlook, and log on to the delegate account. 

On the Tools menu, click Options. 

Click the E­mail tab, and then select the Process requests and responses on arrival check box. 

Click the Calendar tab, and then click Advanced Scheduling. 

In the Processing of meeting requests area, select the check boxes for the options you want to use. 

Select all three options for complete automatic booking of all meeting requests forwarded to the delegate. If you select only one or two of these options, you must log on to the delegate account periodically to accept or reject meeting requests. 

Click OK.



�

Microsoft Exchange Public Folders

Note: This Outlook feature requires that you use Microsoft Exchange Server mail system. 

When you set up Outlook as a workgroup client for Microsoft Exchange Server, you can set up public folders for users to share information. Outlook provides built­in Calendar, Contacts, and Tasks modules that you can customize for workgroups to share details, such as company schedules and holidays, employee and customer lists, and project task lists. Also, you can set up public folders for users where users can participate in online conversations, post information or documents in a bulletin board format, or collect a list of shared Web sites. 

You can develop custom views and forms for public folders to create custom applications. You can also set user permissions for public folders so that others can develop custom views and forms. For more information about creating forms for custom applications, see Building Microsoft Outlook 97 Applications, published by Microsoft Press and available wherever computer books are sold. 

The list of available public folders appears in the Outlook Folder List and in the Microsoft Exchange Server Administrator program. Users are not required to know the name or location of the server where public folder data is stored. If they have permission, other Microsoft clients (such as Microsoft Exchange Client) running under different operating systems also can use these public folders. 



Setting Up Public Folders

As the workgroup administrator, you can use the Microsoft Exchange Server Administrator program and the Outlook client to set up public folders for users in your workgroup. If you grant some or all of the users permission, they can share the task of creating the public folders. If you work in a large organization or expect heavy use of public folders, you might want to create public folder replicas on additional servers to distribute the user load. Also, you may want to set up a replication schedule to keep all public folder information up to date. 

To set up public folders, follow these general steps:

Determine how your organization will use the public folders. Consider the number of users, servers needed, and whether you need to tightly control public folder creation or permit users to share this task. 

Configure a Microsoft Exchange Server computer to have a public information store. You can locate the public information store on a dedicated public folder server or on a server that also contains a private information store. 

�

Use the Administrator program to set up the public folder hierarchy and public folder age and size limits, storage warnings, and access. 

Use Outlook to create public folders, set permission levels, and create rules and views for items in the public folders. 

If necessary, create public folder replicas on additional servers, and set up a replication schedule. 



Note: For more information about how to set up, organize, and maintain public folders and how to set up and maintain public folder replication, see your Microsoft Exchange Server documentation. 



Distributing Public Folder Shortcuts to Users

In an organization that has many public folders, it can be awkward for users to navigate to the folders they want to use, especially if the folders are deep in the Folder List hierarchy. To simplify finding a public folder, users can keep frequently used folders in the Public Folders Favorites folder. When you create public folders, you can distribute shortcuts easily by sending a message that contains public folder shortcuts to users who have permission to use them. 



(	To send a public folder shortcut to users



Create and address a mail message. 

Tip: Include the steps of the following procedure in the text of your message. 

For each public folder for which you want to send a shortcut, drag the public folder from the Folder List to the mail message. 

Send the message. 



Recipients of your mail message must perform the following steps. 

(	To save a shortcut to a public folder 



In the mail message, double­click the public folder shortcut you want to add to the Public Folders Favorites folder. 

The public folder opens in a separate window. 

On the File menu, click Add to Outlook Bar. 

Repeat steps 1 and 2 for each shortcut you want to add. 



�

Why aren’t public folder subfolders available? 



When users add a public folder shortcut to the Public Folders Favorites folder, subfolders in that folder are not available when they use the shortcut. To make sure that subfolders are available from shortcuts in the Public Folders Favorites folder, users must create individual shortcuts for each subfolder they want to open from the Public Folders Favorites folder. 



Making Public Folders Secure

Depending on the permissions you grant, administrators and users can control access to public folders. You can control folder access at any point in the folder hierarchy. Permissions are grouped into predefined roles, or sets of activities, that can be performed in the folder. For example, the editor role permits users to read, create, edit, and delete any item in the folder, but not to create subfolders. 

Hiding Public Folders from Unauthorized Users 



By default, users can view the contents of the Public Folders folder and the All Public Folders folder. To keep users from viewing the contents of a public folder or any of its subfolders, you can use the Administrator program to revoke read permission for a user or distribution list. Revoking a user’s read permission for a folder prevents the user from opening the folder or any of its subfolders in the Folder List. 



(	To revoke read permission for a folder or subfolder



In the Administrator window, click Public Folders in the Folder List. 

Double­click the public folder you want to change. 

Click the General tab, and then click Client Permissions. 

Click the name of the user or distribution list for which you want to revoke permissions. 

If you change permissions for both a user and for a distribution list that includes the user, the user permissions take precedence. 

Clear the Read Items check box. 

Click OK.



Note: A subfolder inherits permissions from the parent folder only when the subfolder is created. If a user adds the subfolder shortcut to the Public Folders Favorites folder before you revoke read permission from the parent folder, the user can continue to use the shortcut to open the subfolder and view its contents. To protect all subfolders in a public folder, you must revoke read permission for the parent folder and for each subfolder. 

�

Preventing Unauthorized Delegates from Adding Messages to �     a Public Folder 



When users copy or move messages to a public folder, one of two names can appear in the From field of the posted message: the name of the person who originally sent the message or the name of the person who moved or copied the message. If the name of the person who originally sent the message appears in the From field, it appears as if the message was posted on behalf of the sender, even if the person who moved or copied the message does not have the appropriate delegate access permissions. 

(	To change the From field setting for a public folder



On the Outlook View menu, click Folder List. 

In the Public Folders folder, right­click the public folder for which you want to change the From field setting, and then click Properties. 

Click the Administration tab. 

In the Drag/Drop posting is a box, click Forward. 

Click OK.

The name of the person who originally sent the message appears in the text box of the message instead of in the From field. 



Supporting the Anonymous Exchange of Information



In Outlook, users can send messages or post information anonymously to a public folder. This practice is useful when users want to make a comment or distribute information to a public folder without revealing their identity to other users. 

To permit users to exchange information anonymously, you must create an Anonymous account. 

(	To create an Anonymous account



In the Microsoft Exchange Server Administrator program, create a mailbox with the display name Anonymous. 

Give the Windows NT domain users group (or any other group containing all or some of the Outlook users) Send As permissions on this mailbox. 

The simplest way to give Send As permission to all the users who will send mail through this account is to give permission to the group. Then, every user in the group gets the permission automatically. 

�

After you create the Anonymous account, users can address messages or post items from Anonymous instead of using their own names. 

(	To send or post information anonymously 



In Outlook, create a message or item to be posted. 

On the View menu, click From Field, and then click From. 

In the Type name or select from list box, enter Anonymous, and then click OK. 

Enter recipient names in the To and Cc boxes. 

Give the message a subject, type the message text, and then send the message. 



Tip: To prevent users from sending or posting information anonymously to a public folder, you can limit permissions for the Anonymous account or create a rule for the public folder to reject messages sent from the Anonymous account. 



How do I know when public folders contain unread messages?



Although the name of a private folder appears in bold when the folder contains unread messages, the name of a public folder does not. This may be confusing to users accustomed to working with private folders. 

If you want to be notified when a public folder contains unread messages, create a shortcut to the public folder. When the public folder contains unread messages, the name of the public folder shortcut appears in bold. 



Extended Task Management Capabilities �with Microsoft Team Manager

The Microsoft Team Manager program extends the task management capabilities of Outlook, making it possible for a workgroup to assign, track, and consolidate tasks. When Team Manager is used with Outlook, team members use the Tasks folder in Outlook to receive, view, and update team tasks. Also, Outlook serves as the messaging client through which team members send and receive task information. 

Use Team Manager in your workgroup to extend Outlook task management features in the following ways: 

Team members can report on the progress of more than one task at a time. 

Managers and team members can send lists of task information to each other. 

Team members can send regular status reports to a manager. Team Manager automatically consolidates status information from the entire team into one status report in the manager’s team file.

�

Both the manager and team member can change a task. For example, the manager can change the due date for an assigned task, and the team member can accept or reject the change.

Team members can view a read­only team file of tasks to see the status for everyone on the team and to see how individual tasks fit into the team’s work. This read­only view is also a place for anyone on the team to experiment with schedule changes. For example, a team member can see what effect a different set of dates would have on other team members’ tasks, without making permanent changes to the team file.



Setting Up Team Manager

Team Manager provides two setup options. Managers use the manager setup option, and team members use the team member setup option. Even though team members track tasks in Outlook, team member setup is required. Users who function as both managers and team members must use both setup options. 



When users install Team Manager, they must choose a messaging option. If managers and team members are not all using Outlook as a messaging client, managers can set up a shared folder or directory on the network to send messages to and receive messages from team members. Users who function as both managers and team members must choose the same messaging option for manager and team member setup options. If your workgroup needs to switch to another messaging option (for example, if you are switching from network messages to Microsoft Exchange Server with Outlook as a client), users must reinstall Team Manager with the new messaging option. 

Note: For more information about how to install Team Manager, how to set up a team file, and how to create and update tasks using Team Manager, see your Microsoft Team Manager documentation. 



When you install Team Manager using the team-member setup option, the following commands are added to the Outlook Tasks menu: 

Team Manager for team members. This command starts the Team Manager for team members utility. Users can get additional details about team tasks and perform activities, such as switching to another team file if they work on tasks for more than one team. 

Send Updates. This command opens the appropriate form to send task update information or a status report to the manager. Task updates integrate with the manager’s team task list. A status report is the team member’s written account of progress. 

View Team Status. This command opens a read­only version of the team file. 



�

Switching from Schedule+ to Outlook to View �Team Tasks

Team Manager can integrate with task lists in either Schedule+ or Outlook. If your workgroup is switching from Schedule+ to Outlook, users must import their Schedule+ files into Outlook to keep team tasks synchronized between Team Manager and Outlook. 

When users switch from Schedule+ to Outlook, they may need to set Team Manager to synchronize tasks with Outlook instead of with Schedule+. 

(	To set Team Manager to synchronize with Outlook



On the Outlook Tasks menu, click Team Manager for team members. 

In Team Manager, click Options. 

Select the Keep copies of tasks in check box, and then click Outlook in the box to the right. 

Click OK.



Task Priorities



The following task priorities are used in Schedule+, Outlook, and Team Manager: 

Schedule+. Tasks are prioritized from 1 to 9, A to Z, or A1 to Z9. Priority 1 is the highest priority. Priority 3 is the default. 

Outlook. Tasks are prioritized as High, Normal, or Low. 

Team Manager. Tasks are prioritized as Highest, Very High, High, Medium High, Medium, Medium Low, Low, Very Low, and Lowest. 



When you import or synchronize tasks between programs, priorities may change. Schedule+ tasks imported into Outlook are prioritized in the following way: 

1 = High 

5 = Low 

2 – 4 and 6 – 9 = Normal 



When Outlook tasks are synchronized with Team Manager, Normal priority tasks appear as Medium priority tasks in Team Manager. 



�

�Chapter 6

Optimizing Microsoft Outlook 97

Read this chapter to learn about helpful tips for using Microsoft® Outlook™ 97. These tips can help you and your user community to optimize Outlook features within the work environment.  

The information and instructions in this chapter were gathered primarily from technical experts and Microsoft Technical Support Knowledge Base articles. So that you can easily locate information in this chapter, topics are divided into these major categories:

Configuring Outlook

Conversion and Tools

Folders, Forms, and Address Books

Calendar Issues
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�Configuring Outlook



(	Additional Command-Line Switches for Outlook

The following table describes additional command-line switches for Outlook. You can use these switches to perform important Outlook tasks from the command line.



Command-Line switch�Description����/CleanFreeBusy�Cleans and regenerates free/busy information.��/CleanReminders�Cleans and regenerates reminders.��/CleanViews�Restores default views.��/ResetFolders�Restores missing folders for the default delivery location.��/ResetOutlookBar�Rebuilds the Outlook Bar.��/CleanSchedPlus�Deletes all Schedule+ data (free/busy, permissions, and .cal file) from the server and allows the free/busy information from the Outlook Calendar to be used and viewed by all Schedule+ 1.0 users.��



WARNING: ANY USE BY YOU OF THE COMMAND-LINE SWITCHES PROVIDED IN THIS SECTION IS AT YOUR OWN RISK. Microsoft provides these command-line switches without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability and/or fitness for a particular purpose. 



(	To use command-line switches 



In Windows 95 or Windows NT Workstation 4.0, right-click the Outlook icon, click Properties, and then click the Shortcut tab. 

-or-

In Windows NT Workstation 3.51, click the Outlook icon, and then on the File menu, click Properties. 

In the Target box or the Command Line box, type the path to the Outlook application file, type a space after the path, and then type one or more of the command-line options listed in the table. 



Note: If any path listed in the Target box or Command Line box contains spaces, such as C:\Program Files, you must enclose the path in quotation marks and use the correct case for each character in the path. The command-line switch must be typed outside the closing quotation mark. 



�

(	Changing the Inbox Icon to Start Outlook

After you upgrade to Outlook from Microsoft Exchange Client, Outlook might not start when you click the Inbox icon. Both Outlook and Exchange client use a shared component called the Windows Messaging System (WMS). Outlook setup does not change WMS to point to Outlook. You can start Outlook by using the standard Windows methods—use the Programs option from the Windows Start menu, or create a desktop shortcut to the Outlook program file. 

To remove the Inbox icon from the desktop and convert the Outlook shortcut to a permanent desktop icon, you can run the Chnginbx.exe program. This program is included with the Office 97 CD and is located in the \Valupack\Patch folder. You can copy this file to your computer, and then double-click the file to execute the program. The Outlook icon will then start Outlook automatically, retaining the attributes of the old Inbox, such as the ability to right-click the icon to see user profiles and service properties. 



(	Setting Up Outlook for Multiple or Roaming Users

Often, many users need to log on to the same computer or a roaming user may need to log on to different workstations on the network. In each of these cases, users might prefer to access their own Outlook settings. This section describes how to set up Outlook for multiple computer users or roaming workstation users if Windows NT is set up for roaming profiles. 

Typically, the files that store Outlook settings are located in the default Windows directory. These files are: 

Views.dat—stores name space views 

Outlprnt—stores print style settings 

<profile name>.fav—stores Outlook Bar settings 

<profile name>.rtf—stores AutoSignature information 



You can move these files to a unique location for each user and change the Windows registry settings to point to them for any user who uses the computer. For multiple users, locate the first three files in a separate directory for each user. For roaming users, locate the first three files in a server-based, private user directory. Then, if Windows NT is set up for roaming profiles, these files will be available from anywhere the user logs on to the network. 

The Outlook <profile name>.rtf does not travel with a roaming user. If two roaming users have the same profile name, an erroneous AutoSignature could be sent. If a roaming user travels to a computer that does not have an .rtf file that matches the profile name, the user will not get an AutoSignature when one is expected. 

�

You can set up multiple or roaming users using the following five-part process:

Copy the Outlook settings files into a separate directory.

Back up the registry before you modify any registry keys.

Add a new value of Favorites to the Office Explorer key, which will contain the path to <profile name>.fav. 

Add a new value of Views to the Office Explorer key, which will contain the path to Views.dat. 

Change the path to Outlprnt.





WARNING: Using Registry Editor incorrectly may cause serious problems that require you to reinstall Windows. Use Registry Editor at your own risk. Microsoft cannot guarantee the resolution of problems resulting from the incorrect use of Registry Editor. For information about how to edit the registry, view the “Changing Keys And Values” online Help topic in Registry Editor (Regedit.exe). Always make a backup copy of the registry files before you edit the registry. 



(	PART 1: To copy the Outlook settings files to a separate directory



For multiple users of a single computer, copy <profile name>.fav, Views.dat, and Outlprnt to a separate directory on the computer for each user. For roaming users, copy the three files to a server-based, private directory for each user. 



(	PART 2: To back up the registry



Click the Start button, and then click Run.

In the Open box, type regedit, and then click OK.

On the Registry menu, click Export Registry File.

Type a name for the registry file, and then click Save to save the registry to your desktop.



(	PART 3: To add a new value of Favorites to the Office Explorer key



Locate the following key in the registry: 

HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Outlook\Office Explorer 

Right-click Office Explorer, point to New, and then click String Value.

For the name of the new string value, type Favorites, and then press ENTER.

Right-click Favorites, and then click Modify. 

�

In the Value data window of Edit String, type the path to the user’s private directory in the following format:

drive:\<path\ (for multiple users)�\\<Servername>\<Sharename>\ (for roaming users)



IMPORTANT: The path must end with a trailing backslash, and the user must have read\write permission to the directory and the file.



(	PART 4: To add a new value of Views to the Office Explorer key



Right-click Office Explorer, point to New, and then click String Value.

For the name of the new string value, type Views, and then press ENTER.

Right-click Views, and then click Modify. 

In the Value data window of Edit String, type the path to the user’s private directory in the following format:

drive:\<path\ (for multiple users)�\\<Servername>\<Sharename>\ (for roaming users)



IMPORTANT: The path must end with a trailing backslash, and the user must have read\write permission to the directory and the file.



(	PART 5: To change the path to the Outlprnt file



Locate the following key in the registry: 

HKEY_CURRENT_USER\software\microsoft\office\8.0\Outlook\printing

Right-click Print Settings File, and then click Modify. 

In the Value data window of Edit String, change the path to the user’s private directory in the following format:

drive:\<path\ (for multiple users)�\\<Servername>\<Sharename>\ (for roaming users)

Important: The path must end with a trailing backslash, and the user must have read\write permission to the directory and the file.

Quit the Registry Editor, and then restart Windows.





�

(	Stopping Outlook from Dialing Your ISP �         When Starting

If your profile contains an Internet Mail transport service, Outlook might try to make a dial-up connection when you start this application. This section describes how to prevent Outlook from dialing the modem when starting, so that you can work offline and use Remote Mail. With Remote Mail, Outlook makes the dial-up connection only while you are checking and delivering mail. 

You can use one of two different Internet mail transport services with Outlook: either your original Internet Mail transport service or the Microsoft-provided Internet Mail transport service, which is included with Outlook 97 version 8.03. 

(	To use your original Internet Mail transport service to prevent an �            automatic dial-up connection



On the Tools menu, click Services. 

Click Internet Mail, and then click Properties. 

Click the Connection tab, and then select the Work Offline and use Remote Mail check box.

To close the open dialog boxes, click OK. 

On the File menu, click Exit and Log Off. 

Restart Outlook. 



(	To use the Microsoft-provided Internet Mail transport service �          to prevent an automatic dial-up connection



Using default settings, Outlook will not automatically dial your ISP and check mail. If Outlook does automatically dial your ISP when starting and you have the latest version of Outlook and the transport service, follow these steps: 

On the Tools menu, click Services. 

Click Internet E-mail, and then click Properties. 

Click the Connection tab, and then select the Disconnect when finished sending and receiving check box. (This option is the equivalent of “Work Offline and use Remote Mail.”) 

Make sure that the I use a modem to access my e-mail check box is selected and that the Use the following Dial-Up Networking connection check box reflects your ISP dial-up connection. 

To close the open dialog boxes, click OK. 

Restart Outlook. 

�

If you have followed the appropriate steps to prevent an automatic dial-up and �Outlook still dials your Internet Service Provider to check mail, make sure that the Internet Connection option Connect to the Internet as needed is not selected. 



(	To turn off the “Connect to the Internet as needed” option 



Click Start, point to Settings, and then click Control Panel. 

Double-click the Internet icon. 

Click the Connection tab, and then clear the Connect to the Internet as needed check box. 

Note: This setting also affects the behavior of Microsoft Internet Explorer. 



(	Configuring the Internet Mail Transport Service to �         Dial Your ISP Automatically

The Outlook Internet Mail transport service (included with Outlook 97 version 8.03) does not call your Internet Service Provider (ISP) automatically to check for new mail. This section describes how to set up the transport service to connect automatically to your ISP at a regular interval to check for new mail. The steps in this section describe the dialog boxes and settings for Microsoft Internet Explorer 3.02 users. 



WARNING: The steps described in this section do not work if you are using Outlook with the Windows NT operating system (the issue should not occur with Windows NT). The Microsoft Dial-Up Networking 1.2 Upgrade is designed for Windows 95 only. Installing the ISDN Accelerator Pack on Windows NT may damage your dial-up networking. 



You can set up Outlook and the transport service to do the following: 

When you start Outlook, it immediately dials your ISP and checks mail. 

After a three-minute idle time, your dial-up connection disconnects. 

At an interval you set, Outlook automatically dials your ISP and checks mail. 

If Outlook is not connected to your ISP and you send a mail message, �Outlook immediately connects to your ISP and sends the message. 

�

To set up the transport service to connect automatically to your ISP at a regular interval, complete the following five-part process: 

Install the Microsoft Dial-Up Networking 1.2 Upgrade. 

Set your e-mail connection type to “LAN” for all accounts that you want to check for new mail automatically. 

Configure your connection to disconnect if idle. 

Configure your Dial-Up connection. 

Set the Dial-Up interval. 



(	PART 1: To install the Microsoft Dial-Up Networking 1.2 Upgrade



To set Outlook to automatically call your ISP, you must install the ISDN 1.1 Accelerator Pack (even if you do not use ISDN). The Microsoft Dial-Up Networking 1.2 Upgrade is available from the Microsoft Web site at http://www.microsoft.com/. 



If you have Windows 95 OSR2 (an OEM version of Windows that is available only with a new personal computer), you do not need to install the Microsoft Dial-Up Networking 1.2 Upgrade. 

(	PART 2: To set your e-mail connection type to LAN



Start Outlook. 

On the Tools menu, click Services. 

Click your Internet E-mail service, and then click Properties. 

Click the Connection tab, and then select the I use a LAN connection check box. 

To close the Internet Mail Properties dialog box, click OK. 

Click OK to confirm the message that changes will take effect when you restart Outlook, and then click OK again to close the Services dialog box. 

Quit Outlook. 

If you have configured multiple accounts, you must repeat steps 1 through 7 for each account that you want to check for new mail automatically. 

�

(	PART 3: To set your connection to disconnect if idle



Note: The steps in this section apply to Microsoft Internet Explorer 3.02. If you use a different Web browser, the steps may be different. 

Click the Start button, point to Settings, and then click Control Panel. 

Double-click the Internet icon, and then click the Connection tab. 

Select the Connect to the Internet as needed check box, and then in the Use the following Dial-Up Networking connection box, click your ISP’s Dial-Up Networking connection. 

Select the Disconnect if idle for check box, set the timeout to three minutes, and then click OK. 

Three minutes is the minimum allowable setting. 



(	PART 4: To configure your dial-up connection



On the Windows Desktop, double-click My Computer, and then double-click Dial-Up Networking. 

Double-click the Dial-Up Networking connection you specified in step 3 of “Part 3: To set your connection to disconnect if idle.” 

Type your username and password, and then select the Save Password check box. 

Click Connect. 

After connecting to your ISP, click Disconnect. 

On the Dial-Up Networking Connection menu, click Settings, and then clear the Prompt for information before dialing check box. 

To close the open dialog boxes, click OK. 



(	PART 5: To set the dial-up interval



Start Outlook. 

On the Tools menu, click Options. 

Click the Internet E-mail tab. 

Select the Check for new messages every x minutes check box, where x is the number of minutes for your connection interval. This number must be greater than 3 (for example, select a value of 15 or 20); otherwise, Outlook will stay connected continuously. 

Click OK. 

�

Conversion and Tools



(	Converting Windows Cardfile Files to Outlook

Microsoft does not provide a converter to import Windows Cardfile files into Outlook. To import these files, use one of the two workarounds described in this section. 

WORKAROUND 1: Using the Schedule+ Import/Export Tool



You can use the Import/Export Add-on Pack for Schedule+ Version 7.0 to import the Windows Cardfile file into Schedule+ and then into Outlook. First, you need to install the Import/Export Add-on Pack for Schedule+ Version 7.0. 

(	To install the Import/Export Add-on Pack for Schedule+ 7.0



Download the Import/Export Pack from the Web site at http://www.microsoft.com/scheduleplus/freestuff/impconv/default.htm. 

Save the file at C:\Program files\Microsoft Office\Office.

Note: Because Microsoft constantly updates Web sites, the site address may change without notice. If this situation occurs, link to the Microsoft home page at http://www.microsoft.com/.

In the C:\Program files\Microsoft Office\Office folder, double-click Sch_suplfilt.exe to expand the downloaded converter programs. 

To run the converter, double-click Ilxlate.exe.

On the Transfer menu, click Import. 

On the Available Systems list, click Windows Cardfile/Calendar, and then click OK.

In the Section drop-down list, click Cardfile. 

Type the name of the Cardfile file to be converted, or click Browse to locate the file. 

On the Fields tab, map the Cardfile fields to the appropriate Schedule+ Contact fields, and then click Import.

This step generates a Schedule+ Default.scd file, which you can now import into Outlook. 



(	To convert Cardfile files using the Schedule+ Import/Export Tool



On the Outlook File menu, click Import and Export. 

Click Import from Schedule+ or another program or file, and then click Next.

Click Schedule+ 7.0, and then click Next. 

�

For the file name, type Default.scd, or click Browse to locate this file, and then, click Next. 

Click the Import default.scd (Contacts) into Contacts check box, and then click Map Custom Fields.

Map the incoming Schedule+ fields to the appropriate Outlook Contact fields, click OK, and then click Finish.

The Default.scd file is imported into Outlook. 



WORKAROUND 2: Creating and Importing a Tab-Delimited File to Outlook



You can import Windows Cardfile files into Outlook using the following three-part process:

Print the Cardfile records to a text file.

In Microsoft Word, convert the text file to a comma-delimited file.

Import the new file into Outlook.



PART 1: Printing the Cardfile Records to a Text File



First, create a text file from the Cardfile records.

(	To create a text file from the Cardfile records



In Windows 3.x, click the Printers icon in Control Panel. 

Configure the Generic/Text Only printer driver to the FILE port. 

Open Cardfile, and load the .crd file you want to import. 

On the File menu, click Print Setup. 

In the Print Setup dialog box, click Specific Printer, click the Generic/Text Only driver, and then click OK. 

On the File menu, click Page Setup, clear the Header and Footer check boxes, set the Left Margin to zero, and then click OK. 

On the File menu, click Print All. 

Type a name for the file, including the desired path and a .txt extension, and then click OK. 



�

PART 2: Manipulate the Comma-Delimited File in Word



For the second part of the workaround, perform the following tasks in order:

Convert the text file to a table.

Convert the table to tab-delimited text.

Enclose fields in quotation marks and replace tabs with commas.

Save the comma-delimited file.



(	To convert the text file to a table



Start Microsoft Word, and open the .txt print file created in Part 1 of the workaround. 

On the Edit menu, click Select All. 

On the Table menu, click Convert Text to Table. 

In the Number of Columns area, type 18, click Separate Text At Paragraphs, and then click OK.

Delete any completely empty columns by selecting them, and then on the Table menu, clicking Delete Columns.

Verify that the fields of each record are in the correct column. 

You must manually adjust any fields that are not in the correct column.

Position the mouse pointer in the first row of the table, and then on the Table menu, click Insert Rows.

In the newly inserted row, type a field name for each column. 



(	To convert the table to tab-delimited text 



On the Table menu, click Select Table. 

On the Table menu, click Convert Table to Text. 

In the Convert Table To dialog box, click Separate Text With Tabs, and then click OK.



(	To enclose fields in quotation marks and replace tabs with commas



Type a double quotation mark (“”) in front of the first character in the file.

On the Edit menu, click Replace. 

In the Find what window, type ^p, in the Replace with window, type “^p”, and then click Replace All.

�

In the Find what window, type ^t, in the Replace with window, type “,”, and then click Replace All.

Click Close.



(	To save the comma-delimited file



On the File menu, click Save As, and then type a name for the file. 

In the Save As Type window, click Text Only, and then click Save.



PART 3: Import the Comma-Delimited File into Outlook



For the final part of this workaround, import the file created in Part 2 into Outlook.

(	To import the comma-delimited file into Outlook



Start Outlook.

On the File menu, click Import and Export. 

Click Import from Schedule+ or another program or file, and then click Next. 

Click Comma Separated Values, and then click Next. 

Type the name of the comma-delimited file, or click Browse to locate the file, and then click Next. 

Click the folder where you want to import the records, and then click Next. 

Click to select the Import <filename.txt> into <foldername> folder check box, and then click Map Custom Fields. 

Map the incoming Cardfile fields to the appropriate Outlook fields, click OK, and then click Finish.



(	Running the Inbox Repair Tool

The Inbox Repair Tool  helps you repair problems associated with Personal Folder (.pst) files. The Inbox Repair Tool is included with Windows 95 and the Office 97 CD. 

(	To use the Inbox Repair Tool installed with Windows 95



Click Start, point to Programs, point to Accessories, point to System Tools, and click Inbox Repair Tool. 

Type the name of the file you want to scan, or click Browse to locate the file, and then click Start.



�

If Inbox Repair Tool is not listed under Windows System Tools, this tool might not have been installed as part of Windows 95. You can also run the tool from the Office 97 CD. You do not need to copy the tool to your hard disk because you will not use the tool frequently. 

(	To run the Inbox Repair Tool from the Office 97 CD



Insert your Office 97 CD in your CD-ROM drive. If the contents of the CD are not automatically displayed, right-click Start, click Explore, and then click your CD-ROM drive. 

Double-click the Office folder, and then double-click the WMS folder. 

If you are running Windows 95 or Windows NT 4.0, double-click the Win95 folder.

-or-

If you are running Windows NT 3.51, double-click the Winnt folder. 

To launch the Inbox Repair Tool, double-click Scanpst.exe. 



Folders, Forms, and Address Books



(	Capacity of Outlook Storage Facilities

The following storage facilities are used by Outlook when running as a client to Microsoft Exchange Server: 



Personal Folders (.pst) files located on the user's computer. One or more .pst files can reside on each user’s computer. A .pst file can be defined as your primary store, meaning that your mail is delivered to the Inbox in that file and all of your other default Outlook folders, such as Calendar, Contacts, Deleted Items, Journal, Notes, Sent Items, and Tasks reside there. Or, a .pst file can be defined as a secondary store, so that you can move items to it, either manually or with Inbox Rules, from your primary store. 

Each .pst file can contain as many folders as you want and each folder can contain a maximum of 64,000 records. The total size of a .pst file cannot exceed 2 gigabytes. 

Offline Store (.ost) files located on the user's computer. Only one .ost file can reside on each user’s computer. The .ost file is always defined as your primary store. Your mail is delivered to the Inbox in that file, and all of your other default Outlook folders, such as Calendar, Contacts, Deleted Items, Journal, Notes, Sent Items, and Tasks, reside there. 

�

The .ost file differs from the .pst file because .ost items can also reside in the user’s Mailbox on the server. You can synchronize the .ost file and Mailbox Folders so that they always contain the same information. Then, you can work offline when the server is unavailable; when you reconnect to the server, changes that you made offline are uploaded to the server, and mail received while you were offline is downloaded to the .ost file. 

The .ost file can contain as many folders as you want, and each folder can contain a maximum of 64,000 records. The total size of an .ost file cannot exceed 2 gigabytes. For more information about creating and using an offline folder file, see “Using Outlook Offline Folders” in this chapter.

Mailbox Folders located on Microsoft Exchange Server. The Exchange Server stores a Mailbox Folder for each user in the same database store. There is no server store limit for Exchange Server 5.5; with Exchange Server 4.0 and 5.0, the server has a capacity of 16 gigabytes for one store, which translates to millions of records. However, the server administrator can limit the size of each user’s Mailbox Folder. 

Public Folders located on Microsoft Exchange Server. Public Folders reside on the server in the same database store. They contain information shared by many users. Depending on access permissions, individual users can read, update, or add to the Public Folder. There is no server store limit for Exchange Server 5.5; with Exchange Server 4.0 and 5.0, the server has a capacity of 16 gigabytes for one store, which translates to millions of records. However, the server administrator can limit the size of each Public Folder. 



(	Backing Up Outlook Data

You can back up data created in Outlook, including e-mail messages, contacts, appointments, tasks, notes, and journal entries. Outlook stores its data in Messaging Application Programming Interface (MAPI) folders. MAPI folders can be stored in a Personal Folder file on your hard disk, or if you are using Outlook with Exchange Server, you can store the data in a mailbox on the server. 

This section describes the following: 

Making a backup copy of a Personal Folder file 

Importing or Exporting Personal Folder data 

How To Back Up Data Using Outlook with Microsoft Exchange Server 



Making a Backup Copy of a Personal Folder File



If you are not using Outlook with Microsoft Exchange Server, Outlook will store all of its data in a Personal Folder (.pst) file. If you want to back up or export a particular folder, such as Contacts or Calendar, use the steps described in “Importing and Exporting Personal Folder Data.” 

�

(	To back up the entire Personal Folder file 



Close any mail-related programs, such as Outlook, Microsoft Exchange, or Windows Messaging. 

Click the Start button, point to Settings, and then click Control Panel. 

Double-click the Mail and Fax icon. If you do not have Microsoft Fax installed, double-click the Mail icon instead. 

Click the Personal Folders service you want to back up; if you have more than one Personal Folders service in your profile, back up each set of personal folders separately. By default this service is called “Personal Folders”; however, it could have been named something else. 

If the service has been named something else, you can find out about a service by selecting it from the list of services, and then clicking Properties. On the dialog box that appears, the title bar will say “Personal Folders” if the service is a Personal Folders service. After you read the title bar, click Cancel. Use this method to check the type of any unfamiliar service.

Note: If your profile contains no Personal Folders services and you store information, such as e-mail, contacts, or appointments, in Outlook, your information is most likely stored in a mailbox on a Microsoft Exchange Server. In this case, see “Backing Up Data When Using Outlook with Microsoft Exchange Server.”

If there are no personal folders in the list of services and you are not storing information in a Microsoft Exchange Server mailbox, you can use Outlook for browsing files only; the features that store data cannot be used, and there is no data to back up.

Click Properties, and make a note of the path and file name listed in the Properties dialog box.

Note: You might be able to reduce the size of a Personal Folder file by clicking Compact Now. This function is especially useful if you plan to back up the Personal Folder file to a floppy disk.

To close the open dialog boxes, click OK. 

Using Windows 95 Explorer, make a copy of the file that you noted is step 5. For more information about copying files in Windows 95, click the Start button, and then click Help. 

If you ever need to restore a Personal Folder file, simply copy the backup copy of the file you created by using the above steps to the same folder and name you noted in step 5. 



�

Importing and Exporting Personal Folder Data



You can export and import an individual folder, such as Contacts or Calendar, to its own personal folder file.

(	To export Personal Folder data



On the File menu, click Import and Export. 

Click Export to a personal folder file, and then click Next. 

Click the folder you want to export, and then click Next. 

For Save exported file, type the name of the file to which the data will be exported. 

Click Finish. 



(	To import Personal Folder data



On the File menu, Click Import and Export. 

Click Import from a personal folder file, and then click Next. 

Type the path and name of the personal folder file you want to import, and then click Next. 

Click the folder into which the data will be imported. 

Click Finish. 



Backing Up Data Using Outlook with Microsoft Exchange Server



If Outlook is being used with Microsoft Exchange Server, you can choose to have Outlook store information on the Microsoft Exchange Server or in a set of Personal Folders on your hard disk. 

(	To determine where Outlook currently stores its data 



On the Tools menu in Outlook, click Services. 

Click the Delivery tab. 

Examine the Deliver new mail to the following location field. 

If the field contains the word “Mailbox” followed by an e-mail name, Outlook stores new e-mail, contacts, and appointments in a set of folders on the Exchange Server. If the field contains the words “Personal Folder” or another name of a set of personal folders, Outlook stores new e-mail, contacts, and appointments in the personal folders on your hard disk.

When Outlook information is stored on Microsoft Exchange Server, it is typically backed up at the server. If your information is being stored in a set of Personal Folders on your hard disk and you want to back up the data, see the section “Making a Backup Copy of a Personal Folder File.” 

�

(	Controlling Your Mail Store on the Server

The following tips can help users reduce the size of their mail store on the server: 

Create a Personal Folder (.pst) file on your hard disk to archive folders/items that you do not need to access regularly. To set up this personal folder, click the Tools menu, and then click Services. Then, create the folders in the .pst file, and manually copy or cut items from your server mailbox to the file.

If you are not using the Outlook Journal, make sure that you turn off the AutoJournal feature. To turn it off, click the Tools menu, click Options, and then click Journal.

Delete items that are old or no longer relevant, including mail, calendar information, and tasks.

Delete attachments from mail, and save only relevant attachments to your hard disk.

Install the StorStat utility from your Outlook or Office CD. This utility analyzes your server store (or any .pst or .ost file) and gives you complete statistics, including the number of items and folders and the size of your mail store. 



(	To install the StorStat utility



Copy the entire StorStat folder from the Outlook or Office CD to your hard disk. 

Quit Outlook.

Click Start, and then click Run.

In the Open box, type: c:\storstat\storstat.exe_/email name





(	Help with Outlook Forms

The Olfrmhlp.exe file contains an Outlook Help add-in with detailed information about using and creating forms in Outlook. Olfrmhlp.exe contains the following files: 

Formshlp.exe, which is the Outlook Forms Help add-in

Readme.txt, which provides instructions for installing the Help add-in



You can download the Olfrmhlp.exe (376,064 bytes) self-extracting file from the following services:

Internet (anonymous FTP). Connect to ftp.microsoft.com, open the Softlib/Mslfiles folder, and then download the file.

Microsoft Download Service (MSDL). Dial (425) 936-6735 to connect to MSDL, and then download the file.

�

Microsoft’s World Wide Web Site on the Internet. Download the file from the Technical Support Knowledge Base on the Internet. 



(	To download Olfrmhlp.exe from the Internet



Access the Internet.

On the http://www.microsoft.com/ page, click Support, and then click Support Online.

Select the Outlook product, type Olfrmhlp.exe, and then click Find.

Double-click to open the article, and download the file.





(	Managing a Personal Folder File for Two Computers

Outlook does not synchronize a Personal Folder (.pst) file between two different computers automatically. There are three possible workarounds for synchronizing .pst files:

Option 1: Use an Offline Store (.ost) file. If you are running Microsoft Exchange Server as your mail service, the best way to synchronize data between two computers is to use an .ost file. Then, the data stored on the server is synchronized automatically with each computer using the server store. 

Option 2: Copy the Personal Folder (.pst) file. You can use a single .pst file and copy it from one computer to another. A problem with this technique is that a .pst file can become very large and may be too large to copy to a floppy disk. In this event, you can use Windows Backup or another backup utility with the ability to write a file over multiple disks. 

Note: You can use the Briefcase application to synchronize two computers if your .pst file is less than 1.44 MB in size.



Option 3: Copy only the Calendar, Contacts, and Task folders. Usually, a large .pst file is the result of e-mail stored in the Inbox Deleted Items and other mail store folders. Therefore, you might want to share only your Calendar, Contacts, and Tasks without sharing your mail folders. To share only your Calendar, Contacts, and Tasks, complete the following three-part process:

Define a second .pst file for the shared folders. 

Copy Calendar, Contacts, and Tasks items into the new shared folders. 

Delete the contents of the old folders.



Note: These steps must be performed on both computers that will share the .pst information. 

�

(	PART 1: To define a second .pst file



On the Tools menu, click Services. 

Click Add, click Personal Folders, and then click OK. 

Type a unique name for the new .pst file, such as “Shared.pst,” and then click Open.

Type a display name for the Personal Folder, such as “Shared Folders,” and �then click OK.

On the File menu, click Exit and Log Off. 



(	PART 2: To copy your existing Calendar, Contact, and Task items to the �          new folders



Start Outlook. 

Right-click your original Calendar folder, and then click Copy Calendar. 

In the Copy Folder dialog box, click to select your Shared Folders, and then click OK.

Repeat steps 2 and 3 for both your Contacts and Tasks folders.

You should now have Calendar, Contacts, and Tasks folders in your new Shared Folders file. Verify that the new folders contain all the items from the old folders before continuing with Part 3. 



(	PART 3: To remove the contents of your old Calendar, Contacts, �          and Tasks folders



Click your original Calendar folder, and in the Current View window, click Active Appointments.

On the Edit menu, click Select All. 

Right-click the selected items, and then click Delete. 

Click your original Contacts folder. 

On the Edit menu, click Select All. 

Right-click the selected items, and then click Delete. 

Click your original Tasks folder. 

On the Edit menu, click Select All. 

Right-click the selected items, and then click Delete. 



�

Now, your mail will be delivered to your original Personal Folder set, while Calendar, Contacts, and Tasks items will be delivered to your new Shared Folder set. This new Shared Folder set (Shared.pst) should be small enough for you to conveniently copy the information to disk for transport between computers. 



(	Reordering Outlook Address Book Names

In Outlook, Contacts are listed in the Address Book in “Firstname, Lastname” order by default. This section describes how to create and use a new mail form that toggles this order to “Lastname, Firstname.” 

Important: Microsoft provides programming examples for illustration only, without warranty either expressed or implied, including, but not limited to, the implied warranties of merchantability and/or fitness for a particular purpose. Microsoft assumes that you are familiar with the programming language being demonstrated and the tools used to create and debug procedures. Microsoft support engineers can help explain the functionality of a particular procedure, but they will not modify these examples to provide added functionality or construct procedures to meet your specific needs. If you have limited programming experience, you may want to contact the Microsoft fee-based consulting line at (800) 936-5200. For more information about the support options available from Microsoft, see the Web site at http://www.microsoft.com/.



Designing a New Mail Form



To create a new mail form that allows you to toggle the contacts listed in the Address Book between “Firstname Lastname” and “Lastname, Firstname” order, complete the following three-part process: 

Open a mail message, and design a new Outlook form.

Insert VBScript code into the form to change the first and last name order.

Rename the second page tab, and publish the new form.



(	PART 1: To create a new form



On the File menu, point to New, and then click Mail Message to open a new mail message.

On the Tools menu of the new mail message, click Design Outlook Form, and then click the second page tab to go to a blank page on the form.

On the Form menu, click Control Toolbox.

In the Toolbox dialog box, click CommandButton, and then drag it to the blank form page.

Right-click CommandButton1, and then click Properties.

�

In the Caption window, type Last, First, and then click OK.

In the Toolbox dialog box, click CommandButton, and then drag a second button to the blank form page.

Right-click CommandButton2, and then click Properties.

In the Caption window, type First Last, and then click OK.



(	PART 2: To insert Visual Basic Script (VBScript) code in the form



 On the Form menu, click View Code to open the Script Editor.

In the Script Editor, type the following code: 

   End If

   End Sub



   Sub CommandButton2_Click()

   'This will reset contacts in CURRENT folder to FirstName LastName

   Set CurFolder=Application.ActiveExplorer.CurrentFolder

   If CurFolder.DefaultItemType=2 Then

      MsgBox "This process may take some time. You will be notified" & _

      "when complete.",,"Contact Tools Message"

      Set MyItems=CurFolder.Items

      For i = 1 to MyItems.Count

         Set MyItem=MyItems.Item(i)

         If Trim(MyItem.FullName)<>"" Then

            MyItem.Subject=MyItem.FullName

            MyItem.Save

         End If

      Next

      MsgBox "Done sorting Outlook Address Book contacts by First" & _

      " Name!",64,"Contact Tools Message"

   Else

      MsgBox "The current folder is not a Contact folder.",64,"Contact" & _

      " Tools Message"

   End If

   End Sub



3.	To return to the form, on the Script Editor File menu, click Close.



�

(	PART 3: To rename the second page tab and publish the new form



On the Form menu, click Rename Page.

Type a meaningful name for this page, such as “Reorder Names,” and then click OK.

On the File menu, click Publish Form As.

In the Form Name box, type a meaningful name for your new form, such as “Reorder Address Book Names.” Verify that Personal Forms appears next to the Publish In button, and then click the Publish button.

Close the message without saving.



Using Your New Form



After you design the new mail form, you can access the updated contacts list, which now uses the new “Lastname, Firstname” format.

(	To use your new form



Open the Contacts folder you want to sort differently. 

On the Contact menu, click Choose Form. 

In the Personal Forms list, click your new form, and then click OK. 

Click the second page tab, and then click the appropriate button to sort the contacts in the desired order within the Address Book. 

Note: This process affects only contact names in the current folder, and then only those names viewed in the Address Book. It has no effect on the order of names within any of the Contact List views. 



(	Sending Mail Messages to a Fax Number

When using the Microsoft Fax service with Outlook, you can address new mail messages to both e-mail addresses and fax telephone numbers. You can manually type a recipient’s fax number, or, if the entry already exists, you can select the number from an Address Book. If you manually type a fax telephone number, you must use the following format: 

[FAX:NUMBER]



(	To send a mail message to a fax number



In Outlook, click the Inbox on the Outlook bar. 

On the Compose menu, click New Mail Message. 

�

On the To line, type: [FAX:NUMBER] (where NUMBER is the fax telephone number to which you want to send the mail message.) 

Enter the subject and the message you want to send.

Click Send. 

Note: For the above steps to work, you must have the Microsoft Fax service as part of your current profile. 

When you use the special format described in step 3, Outlook instructs Microsoft Fax to process the message and send it as a fax automatically. 



(	Sharing Outlook Folders Using Briefcase

When you use Outlook in conjunction with Microsoft Exchange Server, you can share information in MAPI folders, such as Calendar, Contacts, and Tasks. 

To share Outlook folders using Briefcase, complete the following three-part process:

Use the Import and Export wizard in Outlook to export the MAPI folder you want to share to a new Personal Folders (.pst) file.

Create a Briefcase folder on any computer that needs to share the .pst file.

Open the shared Personal Folder in Outlook.



(	PART 1: To export the Outlook folder that you want to share



On the File menu, click Import and Export.

For Choose an action to perform, click Export to a personal folder file (.pst), and then click Next.

Click to select the MAPI folder you want to share, and then click Next.

In the Save Exported File As box, type a path to a shared directory on the local computer or on a server that allows access to users.

Click Finish.



After you export the folder, assign full access to the newly created .pst file to users who need to update the data. Also, assign Read Only access to people who only need to view the data. Then, create a Briefcase folder on any computer that needs to share the .pst file.

Note: Briefcase synchronizes files, not individual items within files. If many people update the data in their local copies, and then synchronize, updates from one user can overwrite updates from another user. Therefore, the fewer people who can update the files, the better. 



�

(	PART 2: To create a Briefcase folder for the new .pst file



In Windows Explorer, open the folder where you want to create the new Briefcase icon.

On the File menu, point to New, and then click Briefcase.

Rename the Briefcase using a name that users can recognize, such as “Outlook Share.”

Copy the .pst file (created in Part 1) into the new Briefcase to make a synchronized copy. 

Repeat Steps 1 though 4 on each computer that needs to access the shared folder. 



Before starting Outlook, each user must right-click the Briefcase in Windows Explorer, and then click Update All. Then, when you start Outlook, it will contain the latest copy of the shared data. Users who can update the shared data should also update the Briefcase to synchronize the shared copy each time they quit Outlook.



(	PART 3: To open the shared folder in Outlook



On the Outlook File menu, point to Open Special Folders, and then click Personal Folder. 

In the Connect to Personal Folders dialog box, locate and open the new Briefcase. Click to select the .pst file, and then click OK to load this file into your current Outlook profile. 

Repeat steps 1 and 2 on each computer that needs to access the shared folder. 



With Briefcase, users who have access can also replace the shared copy with their local copy to add updates from their local computer. 



(	Updating Existing Items to Use a New �         Custom Form

You can update items in an Outlook folder so they use a custom form instead of the standard Outlook form. Several situations can occur in Outlook when you may want to change the form used for all the items in a folder. For example: 

You use the default Outlook form to enter 10 contacts into your Contacts folder. Then, you create a special custom form for contacts and enter 10 additional contacts. When you view one of the first 10 contacts, you want the information to be displayed in the new custom form. 

�

You create a custom form for contacts and enter 10 contacts using the custom form. Then, you import 100 contacts from a text file. The 100 imported contacts use the default form instead of the custom form. 

You have a public folder with 1000 posted items based on the default post form. Then, you create a custom form that organizes the items for your work. You want to apply the new form to the 1000 existing items. 



Outlook Message Classes



A property of the item called “message class” determines the form that the item uses. You cannot change the message class of an item manually. However, you can write VBScript or Automation code to change the message class for all items in a folder. When you create and publish a custom form, the form is assigned a message class. This message class determines the form that is associated with an item. The format of the name is usually IPM.<FolderType>.<FormName> where <FolderType> is the type of folder (for example, Contacts or Tasks) and <FormName> is the name of the form. For example, if you create a new form named Revised and publish the form to your Contacts folder, the message class is IPM.Contact.Revised. 

The following table lists the names used for message classes.

Item�Default folder�Default message class����Contact�Contacts�IPM.Contact��Task�Tasks�IPM.Task��Appointment�Calendar�IPM.Appointment��Note�Notes�IPM.StickyNote��Journal Entry�Journal�IPM.Activity��Mail�Inbox�IPM.Note��

To see the message class for an existing item, add the message class field as one of the columns in the current view. 

(	To add the message class to your view



On the View menu, click Field Chooser. 

In the Field Chooser list, select All Contact Fields. 

To add the field as a column in your current view, drag the message class field (for example, Account or Anniversary) to the column header. 

The message class in this view is Read Only; you cannot type a different message class to change the form manually. 

�

Changing the Message Class



To change the Message Class field for existing items, use Visual Basic Script (VBScript) code within an Outlook form, or use Visual Basic for Applications code from another program to automate Outlook. 

You can use the following two methods to change Message Class fields: 

Download Omsgclas.exe. This file contains a Word 97 document with a macro utility that displays a dialog box with options for changing Outlook Message Classes. This Omsgclas.doc document allows you to change the message class held for each item in the folder so that all existing items will use a specific custom form. The macro runs automatically when you open the document. You can download the Omsgclas.exe file (40,242 bytes) from the Microsoft Software Library; see the Microsoft Web site at http://www.microsoft.com/.

Create and run a VBScript routine that changes all the items in a folder to a specified form. First, you must create a new item to store the VBScript, and then you can enter and run the VBScript code.



Important: Microsoft provides programming examples for illustration only, without warranty either expressed or implied, including, but not limited to, the implied warranties of merchantability and/or fitness for a particular purpose. The procedures in this section assume that you are familiar with the programming language being demonstrated and the tools used to create and debug procedures. Microsoft support engineers can help explain the functionality of a particular procedure, but they will not modify these examples to provide added functionality or construct procedures to meet your specific needs. If you have limited programming experience, you may want to contact the Microsoft fee-based consulting line at (800) 936-5200. For more information about the support options available from Microsoft, please see the Web site at http:/www.microsoft.com/. 



(	PART 1: To create a new item to store the VBScript code



Open the folder that contains the items you want to update. 

On the File menu, point to New, and then click the appropriate item. For example, if you want to create a new item in the Contacts folder, click Contact. If you do not want to keep the item in this folder, you can move the item to a different folder at a later time. The item, though, must be located temporarily in the folder so that the VBScript code can function correctly. 

To enter form design mode, on the Tools menu, click Design Outlook Form. 



�

(	PART 2: To enter the VBScript code



Note: The example in this section assumes that you have published a new form called MyNewForm in the current folder. If you use a different title for your form, modify the form title used in the third line of code.

On the Form menu, click View Code. 

In Script Editor, type the following code. You do not need to enter the lines that begin with an apostrophe, since these lines are comments that are ignored when executed. 

   Sub Item_Open

   ' Change the following line to your new Message Class

   NewMC = "IPM.Contact.MyNewForm"

   ' Set cf to the current folder

   Set CurFolder = Application.ActiveExplorer.CurrentFolder

   ' Loop through all of the items in the folder

   For I = 1 to CurFolder.Items.Count

      Set CurItem = CurFolder.Items.Item(I)

      ' Test to see if the Message Class needs to be changed

      If CurItem.MessageClass <> NewMC Then

         ' Change the Message Class

         CurItem.MessageClass = NewMC

         ' Save the changed item

         CurItem.Save

      End If

   Next

   MsgBox "Done."

   End Sub



On the Script Editor File menu, click Close. 

To exit form design mode, on the Tools menu, click to clear the Design Outlook Form check box. 

To save the item in the current folder, on the item’s toolbar, click Save and Close. If the item does not have a Save and Close button, click the X in the upper-right corner of the item’s window, and then click Yes when asked to save changes. 



(	PART 3: To run the VBScript code



To run the VBScript code, re-open the item. The code runs automatically because it was entered into an Item_Open event procedure. If you receive a macro warning, click Enable Macros. 

Wait while the code changes the message class for all of the items in this folder. Depending on the number of items, this may take several minutes. When the code finishes, you should receive a message that says: Done. 

If you want to edit the VBScript code later, hold down the SHIFT key when you open the item. This prevents the VBScript code from executing, and you can go into form design mode and make changes to the VBScript code. 

�

(	Using Links to Access Outlook Folders �         and Items

You can use three methods to create links that open Outlook folders and items: 

To open an Outlook folder on your server, use this syntax: 

<Outlook:Foldername>

For example: <Outlook:Sent Items>

To open a Personal or Private folder, use this syntax: 

<Outlook://Foldername>

For example: <Outlook://Personal Folders/My Stuff>

To open a specific item, precede the name with a tilde (~): 

<Outlook:Foldername/~Itemname>

For example: <Outlook:Contacts/~Nancy Davolio>



Note: You must include the GREATER THAN (>) and LESS THAN (<) symbols. 



If you are using WordMail, you can drag a folder into a mail message to automatically generate a link. If the folder name contains a space, the space is replaced with %20 for compatibility with browsers that do not support spaces in names.

If you are not using WordMail, Outlook creates an *.xnk shortcut (instead of a link) when you drag a folder into a mail message.



(	Using Outlook Offline Folders

When you use Outlook with the Microsoft Exchange Server Information Service, you have the ability to work with folders “offline.” You can use the contents of a folder without a network connection, which is beneficial for remote users. This section describes how you can create, use, and synchronize offline folders. 

Offline folders are the quickest and easiest way to work offline with Microsoft Exchange Server. With offline folders, you can take a folder from the Exchange Server location, work with the contents of the folder, and when you are connected to the network, you can update (synchronize) the folders. 

Note: Offline folders are available only with Microsoft Exchange Server. 



�

Creating Offline Folders



Offline folders are stored in an Offline Folder (.ost) file. This file is located on your computer hard disk. The default location for the .ost file is your current Windows folder, which you can access even when the network is unavailable. Like Personal Folder (.pst) files, the .ost file can be compacted to save space on your computer. 



The difference between an Offline Folder file and a set of Personal Folders is that the Offline Folder file starts as a mirror image of your folders on Exchange Server and works in conjunction with the Server during synchronization. A set of Personal Folders, on the other hand, is simply a storage location on your local hard disk or on a server other than Exchange Server. 



(	To create an offline folder file



On the Tools menu, click Services. 

Click Microsoft Exchange Server, and then click the Properties button. 

Click the Advanced tab, and then click the Offline Folder File Settings button. 

Type the path to the file you want to use as the offline folder file. 

If you receive a message stating that the “<path><filename>.ost could not be found. Would you like to create it?” click the OK button. 

Click OK. 

Note: The client must be connected to the Exchange Server for the initial creation and synchronization of the Offline Folder file. 

All of the standard Outlook folders (Inbox, Outbox, Deleted Items, Sent Items, Calendar, Contacts, Journal, Notes, and Tasks) on Exchange Server are now ready for offline use. You cannot selectively choose the folders that are available for offline use, except Public Folders and any user-defined folders. 

(	To set user-defined folders for offline use



Right click the user-defined folder, and then click Properties. 

Click the Synchronization tab, and then in the This folder is available area, click When offline or online. 

Click OK. 

Note: You cannot use an .ost file that was previously used with a different mailbox. Doing so produces the following error message: 

The file <filename>.ost cannot be accessed because it has been configured for use with a different mailbox.



�

Using Offline Folders



When working offline, you can add, delete, and modify the contents of an offline folder in the same way that you use a folder on a server. For example, you can change and move items in your offline Inbox, send messages that are placed in your offline Outbox, and read your offline Public Folders. In the meantime, information on the server is still processing. You will continue to receive new messages in your Mailbox, and other users can add, delete, and change items in Public Folders. However, you will not be aware of these changes on the server until you connect to the network. 



(	To work with Public Folders offline



Right-click the Public Folder that you want to work with, and then click Copy <FolderName>. 

Click your Favorites folder, and then click OK.

From your Favorites folder, right-click the newly copied folder, and then click Properties. 

Click the Synchronization tab, and then in the This folder is available area, click When offline or online. 

Click OK. 

Your Public Folder is now ready for offline use. Now you can set each folder that you copy to your Favorites Folder for offline use. 



Synchronizing Offline Folders



You can synchronize the contents of the offline folder and its corresponding server folder, and then continue to work offline. The Synchronize command (Tools menu) connects to the server through Dial-Up Networking, copies the changes made in each offline folder to the other server folder, and then disconnects. Any item that you delete from either the offline folder or the corresponding server folder will be deleted from both folders. 

To synchronize offline folders, use one of the following methods:

Synchronize a specific folder.

Synchronize all folders.

Automatically synchronize all folders when you quit Outlook.

 

Note: When you synchronize folders, a log file appears as a message in your Deleted Items folder. This log file contains information, such as the time you synchronized, the names of the folders synchronized, and the number of items added. 

�

(	To synchronize a specific folder



Click the folder you want to synchronize.

On the Tools menu, click Synchronize, and then click This Folder. 



(	To synchronize all folders



On the Tools menu, click Synchronize, and then click All Folders. 



(	To automatically synchronize all folders when you quit Outlook



On the Tools menu, click Options. 

Click the General tab, and then select the When online, synchronize all folders upon exiting check box.

Click OK. 

Now, all offline folders will be synchronized automatically when you quit Outlook. 



Downloading Your Address Book



Before working with your offline folders on a second computer ( for example, a computer at home or on the road), it is important to synchronize and download the Address Book before you log off from Exchange Server. This process ensures that all your offline folders are updated before you leave the office. 



(	To download your address book



On the Tools menu, click Synchronize, and then click Download Address Book. 

Click either Download offline address book or Download offline address book without details information, and then click OK. 

The Download Offline Address Book dialog box contains information about the results to expect if you download without details information. 

Note: The Outlook Remote Mail feature is not available if you are set for Offline Folder Use. 



�

Calendar Issues



(	Customizing Outlook Calendar Holidays

You can customize the pre-defined Calendar holidays in Outlook. The technique described in this section involves modifying the Outlook.txt file that stores the holidays for the active calendar. Outlook stores a read-only text file named Outlook.txt in the \Program Files\Microsoft Office\Office folder, which it uses for the Add Holidays feature. 

The Outlook.txt file lists holidays in the following format: 

[Country] ###

Holiday description, yyyy/mm/dd

Holiday description, yyyy/mm/dd



In this format, ### is the total number of holidays listed for a particular country. Note that there is a space between the closing bracket and the number, as well as a carriage return at the end of the line. On each holiday line, there is a comma and a space between the holiday description and the date, as well as a carriage return at the end of the line. For example: 

[United States] 3

Independence Day, 1997/07/04

Thanksgiving Day, 1997/11/27

Christmas Day, 1997/12/25





WARNING: MODIFY THE OUTLOOK.TXT FILE AT YOUR OWN RISK. Microsoft provides this procedure "as is" without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability and/or fitness for a particular purpose. 



(	To create a custom set of holidays



If you are running Outlook, quit the application. 

Start Windows Explorer, locate Outlook.txt, and make a backup copy of the file. 

Right-click Outlook.txt ( the original file), and then click Properties. 

In the Attributes area, clear the Read-only check box, and then click OK. 

In Windows Explorer, double-click Outlook.txt to open the file in Notepad or WordPad. 

Press CTRL+END to position the insertion point at the end of the file. 

Type a new country header and custom holidays using the format described above. 

�

Save and close Outlook.txt in a text-only format. 

Switch to Windows Explorer. Right-click Outlook.txt (the original file), and then click Properties. 

In the Attributes area, select the Read-only check box, and then click OK. 

The next time you run Outlook, the new custom holidays are added to your Calendar. 

Note: Thanksgiving Day is incorrect in the United States section of the holiday file. It is scheduled for Wednesday rather than Thursday. You can correct this day using the procedures described in this section. This problem was corrected in Microsoft Outlook 97 version 8.02 or later for Windows. 



(	Using Schedule+ As the Primary Calendar �         in Outlook

In Outlook, you can substitute Microsoft Schedule+ 95 for the Outlook calendar function. In a mixed environment consisting of Outlook and Schedule+ 95 and/or Schedule+ 1.0 users, all users can exchange meeting request messages and share free/busy status with each other. However, many Outlook capabilities go beyond those of Schedule+ 95 and Schedule+ 1.0. Outlook users should be aware that their coworkers who are still using Schedule+ 95 or Schedule+ 1.0 may not be able to view or use some of the messaging or calendar information the same way another Outlook user can. For more information about interoperability with Schedule+, see “Interoperability with Microsoft Schedule+” in Chapter 4, “Interoperability.”

Although Outlook, Schedule+ 95, and Schedule+ 1.0 offer a high level of interoperability for basic calendar and group scheduling functions, the differences can affect more advanced levels of access to other calendars. Using the option to “Use Schedule+ 95 as my primary calendar” is one method of allowing a group of users to modify each other’s schedules seamlessly. Continuing to use Schedule+ for calendar functions during the transition period ensures the retention of the same level of interoperability that existed before the upgrade to Outlook. 



(	To enable the option to use “Schedule+ as my primary calendar”



On the Outlook Tools menu, click Options. 

On the Calendar tab, select the Use Schedule+ 95 as my primary calendar check box. 

Enabling this option adds a button for starting Schedule+ 95 to the Outlook toolbar. The Outlook calendar is no longer used. 

�

If you decide you want to switch from Schedule+ to the Outlook Calendar, you can go back and clear this option. Also, you can use the Outlook Migration Kit to migrate a group of users from Schedule+ to the Outlook Calendar; for more information, see “Microsoft Outlook Migration Kit” in Chapter 3, “Migration.”

Note: The option to use Schedule+ 95 for the primary calendar is available only if Schedule+ 95 is installed and working on the computer before you install Outlook. Alone, the Outlook Setup program does not install enough of the Schedule+ 95 file set to enable its operation, and this option will not be available. 



(	Getting the Outlook Calendar Template �         for Word 97

Olcalndr.exe contains a sample Microsoft Word 97 template. The template includes Visual Basic for Applications (VBA) macros, which use OLE Automation to automate the process for creating Outlook monthly calendars. The template enables you to print the monthly view of your Outlook calendar, with or without weekends and in either portrait or landscape layout. Because the template uses the Word table format, you can easily modify your calendar before saving or printing. Using the Word for Windows “Save as HTML” converter, you can save the monthly calendar for publishing on a Web page. 

You can download the Olcalndr.exe (59,060 bytes) from the Microsoft Software Library; see the Microsoft Web site at http://www.microsoft.com/. Olcalndr.exe contains the following files: 

Olcalndr.dot, which is the Outlook Calendar Template for Word

Readme.txt, which provides information and instructions about Olcalndr.exe



�Appendix A

Sample Outlook.prf File

This appendix provides the complete contents of a sample profile descriptor file (.prf), which is the messaging profile used by Microsoft® Outlook™97 to define a user’s mail settings and preferences. System administrators can review this sample file when they customize the .prf file for their own user communities. For more information about messaging profiles, see Chapter 2, “Installation and Configuration.” 
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�Outlook.prf for Microsoft Exchange Server Users

The Outlook.prf file in this appendix provides an example of how to create a .prf file that configures Outlook users with Microsoft Exchange Server. You can modify Sections 1, 2, and 3 of the .prf file. DO NOT MODIFY SECTION 4. Modifying Section 4 can cause Exchange Server services to stop responding. When editing your Outlook.prf file, you must ensure that property values match their property types. 

Note: You must fill in the HomeServer setting for the Exchange Server before using this file. For more information, see “About the HomeServer= Setting” in Chapter 2, “Installation and Configuration.”

For information about how to disable Outlook Profile Setup and use the Inbox Setup Wizard instead, see NONE.PRF in the Office Resource Kit.

Outlook.prf File Contents

************************************************************************

; Section 1 - Profile defaults.



[General]

Custom=1

;	-- Required.  Indicates that this is a customized PRF file.

ProfileName=Microsoft Outlook

DefaultProfile=Yes

OverwriteProfile=Yes

DefaultStore=Service2



; ************************************************************************

; Section 2 - Services in profile.



[Service List]

Service1=Microsoft Outlook Client

Service2=Microsoft Exchange Server

Service3=Outlook Address Book



; ************************************************************************

; Section 3 - Default values for each service.



[Service1]

EmptyWastebasket=FALSE

SelectEntireWord=TRUE

AfterMoveMessage=2

CloseOriginalMessage=FALSE

GenReadReceipt=FALSE

GenDeliveryReceipt=FALSE

DefaultSensitivity=0

DefaultPriority=1

SaveSentMail=TRUE
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[Service2]

ConversionProhibited=TRUE

HomeServer=Enter your Microsoft Exchange Server Name

;       Required.

;	--  The name of the Microsoft Exchange Server the user should

;	connect to.  You can specify any Microsoft Exchange Server

;	in your site, and the correct Home Server will be assigned 

;	when the user first logs on.



[Service3]

Ben=TRUE

;	--  Dummy property.  Do not delete or modify.





; ************************************************************************

; Section 4 - Mapping for profile properties.  DO NOT MODIFY.



; ************************************************************************

; Microsoft Outlook Client definitions



[Microsoft Outlook Client]

SectionGUID=0a0d020000000000c000000000000046



EmptyWastebasket=PT_BOOLEAN,0x0115

;	-- A boolean value indicating whether or not to empty the

;	wastebasket on exit.



SelectEntireWord=PT_BOOLEAN,0x0118

;	-- A boolean value indicating whether or not to select entire

;	words when selecting.



AfterMoveMessage=PT_LONG,0x013B

;	-- Indicates what to do after moving or deleting a message.

;	Possible values are shown below:

;	0 - Open Next Message

; 	1 - Return to Viewer

; 	2 - Open Previous Message



CloseOriginalMessage=PT_BOOLEAN,0x0132

;	-- A boolean value indicating whether or not to close the

;	original message after replying.



GenReadReceipt=PT_BOOLEAN,0x0141

;	-- A boolean value indicating whether or not to generate

;	a read receipt on sent mail.



GenDeliveryReceipt=PT_BOOLEAN,0x014C

;	-- A boolean value indicating whether or not to generate

;	a delivery receipt on sent mail.
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DefaultSensitivity=PT_LONG,0x014F

;	-- The default sensitivity to send mail with.

;	Possible values are shown below:

;	0 - Normal

;	1 - Personal

;	2 - Private

;	3 - Confidential



DefaultPriority=PT_LONG,0x0140

;	-- The default priority to send mail with.

;	Possible values are shown below:

;	0 - Low

;	1 - Normal

; 	2 - High



SaveSentMail=PT_BOOLEAN,0x0142

;	-- A boolean value indicating whether to save a copy of

;	sent messages in the sent items folder.





; ************************************************************************

; Microsoft Exchange Server service definitions.



[Microsoft Exchange Server]

ServiceName=MSEMS

MDBGUID=5494A1C0297F101BA58708002B2A2517



MailboxName=PT_STRING8,0x6607

;	-- The name of the user's Exchange Server Mailbox



HomeServer=PT_STRING8,0x6608

;	-- The name of the Microsoft Exchange Server the user should

;	connect to.  You can specify any Microsoft Exchange Server

;	in your site, and the correct Home Server will be assigned 

;	when the user first logs on.



OfflineFolderPath=PT_STRING8,0x6610

;       -- The path to the Offline Store File that contains

;       local replicas of the user's Mailbox and Favorites.

;       If you do not specify a value, no Offline Store will

;       be created.  If you specify a path, an Offline Store

;       will be created and the Inbox, Outbox, Deleted Items,

;       and Sent Items folders will be replicated to it.



OfflineAddressBookPath=PT_STRING8,0x660E

;	-- The path to the directory to store offline address

;	book files in.



�

ExchangeConfigFlags=PT_LONG,0x6601

;       -- Flags that control behavior when connecting to the Exchange

;       Server.

;       The following values are possible:

;       VALUE           RESULT

;       4               Normal

;       6               Ask whether to connect or work offline at startup.

;       12              Allow clients to be authenticated via the Internet

;       14              Combination of 6 and 12.



ConversionProhibited=PT_BOOLEAN,0x3A03

;       -- A boolean value indicating whether NEWPROF should

;       attempt to resolve the Exchange mailbox name at run time. 

;       If set to TRUE, NEWPROF will copy the name to the profile

;       without resolving it.

;       If FALSE, the name will be resolved. Invalid server or 

;       mailbox name will not be copied to the profile.



; ************************************************************************

; Microsoft Mail service definitions.



[Microsoft Mail]

ServiceName=MSFS



;      --  The path to the users post office.  Mapped network drives, UNC and NETWARE 

;          paths are acceptable.  NETWARE paths of the type NWServer/share:dir\dir1 are 

;          converted to UNC paths of the type \\NWServer\share\dir\dir1. 



ServerPath=PT_STRING8,0x6600



;      --  The users mailbox name.  eg. in a NET/PO/USER address,

;          this is USER.  The maximum mailbox name is 10 characters.



Mailbox=PT_STRING8,0x6601



;      --  The users mailbox password.  The maximum password is 8 characters.



Password=PT_STRING8,0x67f0



;      --  A boolean value indicating whether the users password is

;          to be remembered in the profile or not.  This is useful because

;          if the password is remembered the user can bypass the logon prompt

;          if his server path, mailbox name and password are all supplied.



RememberPassword=PT_BOOLEAN,0x6606



;      --  The connection type.  This may be one of CFG_CONN_AUTO, CFG_CONN_LAN,

;          CFG_CONN_REMOTE, CFG_CONN_OFFLINE as defined below.

;
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;          0x0   --  LAN type connection.  Used to connect to the post office using a

;                    UNC path or pre-existing mapped drive.

;          0x1   --  Dial up connection using Dial-up Networking.

;          0x2   --  Not connected.

;          0x3   --  Automatically detect whether the connection type is LAN or REMOTE.

;                    This connection type is only available on Win95.



ConnectionType=PT_LONG,0x6603



;      --  A boolean value indicating whether session logging

;          is on or off.



UseSessionLog=PT_BOOLEAN,0x6604



;      --  The path to the session log file.



SessionLogPath=PT_STRING8,0x6605



;      --  A boolean value which indicates whether mail in the outbox

;          is sent.



EnableUpload=PT_BOOLEAN,0x6620



;      --  A boolean value which indicates whether mail in the server

;          mailbag is downloaded.



EnableDownload=PT_BOOLEAN,0x6621



;      --  A bit array which allows the user to indicate which addresses

;          for which the transport is to attempt delivery.  This is useful

;          in order to allow a user to specify that a transport only handle

;          delivery for a subset of the addresses it can really process.

;          When multiple transports are installed and the user wants a

;          different transport to handle some specific address types they

;          can use this bit array to specify that the MSMAIL transport

;          only handle a specific set of addresses.

;

;          Possible values as defined below include:

;

;          0x00000001      --  Local Post Office and External Post Office address types

;          0x00000002      --  PROFS address types

;          0x00000004      --  SNADS address types

;          0x00000008      --  MCI address types

;          0x00000010      --  X.400 address types

;          0x00000040      --  FAX address types

;          0x00000080      --  MHS address types

;          0x00000100      --  SMTP address types

;          0x00000800      --  OfficeVision address types

;          0x00001000      --  MacMail address types

;          0x000019df      --  All of the above address types
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UploadMask=PT_LONG,0x6622



;      --  A boolean value which indicates whether a netbios notification

;          is sent to a recipients transport when mail is delivered to

;          their server inbox.



NetBiosNotification=PT_BOOLEAN,0x6623



;      --  The polling interval in minutes when the transport

;          checks for new mail.  1 <= polling interval <= 9999



NewMailPollInterval=PT_STRING8,0x6624



;      --  A boolean value which, if TRUE, only displays the Microsoft Mail Global 

           Addresslist for name selection.  The Postoffice list, external post office 

;          lists, and gateway address lists are not shown.



DisplayGalOnly=PT_BOOLEAN,0x6625



;      --  A boolean value which indicates whether the user wants to enable

;          headers while working on the LAN.  Headers mode allows the user

;          to download message headers and selectively choose which mail

;          to download.



UseHeadersOnLAN=PT_BOOLEAN,0x6630



;      --  A boolean value which indicates whether the user wants to use

;          name resolution based on a local copy of the server address book

;          rather than the server address book itself.



UseLocalAdressBookOnLAN=PT_BOOLEAN,0x6631



;      --  A boolean value which indicates whether EXTERNAL.EXE, a server process, 

;          should be used to deliver submitted mail messages.  This is sometimes useful 

;          when mail is running on a slow LAN connection.



UseExternalToHelpDeliverOnLAN=PT_BOOLEAN,0x6632





;      --  A boolean value which indicates whether the user wants to enable

;          headers while working over a slow speed link.  Headers mode

;          allows the user to download message headers and selectively

;          choose which mail to download.



UseHeadersOnRAS=PT_BOOLEAN,0x6640



;      --  A boolean value which indicates whether the user wants to use

;          name resolution based on a local copy of the server address book

;          rather than the server address book itself.
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UseLocalAdressBookOnRAS=PT_BOOLEAN,0x6641



;      --  A boolean value which indicates whether EXTERNAL.EXE, a server process, 

;          should be used to deliver submitted mail messages.  This speeds up message 

;          delivery when mail is running on a Dial-up network connection.



UseExternalToHelpDeliverOnRAS=PT_BOOLEAN,0x6639



;      --  A boolean value which indicates that a Dial-up Network connection should

;          be established when the transport provider starts up.



ConnectOnStartup=PT_BOOLEAN,0x6642



;      --  A boolean value which indicates that a Dial-up Network connection should

;          be automatically terminated when headers are finished downloading.



DisconnectAfterRetrieveHeaders=PT_BOOLEAN,0x6643



;      --  A boolean value which indicates that a Dial-up Network connection should

;          be automatically terminated after mail has finished being sent

;          received.



DisconnectAfterRetrieveMail=PT_BOOLEAN,0x6644



;      --  A boolean value which indicates that a Dial-up Network connection should

;          be automatically terminated when the provider is exited.



DisconnectOnExit=PT_BOOLEAN,0x6645



;      --  The name of the Dial-up Network profile that the transport will use by

;          default to attempt the connection.



DefaultDialupConnectionName=PT_STRING8,0x6646



;      --  Number of times to attempt dial for connection.

;          1 <= retry attempts <= 9999



DialupRetryCount=PT_STRING8,0x6648



;      --  Delay between retry attempts in seconds.

;          30 <= retry delay <= 9999



DialupRetryDelay=PT_STRING8,0x6649







; ************************************************************************

; Personal Folders service definitions.



[Personal Folders]

ServiceName=MSPST MS



;      --  Path to personal folders.

�



PathToPersonalFolders=PT_STRING8,0x6700 



;      --  A boolean value that determines if the personal folders password

;          should be cached.



RememberPassword=PT_BOOLEAN,0x6701



;      --  A value that designates the type of encryption that is used to

;          compress the data in the PST:

;

;          No Encryption              0x80000000

;          Compressable Encryption    0x40000000

;          Best Encryption            0x20000000



EncryptionType=PT_LONG,0x6702



;      --  PST password.



Password=PT_STRING8,0x6703







; ************************************************************************

; Personal Address Book service definitions.



[Personal Address Book]

ServiceName=MSPST AB



;      --  Path to personal address book.



PathToPersonalAddressBook=PT_STRING8,0x6600



;      --  Determines if PAB entries are first, last, or last, first.

;      

;          first last                0

;          last, first               1



ViewOrder=PT_LONG,0x6601







; ************************************************************************

; Outlook Address Book service definitions.



[Outlook Address Book]

ServiceName=CONTAB

Ben=PT_STRING8,0x6700

;      --  Dummy property.  Do not modify.



�

�Appendix B

Setup Command-Line Options

This appendix describes the Setup command­line options, which allow you to customize and run your installation from the command line. For detailed information about the Setup process and Network Install wizard, see Chapter 2, “Installation and Configuration.”
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Setup Command­Line Options

You can run the Setup program from the command line. If you do, you can add parameters to the command that allow you to specify certain options, such as choosing a Typical installation or creating a network installation log. 

(	To run the Setup program from the command line



In Windows 95 or Windows NT Workstation 4.0, click Start, and then click Run. 

– or – 

In Windows NT Workstation version 3.51, click Run on the Program Manager File menu. 

Type the location you are installing from, followed by the word setup. For example, a:\setup or x:\msoffice\setup 

If you want to add a command­line option, type it after the command. For example, to run Setup in administrative mode, type a:\setup /a 



Some command­line options are standalone parameters, while others take an argument, such as a number or file name. Options are not case­sensitive—they can be in uppercase or lowercase. With a few exceptions, you can combine options in the same command line. For example, to run Setup from drive A so that it specifies the user name Laura Callahan, the organization Island Trading, and the log file C:\Tmp\Offlog.txt, you would type the following: 

a:\setup /n "laura callahan" /o "island trading" /g "c:\tmp\offlog.txt"



Command­Line Option Descriptions

The following table shows the command­line options that you can use with the Setup program. 



Command-line option�Description����/a�Creates an administrative installation point. Valid when running from CD only. ��/b number �Bypasses the Microsoft Office 97 Setup dialog box by preselecting the type of installation: 

1 — Typical 

2 — Custom 

3 — Run from CD or Run from �        Network Server���

Command-line option (cont.)�Description (cont.)����/c “number” �Bypasses the dialog box for entering and validating the 20­character Product ID from the OEM Certificate of Authorization by entering the number you specify. ��/f�Specifies that all files are created with an 8­character file name with a 3­character extension instead of with a long file name. Use this option for installing to a server that does not support long file names.��/g{+} “file” �Generates a log file that records details of the Setup process. If + is specified, Setup appends new information to the log file instead of overwriting it. ��/k “number” �Bypasses the dialog box for entering and validating the 11­digit key from the CD sticker by entering the number you specify. ��/l “file” �Overrides the default .lst file (Setup.lst) with the specified file. ��/m number �Specifies the Microsoft License Pack (MLP) licensing information needed to activate the MLP for floppy disks. Setup does not install any software, but terminates immediately after setting the count at the number you specify. ��/n “” �If no default user name exists in the Windows registry, prompts for a user name. ��/n “name” �If no default user name exists in the Windows registry, specifies the user name. ��/o “” �If no default organization name exists in the Windows registry, prompts for an organization name. ��/o “organization” �If no default organization exists in the Windows registry, specifies the organization name. ���

Command-line option (cont.)�Description (cont.)����/q{option} �Specifies the level of user interaction for batch mode installation: 

0 — Suppresses all dialog boxes except the�        final one. Using 0 is the same as using�        no argument. 

1 — Suppresses all dialog boxes, including �        the final one. 

T — Suppresses all Setup user interface �        elements.��/qn{option} �Does the same as /q, except that the system is not restarted, and 0 is not a valid value. To suppress all dialog boxes except the final one, use /qn with no argument. ��/r�Reinstalls an application. Use in maintenance mode only. ��/s "folder" �Overrides the default source—the folder containing Setup.exe or the source specified in the maintenance-mode setup table file (.stf file)—with the specified folder. ��/u{a} �Removes Office. If a is specified, shared components are removed without prompting the user; otherwise, the user is prompted before removing shared components. Use in maintenance mode only. ��/x "file" �Creates a network installation log file for tracking the number of installations made from an administrative installation point. This option overrides the value, if any, specified in the .stf file. ��/y�Proceeds normally, including setting registry entries, but does not copy any files to the user’s disk. Use this option to restore registry values or to track down processing problems. ��

Note: If you enter any invalid parameter, Setup displays a partial list of valid command­line options. 

�

Special Option Considerations

When you combine options on the same command line, be aware of these special considerations: 

The /a and /q options are mutually exclusive; using both options results in a usage error message. 

If you use the /a option, the /n option is ignored. 

The /u and /r options are mutually exclusive; using both options results in a usage error message. 

The prompt elicited by the /u option is suppressed if /q and the shared components are not removed. 
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